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ITSM Practices
CSM provides an ITSM solution to support multiple features and processes.

Business Objects that support Multi-Sourcing Service Integration (MSI) and Service Integration and
Management (SIAM) are available as part of this solution. For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.

CSM is highly configurable so your processes and content will vary.
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Incident/Service Request Management
Incident/Service Request management is the process that ensures that Services are restored as quickly
as possible.

This can cover:

• Incident: Restoring something that is broken/disrupted (example: Fixing a printer, phone, or
software).

• Service Request: Fulfilling a request for information/advice or access to a Service (example:
Resetting a password, granting access to a printer, or providing standard setup Services for a new
employee).

Note: In CSM, Incidents and Service Requests (often called Requests) are stored together
in the Incident Business Object.
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About Incidents and Service Requests
An Incident is an unplanned interruption to a service or a reduction in the quality of a service (example:
Something is not working). A Service Request is a request for information, advice, a Standard Change, or
access to a service (example: Installation of new software).

In CSM, Incidents and Service Requests are stored together in the Incident Business Object. The
categorization (Service/category/subcategory) identifies the record as either an Incident or Request. A
categorization often requires a unique form to capture the correct information. For example, an Incident
for a non-working network printer would require different information than a Request for printer toner
cartridge. To facilitate gathering this specific information, CSM embeds and uses several default Specifics
Forms, which are automatically displayed when you categorize the record. For more information, see
Specifics Forms.

Good to Know

• The workflow for Incidents and Service Requests is almost identical, and the forms are similar.
Specifics Forms always vary.

• CSM provides several default Automation Processes to automate Incident management. For more
information, refer to the Automation Process documentation.

• When on a record, you can send an email directly to the current customer by selecting File > E-mail
Current Customer, or by selecting the customer's email address in the Incident Form. If using the
File menu, the email is blank. If using the Default Form link, an email template is used to auto-
populate the email with information from the current Incident (example: Incident ID, customer's
name, and logging date/time details).
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Incident and Service Request Workflow
Incidents and Service Requests have similar (but slightly different) workflows.

The following figure describes the high-level Incident/Request workflow.

1

The choice between Incident and Service Request is automatically determined by CSM:

• Incident: Initiator reports that something is not working.

• Service Request: Initiator requests information, advice, access or a standard change.

Incidents are investigated and resolved, Service Requests are fulfilled.

2

• Assigned team: Select the team owner.

• Assigned to: Select the owner.

• Assign to me: Make yourself the owner.

3

Owner:

• Searches the Knowledge Base.

• Views similar Incidents/Service Requests.

• Creates Tasks (example: Work Items, Escalations, Time Tracking).

• Uses Actions (example: One-Step Actions, Quick Templates).

• Selects available Service Catalog Template (SCT).
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4

Owner resolves the Incident by:

• Marking it as Resolved.

• Recording the resolution details.

• Recording the resolution code.

5

Owner fulfills the Service Request by:

• Marking it as Resolved.

• Recording the resolution details.

Note: CSM uses several features to manage the Incident or Request workflow (example: The
Incident Form helps create and track Incidents, One-Step Actions help move an Incident through
its workflow, Automation Processes notify stakeholders via emails, dashboards notify stakeholders
and track metrics, SCTs and Work Units allow automation of tasks, etc.). See Incident Features,
Incident One-Step Actions, and Incident Automation Processes.

Contributors
An Incident or a Request typically involves the following contributors. Depending on your workflow and the
size of your company, some of these contributors might be combined into one person:

• Requester: Person who initiates the Incident/Request. This is typically a customer.

• Creator: User who first logs the Incident/Request. This is a user; the level varies depending on
tiered support.

• Owner: User who manages (investigates/resolves/fulfills) the Incident/Request. This is typically a
technician; the level varies depending on tiered support.

• Task owner: User to whom Tasks are assigned in order to help resolve/fulfill an Incident/Request
(example: Work Unit owner, Approval owner).

Statuses
An Incident or a Request progressing through the workflow encounters the following statuses:

1. New: Incident/Request is being created, recorded (initial details), classified, and assigned to an
owner.

2. Assigned: Incident/Request has been assigned to an owner.

3. In Progress: Incident/Request is being investigated/fulfilled and resolved by an owner.

4. Pending: Incident/Request is temporarily paused (Stop The Clock).

5. Resolved: Incident/Request has been resolved and is waiting to be closed.

6. Closed: Incident/Request is closed.

CSM 10.5.0 ITSM Practices 12

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=incident_features
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=incident_one-steps


7. Reopened: Incident/Request is reopened because the issue was not fixed or reoccurred.

Related concepts
Incident Form
Incident One-Step Actions
Create an Incident
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Create an Incident
The following procedures walk you through the steps required to create an Incident and how to classify it
as a Major Incident. The process to create a request follows a similar workflow.

Log the Incident
Create an Incident record and provide initial details.

1. On the CSM Desktop Client toolbar, select New > New Incident. See CSM Desktop Client toolbar.

Note: If configured, an Incident can also be logged by an automated process or by a
customer in the CSM Portal. After an Incident is logged, a CSM creator or technician moves
the Incident through the Incident workflow. See Incident and Service Request Workflow.

2. Record Incident details:
a. Call Source: Select a source or method of contact from the drop-down list.

b. Customer: Select a customer from the Related Item Picker.
i. (Optional) If the Incident is being submitted on behalf of another user, select Submit on

Behalf Of and select the requester. You are also prompted to select who should receive
email notifications.
You can select this option again to change or remove the requester.

ii. Select OK.

Note: You can also select Add Requester in the Actions list to submit on behalf
of another user. To remove or change the requester, select Remove/Change
Requester in the Actions list.

c. Description: Provide a description for the Incident (example: Cannot print to network printer).
The description field is a rich text field. To format the text or embed an image, select the Zoom
button. See About Rich Text.

Classify the Incident
The second step on an Incident form is to classify the Incident. Categorize, prioritize, and escalate to a
Major Incident, if necessary.

1. Service Classification: Enter a service classification or select the Related Item Picker. The Related1.
Items dialog box opens with a list of available service classifications. Select the classification that
matches the Service, Category, and Subcategory for the Incident.

Note: Incident Type is determined by the Service Classification. This three-tiered
categorization determines the Incident Type (Incident or Request), which specifics form to
display and which SLA to invoke. See Specifics Forms. If you do not know the three-tiered
classification, enter a word into the Quick Assembly field (example: Printer) then press TAB
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or ENTER to locate a possible match. Wildcards (% or *) can be used when searching. If
matches are found, the Category Selector opens.

After an Incident is identified as an Incident or Request, the relevant specifics form is displayed.

2. Prioritize the Incident:
a. Select the Priority drop-down list, and select a priority number from the Priority Matrix. The

selected priority is displayed in the Default form.
After a priority is selected, Respond By and Resolve By Target Times are calculated based on
the defined Priority Target Times in the invoked SLA, and are then displayed in the SLA
section of the Incident form. The Respond/Resolve By fields indicate when the Target Times
(deadlines) are met and breached. If enabled (via an Automation Process), emails are
automatically created and sent to the managers of user/team owners to notify them of potential
SLA Respond/Resolve By breaches.

Note: If necessary (and allowed by the invoked SLA), place the record in a pending
state to stop the SLA clock anytime after the required fields are populated by selecting
the Set to Pending link in the Actions list. After you select a pending reason
(example: Need data from customer), the status changes to pending and the pending
reason (with a review date) displays in the Status bar. To remove the status from
pending, select the Remove from Pending Status link in the Status bar.

3. Select a Primary Configuration Item (CI):
a. Select the Related Item Picker to launch the Find Related window, where you can select a CI.

You can locate CIs by filtering (by Config Type, All Customers, a specific Customer) or by
searching. You can also create a new CI on the fly.
The selected CI record appears on the Configuration Items tab (arrangement area).

Tip: To view the selected CI record, select the Quick View button or select the record
on the Configuration Items tab (in the form arrangement). To view impacted CIs, select
View Impacted CIs in the Actions list to open a Configuration Map that shows other
CIs affected by the Incident.

4. Assign the Incident to a Team.
a. Enter the name of a team or select the team from the drop-down list. First Level Support is the

default team.

5. Assign the Incident to a member of the assigned team.
a. Select the team member from the drop-down list.

Escalate to a Major Incident
A Major Incident has a company impact and requires a high level of urgency. It may involve several
departments, or may be the result of multiple related Incidents. For example, if several Incidents have
been submitted regarding login issues to Microsoft Outlook, and the cause of these Incidents is that
Microsoft Outlook is down company-wide, a Major Incident should be created.

To escalate an Incident to a Major Incident if necessary, select Change to Major Incident in the Actions
list.
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1. (Optional): Attach similar incidents in the Linked Incidents tab of the form arrangement. This tab is
only visible if the Incident is a Major Incident. Any Incidents linked to a Major Incident can be
automatically resolved at the same time as the Major Incident.

Note: Linked Incidents are automatically updated with the Major Incident ID. If the Major
Incident is closed, the linked Incidents are also automatically closed. If desired, create a
One-Step™ Action to notify all Incident Owners of the Major Incident Escalation.

2. (Optional): Select Link to Existing Major Incident in the Actions list if the Incident is a contributing
factor to an already open and existing Major Incident.

Resolve the Incident
After an Incident has been logged, classified, and associated Specifics forms are complete, the owner can
resolve the Incident.

1. Develop a resolution:
◦ Search the Knowledge Base. See Search for Knowledge Using the Knowledge Pane.

◦ View Similar Incidents.

Note: The Similar Incidents tab is displayed only for Incidents. Service Requests do
not include the Similar Incidents tab.

◦ Use Actions (Actions/One-Step Actions/Quick Templates/Task Forms).

2. After a resolution is developed, resolve the Incident and capture the resolution details:
a. In the Status bar, select Resolve.

CSM prompts you to log the resolution/fulfillment details.

Note: If the Incident has open tasks associated with it that need to be closed before the
Incident is resolved, a message displays to warn you.

3. (Optional) Transfer the resolution to the Knowledge Base/Support Group:
a. Select the Submit to KB button on the Resolution Details form, or select Submit to

Knowledge Base in the Actions list to log a Knowledge Article. See Create a New
Knowledge Article.

4. If you discover that the Incident was not resolved, clone it (create a new Incident with fields auto-
populated with information from the cloned Incident) by opening the Task pane and selecting
Incident Actions > Quick Templates > Clone Current Incident.

Related concepts
Incident Form
Incident One-Step Actions
Incident and Service Request Workflow
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Incident Design Ideas
Use these ideas for tips on how to design an Incident.

• Fields: Change required fields and when they are required, and the fields that support rich text.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the CSM Desktop Client, CSM Browser Client, and CSM Portal. View Counter functionality is
configured in CSM Administrator. See Define Advanced Properties for a Business Object.

• Statuses: Change Incident statuses and/or the One-Step™ Actions that are initiated when an
Incident enters each status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate your workflow, or
implement any of the unused example One-Step Actions that are shipped with CSM (example:
Notify Owned By of Edits One-Step Action).

• Email: Change the templates that are used to create the emails sent by One-Step Actions or
Automation Processes (example: Resolved Confirmation). The email templates are defined as part
of the One-Step Action. Disable/change when and to whom notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that monitor Incidents
(example: Monitors for SLA resolve/respond by deadline breaches, automatic notification emails).
Consider creating Automation Processes to notify stakeholders of a Major Incident or to coordinate
a Major Incident effort.

• Validated Field values: Use Table Management to add/edit Lookup Object values to use in drop-
down menus (example: Cause Codes).
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Incident Features
CSM provides tools to help manage Incidents and Requests, such as forms and dashboards.

• Incident/Request forms and Specifics forms. See Incident Form and Specifics Forms.

• Journals

• Dashboards. See Incident Dashboards.

• One-Step™ Actions. See Incident One-Step Actions.

• Saved Searches. See Incident Saved Searches.

• Automation Processes. See Incident Automation Processes.

• Reports. See Incident Reports.
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Incident Form
Use the Incident and Request forms to create, edit, and track Incidents or Requests.

The forms are similar and are made up of four main areas:

1. Default Form: Displays important at-a-glance information.

2. Form Arrangement: Dynamically displays a tabbed collection of child forms and records that are in a
relationship with the Parent Incident form. See Managing Form Arrangements for more information.

3. Form Area: Displays the main form fields.

4. Actions List: Dynamically displays a list of actions that are available for the current Incident.

The following table describes the fields on the form.

Field Description Comments

Default Form

Important at-a-glance information, such as Incident ID,
response timers, customer contact information, Status bar
(current and next Status), and to whom the Incident is
assigned.

Priority
A measure of impact and urgency used to establish
timescales and effort to respond to and resolve an issue.
See Priority for more information.

ID Unique record identifier (example: 10999).
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Field Description Comments

Status

Statuses include:

• New: Incident/Request was created and initial
details are being entered.

• Assigned: Incident/Request has been assigned to
a record owner.

• In Progress: Incident/Request is being
investigated/fulfilled by a record owner and/or Task
owners.

• Pending: Incident/Request is temporarily paused
(Stop The Clock).

• Resolved: Incident/Request has been investigated/
fulfilled and is waiting to be closed.

• Closed: Incident/Request is closed.

• Reopened: Incident/Request is reopened because
the issue was not fixed or reoccurred.

Next: Status

Select the links to move the Incident/Request through the
Incident/Request workflow.

The Next links include the following statuses:

• Begin Work: Captures a date-time stamp to track
when work began on the Incident/Request.

• Set Pending: Temporarily pauses the Incident/
Request (Stops the SLA Clock).

• Resolve: Prompts the user to log the Resolution
details (Close Description) and Cause Code.

• Close: Manually closes the Incident/Request. Note:
A CSM Automation Process/One-Step™ Action
automatically closes Incidents after three (3) days.

• Reopen: Reopens a Resolved Incident/Request
because it was technically not resolved. Restarts
the SLA Clock.

For information about
One-Step Actions that
can be used with the
Next: Status field, see
Incident One-Step
Actions.

Response Time Time remaining to respond to the Incident based on
Priority.

Resolve Time Time remaining to resolve the Incident based on Priority.

Requester Person who submitted the Incident/Request on behalf of
the customer. Select to change or remove requester.

Customer Person affected by the Incident/Request. Select to
change customer.
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Field Description Comments

Assigned to
Name of the team member who is working on the
Incident. Select the link to first select a team and then the
assigned user.

Main Pane Displays the main form fields. Specifics forms appear
when relevant. See Specifics Forms.

Call Source

Method by which the Incident was delivered. Options
include the following sources:

• Walk in

• Social Media

• E-mail

• Event

• Phone

• Portal

• Chat Session

• Mobile

Customer
Person affected by the Incident/Request. If the Incident
was submitted by another user on behalf of the customer,
select Submit On Behalf Of to set the requester.

Description Description of the Incident/Request.

Service
Classification

Service affected by Incident/Request:

• Account Management

• Conferencing/Presentation

• Desktop Management

• E-mail/Calendaring

• Employee Support

• Enterprise Apps

• IT Service Desk

• Network Services

• Printing

• Telephony/Fax

• Web Services

You can classify an
Incident form by
selecting a Service
Classification that
matches the Service,
Category, and
Subcategory.

For more information,
see Service
Categorization.

Priority
Indicates the established timescales and effort to respond
to and resolve an issue (Incident or Request). Priority is
derived from an impact and urgency Priority Matrix.

For more information,
see Priority.
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Field Description Comments

Primary
Configuration
Item

Displays the main CI that supports this Incident. For more information,
see About CMDB.

Team Name of the team to which the form is assigned.

Assign To
Select the link to select a user owner for the Incident.
The team owner is populated by the selected user
owner's default team.

One-Step Action
(Assign to ANY
Individual): Prompts the
user to assign the
record to any CSM user
(not limited by team).
Uses Owned By ID and
Owned By Team Fields.

Actions List Dynamic display of the actions available for the current
Incident.

Assign to Me Makes the current user the owner of the Incident. The
current user's name appears in Assigned to field.

Escalate to Assigns next level of severity to the Incident according to
the workflow.

Link to Existing
Major Incident

Creates association between current Incident and existing
Major Incident.

Submit to
Knowledge Base

Creates a knowledge article with fields assigned relevant
information from Incident form.

Change to Major
Incident

Change to
Incident

Transforms a priority 1 incident into a Major Incident or
changes a Major Incident back to an Incident.

A Major Incident can
have other Incidents
associated to it. When
the Major Incident is
resolved, the linked
Incidents are also
closed. A Major Incident
has a Linked Incidents
tab that displays a list of
all Incidents associated
with it.

View Impacted
CIs

Opens a list of Configuration Items that are affected by
the Incident.

Select Available
SCT

Allows you to add tasks from a Service Catalog Template.
SCT tasks appear in Tasks tab.
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Field Description Comments

Add Requester

Remove/Change
Requester

Adds a Requester when submitting on behalf of another
user or removes or changes the Requester.

After selecting a
Requester, prompts the
user to select who
should receive email
notifications.

One-Step Action:
Prompts the user to
change or remove the
Requester.

Set to Pending Stops the progression of Resolve Time. Opens a prompt
that requires a reason.

Related concepts
Create an Incident
Incident One-Step Actions
Incident and Service Request Workflow
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Specifics Forms
Specifics forms are context-sensitive forms that are embedded into Incident and Service Request records
to capture relevant data for the different Categorizations of Incidents and Service Requests.

For example, different details are needed for a printing Incident than for a new computer request. Using
Specifics forms allows the Service Desk to capture the exact data to determine a resolution more quickly
by either asking scripted questions to lead to the appropriate answer or capture the correct data for
subsequent support teams involved in the functional escalation process.

CSM provides the following default Specifics forms:

Service Category Subcategory Specifics Form

E-mail/Calendaring (any category) Submit Incident E-Mail

Employee Support Add/Change Employee Separation Employee Departure

Employee Support Add/Change New Employee Setup New Employee

Employee Support Add/Change Update Employee Update Employee

Desktop Management Computer Request New Computer New Device

Printing (any category) Submit Incident Printer
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Dynamic Specifics Forms
Dynamic Specifics forms allow you to select computer and mobile device accessories on the New
Employee and New Device Specifics form.

Users configure the functionality by adding accessory titles and costs to each computer and mobile device
item in the Product Catalog Lookup Table. Accessory values dynamically display based on the selected
computer or mobile device item.
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Define Accessories and Permissions for a
Computer CI

Define configurations for a computer CI such as name, cost, and access.

To define accessories for a computer CI:

1. In the CSM Desktop Client menu bar, select Tools > Table Management. See CSM Desktop Client
menu bar.

The Table Management interface opens.

2. In the Type drop-down, select Product Catalog.

Product catalog items open in the grid.

3. Select a computer item (example: Latitude E5530 Laptop), and then select the Show Current
Record button.

The record (example: Product - Latitude E5530 Laptop) opens.

4. Define accessories for the item:
a. In an accessory field, type the name of the accessory (example: Carrying Case).

b. In the cost field, type the cost of the accessory (example: 59.99).

Note: You must define accessories for each computer item in your product catalog.

5. Define permissions for who can access the item in the drop-down on the Specifics form:
a. Select the Include Specific Departments link.

b. Do one of the following to grant permissions to access the item in the drop-down list:
◦ Select the add from list link to grant permissions to all members of a specific

department.

◦ Select the add all departments link to grant permissions to all members of all company
departments.

Tip: To remove all departments from the list, select the Clear All link.

6. Select Save.
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Define Accessories and Permissions for a Mobile
Device CI

Define configurations for a mobile device CI such as name, cost, and access.

To define accessories for a mobile device CI:

1. In the CSM Desktop Client menu bar, select Tools > Table Management. See CSM Desktop Client
menu bar.

The Table Management interface opens.

2. In the Type drop-down list, select Product Catalog.

Product catalog items open in the grid.

3. Select a mobile device item (example: Apple iPhone 5 32GB), and then select the Show Current
Record button.

The record (example: Product - iPhone 5 32GB) opens.

4. Define accessories for the item:
a. In an accessory field, type the name of the accessory (example: Phone Case).

b. In the Cost Field, type the cost of the accessory (example: $35.00).

Note: You must define accessories for each mobile device item in your product
catalog.

5. Define permissions for who can access the item in the drop-down list on the Specifics form:
a. Select the Include Specific Departments link.

b. Do one of the following to grant permissions to access the item in the drop-down list:
◦ Select the add from list link to grant permissions to all members of a specific

department.

◦ Select the add all departments link to grant permissions to all members of all company
departments.

Tip: To remove all departments from the list, select the Clear All link.

6. Select Save.
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Add Accessories to a Computer CI and Mobile
Device CI

Add accessories to a new Incident for a new employee setup or new computer request.

To add accessories to a computer CI and mobile device CI:

1. In the CSM Desktop Client, log a new Incident (New > Incident).

A new Incident record is created.

2. Classify the Incident as a new employee setup:
a. Service Classification: Select Employee Support > Add/Change > New Employee Setup.

The New Employee Specifics form opens.

Note: The configured computer and mobile device accessory and cost values are also
available on the New Device Specifics form. Access the form by classifying the
Incident as a Request New Computer (Service Classification: Desktop Management
> Computer > Request New Computer).

3. In the computer section, select an item from the Computer drop-down list (example: Latitude
E5530 Laptop).

Note: Your department must have defined permissions to access the item.

The defined computer accessories display.

a. Select an accessory check box (example: Carrying Case $59.99).

The price of the accessory is added to the computer details calculation, and an Ordered [Item]
check box displays on the form.

4. In the Mobile Device section, select an item from the Mobile Device drop-down list (example:
iPhone 5 32GB).

The defined mobile device accessories display.

a. Select an accessory check box (example: Car Charger $19.95).

The price of the accessory is added to the computer details calculation, and an Ordered [Item]
check box displays on the form.

5. Complete the Incident logging process.
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Incident Journals
Each Journal type has its own unique form. Journals are child records, so they are linked to and available
from their parent records.

Access Journals by selecting the Journals tab in the parent record's arrangement.

CSM provides the following default Incident Journal types:

• Journal - Note: Tracks user notes/comments. For example, a user might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important field changes. Tracked fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks email correspondence. For example, emails sent for receipt, follow-
up, resolution, and questions.

• Journal - SLM History: Tracks SLA breaches, warnings, and changes in the pending status for
Stop the Clock.

• Journal - Queue History: Tracks when records are added to/removed from a Queue. See About
Queues.

• Journal - Remote Support History: Tracks chat/remote support sessions.

Note: History Journals are automatically created by CSM. Notes are manually created in
CSM by selecting New Journal. Customer Requests are manually created in the CSM
Portal.
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Incident Dashboards
CSM provides Incident dashboards to view Incident and Service Request metrics. Use these dashboards to
monitor metrics and configure and filter Widgets to customize the display.
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Incident Dashboard
CSM provides an Incident dashboard that intuitively organizes your critical Incident metrics into a single,
real-time, at-a-glance Incident control panel.

Note: Incidents metrics are also found on other dashboards (example: Global IT and Executive).

The following table describes the items on the dashboard.

Item Description Widget
Type Widget Name Widget Uses:

Incident
Details Incident Details Dashboard Link Incident Details

Open Incident
Details
dashboard

Total Open
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed).

Text
Gauge

Total Open
Incidents

Open Incidents
Saved Search

Reopened
Incidents

Number of Reopened Incidents
(Status = Reopened).

Text
Gauge

Total Reopened
Incidents

Re-Opened
Incidents Saved
Search

Pending
Incidents

Number of Open Incidents (Status
= Pending).

Text
Gauge

Current Pending
Incidents

Pending
Incidents Saved
Search

Open
Overdue
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
that have not been resolved by
the SLA deadline.

Text
Gauge

Current Overdue
Incidents

Open Overdue
Saved Search
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Item Description Widget
Type Widget Name Widget Uses:

Open VIP
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
initiated by a VIP Customer.

Text
Gauge

Total Open VIP
Incidents

Total Open VIP
Incidents Saved
Search

Unowned
Incidents

Number of Open Incidents (Status
does NOT = Resolved or Closed)
that have an empty Ownership
field.

Text
Gauge

CDCurrent
Unknown
Incidents

Current Unknown
Incidents Saved
Search

Open
Incidents by
Category

Percentage of Open Incidents
(Status does NOT = Resolved or
Closed) by Service Category. Pie
slices represent Service
Categories.

Pie Chart Incidents by
Category

Open Incident
Saved Search

Open Incident
Lifecycle

Percentage of Open Incidents
(Status does NOT = Resolved or
Closed) by Status. Pipeline Slices
represent Incident Statuses.

Pipeline
Chart

Incident Lifecycle
Distribution

Open Incident
Saved Search

Filter
Filters the data on the dashboard
by time (example: Today,
yesterday, within last week).

Filter CD - Date Filter -
30 day default  
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Incident Details Dashboard
CSM provides an Incident Details dashboard that provides more detailed Incident information, including
MTTR and lifecycle stats.
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Service Request Dashboard
CSM provides a Service Request dashboard that organizes your critical Request metrics into a single,
real-time, at-a-glance Request control panel.

Note: Request metrics are also found on other dashboards (example: Global IT and Executive).

The following table describes the items on the dashboard.

Item Description Widget
Type Widget Name Widget Uses:

Total Open
Requests

Number of Open Requests (Status
does NOT = Closed or Resolved). Text Gauge Total Open

Requests
Open Requests
Saved Search

Pending
Requests

Number of Open Requests (Status
= Pending). Text Gauge Current Pending

Requests

Pending
Requests Saved
Search

Open Overdue
Requests

Number of Open Requests (Status
does NOT = Closed or Resolved)
that have not been resolved by the
SLA deadline.

Text Gauge
Current
Overdue
Requests

Open Overdue
Saved Search

Open VIP
Requests

Number of Open Requests (Status
does not = Closed or Resolved)
initiated by a VIP Customer.

Text Gauge Total Open VIP
Requests

Total Open VIP
Requests Saved
Search

Unowned
Requests

Number of Open Requests (Status
does NOT = Resolved or Closed)
that have an empty Ownership
field.

Text Gauge Unowned
Requests

Unowned
Requests Saved
Search
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Item Description Widget
Type Widget Name Widget Uses:

Reopened
Requests

Number of Reopened Requests
(Status = Reopened). Text Gauge Total Reopened

Requests

Re-Opened
Requests Saved
Search

Open
Requests by
Category

Percentage of Open Requests
(Status does NOT = Closed or
Resolved) by Service Category.

Pie Chart Requests by
Category

Open Requests
Saved Search

Open
Requests in
Lifecycle

Percentage of Open Requests
(Status does NOT = Closed or
Resolved) by Status.

Pipeline
Chart

Request
Lifecycle
Distribution

Open Requests
Saved Search
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Incident One-Step Actions
CSM provides several Incident One-Step Actions to automate tasks.

One-Step
Actions Descriptions Actions Executed From

Status   

Alt 1 Step from
Relationship

Conditionally change the Incident status to next logical status
(defined by the Incident status values in Table Management)
and/or initiate the next appropriate One-Step Action.

Incident form:
Next: <Status>

Alt 2 Step from
Relationship

Conditionally change the Incident status to next logical status
(defined by the Incident status values in Table Management)
and/or initiate the next appropriate One-Step Action.

Incident form:
Next: <Status>

Next Step from
Relationship

Conditionally change the Incident status to next logical status
(defined by the Incident status values in Table Management)
and/or initiate the next appropriate One-Step Action.

Incident form:
Next: <Status>

Form   

Ownership   

Assign to ANY
Individual

Prompts the user to assign the record to any CSM user (not
limited by team). Uses Owned By ID and owned by team fields.

Changes the Incident status from new to assigned.

Incident form:
Assign To link

Assign to
Individual

Launches the Choose Team window, where a user can choose
an owned by team for the record; then, launches the Choose
User window, where a user can choose a primary user from the
already-selected team.

Changes the Incident status from new to assigned.

Incident form:
Assign To link

Assign to Team Launches the Choose Team window, where a user can choose
an owned by team for the record.

Incident form:
Team: link

Close Incident
Works with close status. Changes the Incident status from
resolved to closed. Prompts the user to fill in resolution notes
and cause code if those fields are empty.

Incident form

Reopen Incident

Works with reopen status. Changes the Incident status from
resolved to reopened, and clears the resolution fields. Sets the
resolved time in minutes and the total STC time in minutes to
restart the SLA clock.

Incident form
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One-Step
Actions Descriptions Actions Executed From

Resolve Incident

Works with resolve status. Changes Incident status from in
progress to resolved, and then prompts the user for a close
description and cause code if those fields are empty. A pop-up
message displays if the Incident record has open Tasks
associated with it that need to be closed before the Incident is
resolved.

Incident form

Set Pending

Works with set pending status. Changes Incident status from in
progress or reopened to pending to pause the SLA clock (Stop
The Clock). For Incidents in pending status, sets them to their
previous status using the Remove Pending Status link.

Incident form

Start Work In
Progress

Works with begin work status. Tracks the date/time responded
and changes the Incident status to in progress. If ownership has
not yet been assigned, assigns the Incident to the current user
and the team that user belongs to.

Incident form

Take Ownership

Makes the current user the primary user of the record.

Changes the Incident status from new to assigned.

Incident form:
Assign to Me
action

Other   

Nominate for KB

Creates a new Knowledge Article (KA) populated with the
description, categorization, and solution/workaround from the
Incident.

Use to submit information from an Incident record as a KA to
the Knowledge Base. A KA is a separate record with its own
workflow.

Incident form:
Submit to
Knowledge Base
action

Remove/Change
Requester

Launches the Select an option window where a user can
choose to remove or change the requester.

Incident form:
Remove/Change
Requester action

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.

Related concepts
About One-Step Actions
Create an Incident
Incident Form
Incident and Service Request Workflow
Action Block Email Templates
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Incident Saved Searches
CSM provides numerous Incident saved searches to reuse for common criteria.

For more information, see About Saved Searches.

Saved Search Returns Association Executed From

All Incidents All Incidents and Requests. Incident Search Manager,
Widgets

Closed on 1st Call
(Incidents and Requests)

Incidents and Requests closed on the
first call. Incident Search Manager,

Widgets

Incidents by Priority Incidents with a user-selected Priority. Incident Search Manager

Incidents Linked to
Problem

Open Incidents that are linked to a
Problem. Incident Search Manager,

Widgets

My Open Incidents Open Incidents owned by me (current
user). Incident Search Manager,

Reports

My Open Incidents and
Requests

Open Incidents and Requests owned
by me (current user). Incident Search Manager,

Widgets

My Teams Open
Incidents

Open Incidents owned by one of my
(current user) teams. Incident Search Manager

Open Incidents and
Requests Open Incidents and Requests. Incident Search Manager,

Widgets

VIP Open Tickets Open Incidents and Requests that are
initiated by a VIP customer. Incident Search Manager,

Metrics, Widgets

VIP Tickets All VIP Incidents and Requests. Incident Search Manager
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Incident Automation Processes
CSM provides the following Incident Automation Processes to automate behavior.

For more information, see Automation Processes.

Name Description

Incident -
Confirmation Email
on Create

When an Incident is created, the process initiates the Incident Confirmation
One-Step™ Action, which sends the customer an email to confirm their record
and provide the Record ID number.

Incident - Not
Touched in 3 Days

Waits for the last modified date time field to update. If the field is not updated for
three days, the process initiates the SLA Escalate if Not Touched in 3 Days
One-Step Action that sends an email to the Incident owner with a reminder to
follow up with the customer.

Notify Incident Owner
of a new Journal -
Note

When a Journal is added to an Incident, the process initiates the Notify Owned
By of a New Journal-Note One-Step Action, which sends a notification email to
the Incident owner.

Notify Incident Owner
of Assignment

When the Owned By Field of an Incident changes, the process initiates the
Notify Owned By Via E-mail One-Step Action, which sends a notification email
to the assigned Incident owner.

Notify Incident Team
of Assignment

When the Owned By Team Field of an Incident changes, the process initiates
the Notify Owned By Team Via E-mail One-Step Action, which sends a
notification email to the assigned team.

Resolve By Breached
- Incident Changed
from Pending

Waits for the resolve by SLA deadline value to pass after the status of an
Incident is changed from pending. If it passes, this process sends an email to
the manager of the user who owns the Incident and creates a Journal entry to
record the breach.

Resolve By Breached
- Incident Created

Waits for the resolve by SLA deadline value to pass after an Incident is created.
If it passes, this process labels the Incident as breached and sends an email to
the manager of the user who owns the Incident.

Resolve By Breached
- Incident Reopened

Waits for the resolve by SLA deadline value to pass after an Incident is
reopened. If it passes, this process labels the Incident as breached and sends
an email to the manager of the user who owns the Incident.

Resolve By Warning
- Incident Changed
from Pending

Waits for the SLA resolution warning deadline value to pass after an Incident
status is changed from pending. If it passes, this process sends an email to the
manager of the user who owns the Incident and creates a Journal entry warning
that the SLA resolution time is about to breach.

Resolve By Warning
- Incident Created

Waits for the SLA resolution warning deadline value to pass after an Incident is
created. If it passes, this process sends an email to the manager of the user
who owns the Incident and creates a Journal entry warning that the SLA
resolution time is about to breach.

Resolve By Warning
- Incident Reopened

Waits for the SLA resolution warning deadline value to pass after an Incident is
reopened. If it passes, this process sends an email to the manager of the user
who owns the Incident and creates a Journal entry warning that the SLA
resolution time is about to breach.
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Name Description

Resolved - Calc SLA
Good Fields

When the Status Field of an Incident changes to resolved, the process uses an
expression (SLA calculations) to determine whether the date and time of the
resolution is less than or equal to the SLA resolve deadline.

Tip: Use this Automation Process for report or dashboard metrics.

Resolve to Closed
Process

Waits for three days after the status of an Incident is changed to resolved. If the
status does not change from resolved, it marks the status as closed.

Respond by
Breached - Incident
Created

Waits for the respond by SLA deadline value to pass after an Incident is
created. If it passes, this process labels the Incident as breached and sends an
email to the manager of the user who owns the Incident to notify them of the
breach.

Respond by Warning
- Incident Created

Waits for the SLA response time value to pass after an Incident is created. If it
passes, this process sends an email to the manager of the user who owns the
Incident and creates a Journal entry warning that the SLA resolution time is
about to breach.

Responded - Calc
SLA Good Field

When the status field of an Incident changes from new to work in progress, the
process uses an expression (SLA calculations) to determine whether the date
and time of the response is less than or equal to the SLA response deadline.

Tip: Use this Automation Process for report or dashboard metrics.
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Incident Reports
CSM provides numerous OOTB Incident Reports, including several Reports with drill-down functionality.
Notable Incident Reports include:

Report Description Association Saved
Search

Incidents by
Owner

Bar chart shows the number of Incidents by CSM
User within a User-specified date range. Also lists
Incident details.

Incident Date Range
for Report

Incidents by
Team

Bar chart shows the number of Incidents by Team
within a User-specified date range. Also lists Incident
details.

Incident Date Range
for Report

Incidents by
Category

Bar chart shows the number of Incidents by
Category within a User-specified date range. Also
lists Incident details.

Incident Date Range
for Report

Incidents by
Priority

Pie chart shows the percentage of Incidents by
Priority within a User-specified date range. Also lists
Incident details.

Incident Date Range
for Report

Incidents that
Occur Most
Often

Bar chart shows the top five Incident categories by
the number of Incidents within a User-specified date
range. Also lists Incident details.

Incident Date Range
for Report

Overdue
Incidents

Bar chart shows the number of overdue Incidents by
Owner. Also lists Incident details. Incident Open

Overdue

Top 10 High
Volume
Customers

Bar chart shows the number of Incidents by
Customer within a User-specified date range. Also
lists Incident details.

Incident Date Range
for Report

Incident Duration
Metrics

Bar charts (each priority (priority 1, priority 2, priority
3) show the number of closed Incidents by duration
(days) within a User-specified date range. Also lists
Incident details.

Incident Closed in
Date Range

My Open
Incidents Lists open Incidents owned by me (Current User). Incident My Open

Incidents

My Open
Incidents by
Category

Lists open Incidents owned by me (Current User) by
category. Incident My Open

Incidents

Condensed High
Volume
Customers

Drill-down Report. Bar graph shows the top ten
Customers based on the number of submitted
Incidents within a User-specified date range. Also
lists Incident details.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident Date Range
for Report
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Report Description Association Saved
Search

Condensed
Incident Duration
Metrics

Drill-down Report. Three bar graphs (based on
Priority) show the number of days required to close
Incidents within a User-specified date range. Also
lists Incident details.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident Closed in
Date Range

Condensed
Incidents with
Longest Duration

Drill-down Report. Bar graph shows the number of
days required to close Incidents (by Incident
category) within a User-specified date range.

Drill down to view the Incidents by clicking a link in
the Incident ID column.

Incident Date Range
for Report

Incident List with
Audit Trail

Drill-down Report. Lists Incidents and their
associated Journal Records within a User-specified
date range.

Drill down to view the Journals by clicking a link in
the Incident ID column. If an Incident does not have
any associated Journals, the Incident ID is not be
underlined (indicates a link).

Incident Date Range
for Report

Incident List with
Task Audit Trail

Drill-down Report. Lists Incidents and their
associated Task records within a User-specified date
range.

Drill down to view the Journals by clicking a link in
Incident ID column. If an Incident does not have any
associated Tasks, the Incident ID is not be
underlined (indicates a link).

Incident Date Range
for Report

Incidents by
Source Call

Drill-down Report. Pie chart shows the percentage of
Incidents based on the source of the initiation (ex: E-
mail, Portal, etc.) within a User-specified date range.

Drill down to view the Incidents by clicking a link in
the Incident Source column.

Incident Date Range
for Report
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Service Portfolio/Service Catalog Management
Service Portfolio management is the process that allows organizations to create and manage a
comprehensive set of service offerings for customers.

In CSM, the heart of the Service Portfolio is the Service Catalog. The Service Catalog is imperative to a
service desk because it defines and communicates a list of services that an organization provides to its
employees or customers.

Each Service in a catalog is defined by:

• Basic information: Name, description, status, stakeholders/owners, costs, etc.

• Service Categorization: The service categorization has a three-tiered organization (service,
category, and subcategory) that determines the type of support required (Incident or Request),
which Specifics form to display to capture the appropriate details, and which Priority Matrix to use.

• SLAs: A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a Service Provider that defines response/resolve target times for a service.

• Priority: The priority is used to establish timescales and effort to respond to and resolve an issue
(Incident or Request). Priority is derived from an impact and urgency Priority Matrix.
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About Services and Service Catalogs
The Service Catalog is imperative to a service desk because it defines and communicates a list of
Services that an organization provides to its employees or customers. Each Service in a catalog is
defined by:

• Basic information: Name, description, status, stakeholders/owners, costs, etc.

• Service Categorization: The Service categorization has a three-tiered organization (Service,
category, and subcategory) that determines the type of support required (Incident or Request),
which Specifics form to display to capture the appropriate details, and which Priority Matrix to use.

• SLAs: A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a Service Provider that defines Response/Resolve target times for a
Service.

• Priority: The priority is used to establish timescales and effort to respond to and resolve an issue
(Incident or Request). Priority is derived from an impact and urgency Priority Matrix.

To get your service desk started, CSM provides a thorough OOTB Service Catalog (found in the CSM
Portal), shown in the following figure.

In CSM, a Service is a Major Business Object. The Service Form defines each Service. For more
information about the Service Form, refer to the Service Form documentation.
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Service Categorization
The Service categorization has a three-tiered organization: Service, category, and subcategory.

The organization determines:

• Which Priority Matrix to use.

• The type of support required (Incident or Service Request).

• Which Specifics form to display to capture the appropriate details.

The following figure shows how the Service, category, and subcategory work together to identify an issue
as an Incident or Service Request, and then display the appropriate Specifics form.

The Category and Subcategory forms define your Service categories/subcategories. These forms are
child forms, and are linked to and available from their parent Service form (Category and Subcategory
tabs in the Service form's Arrangement section).

There are several different Specifics forms. The Subcategory form determines the Specifics form that
displays.
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Service Good to Know
• Search for one or more Services that meet a specific criteria by running a Quick Search or Search

Group.

• The Service categorization has a three-tiered organization (Service, category, and subcategory) that
determines the type of support required (Incident or Request), which Specifics form to display to
capture the appropriate details, and which Priority Matrix to use.

• CSM provides several OOTB categories and subcategories to use as part of the Service
categorization. Use these categories and subcategories as-s, edit them, or create your own using
their respective forms in the Arrangement area of the Service Form.

• CSM implements several OOTB Actions/One-Step Actions to make Service management more
efficient. For more information about Actions and One-Step Actions, refer to the Actions/One-Step
Actions documentation.
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OOTB Service Categories and Subcategories
CSM provides the following OOTB Categories and Subcategories.

Service Category Subcategory Incident
Type Specific Form

Account
Management Network Access Change Password Request Standard Details

Account
Management Network Access New Account Request Standard Details

Account
Management Network Access Password Reset Request Standard Details

Account
Management Network Access New Account Request Standard Details

Account
Management Network Access Remove Access/

Permissions Request Standard Details

Account
Management Self Service Change Password Request Standard Details

Account
Management Self Service New Account Request Standard Details

Conferencing/
Presentation

Equipment
Request

Request Conference
Phone Request Presentation

Conferencing/
Presentation

Equipment
Request Request Projector Request Presentation

Conferencing/
Presentation

Equipment
Request Request Webcam Request Presentation

Conferencing/
Presentation

Video/Audio
Conferencing

One-Time
Convergence Setup Request Presentation

Conferencing/
Presentation

Video/Audio
Conferencing Request Account Request Presentation

Desktop
Management Anti-Virus Request Installation/

Config Request Standard Details

Desktop
Management Anti-Virus Submit Incident Incident Standard Details

Desktop
Management Computer Request Computer

Upgrade Request Standard Details

Desktop
Management Computer Request New

Computer Request Order Computer

Desktop
Management Computer Request Removal of

Computer Request Standard Details
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Service Category Subcategory Incident
Type Specific Form

Desktop
Management Computer Submit Incident Incident Standard Details

Desktop
Management Misc. Software Request Installation/

Config Request Standard Details

Desktop
Management Misc. Software Submit Incident Incident Standard Details

Desktop
Management OS Request Upgrade Request Standard Details

Desktop
Management OS Submit Incident Incident Standard Details

E-mail/Calendaring Browser Client Request Access/
installation Request Website Address

E-mail/Calendaring Browser Client Submit Incident Incident Connectivity

E-mail/Calendaring Desktop Client Request Access/
installation Request Standard Details

E-mail/Calendaring Desktop Client Submit Incident Incident Connectivity

E-mail/Calendaring Mailbox Request Disk Quote
Increase Request Request Disk Quota

Increase

E-mail/Calendaring Mailbox Request Mailbox or
Alias Request Request Mailbox or

Alias

E-mail/Calendaring Mailbox Spam Filter request Request Spam Filter Request

E-mail/Calendaring Mobile Client Request Access/
installation Request Standard Details

E-mail/Calendaring Mobile Client Submit Incident Incident Connectivity

Employee Support Add/Change Employee Separation Request Employee
Departure

Employee Support Add/Change New Employee Setup Request New Employee

Employee Support Add/Change Update Employee Request Update Employee

Enterprise Apps Accounting
System NA Incident Standard Details

Enterprise Apps CRM/Sales
Software NA Incident Standard Details

Enterprise Apps JD Edwards Convert to Option
form Request Standard Details

Enterprise Apps JD Edwards Submit Incident Incident Standard Details

Enterprise Apps MS Office NA Request Standard Details

Enterprise Apps MS Office Submit Incident Incident Standard Details

CSM 10.5.0 ITSM Practices 48

CSM 10.5.0 ITSM Practices



Service Category Subcategory Incident
Type Specific Form

Enterprise Apps Office Suite NA Request Standard Details

Enterprise Apps Oracle Convert to Option
form Request Standard Details

Enterprise Apps Oracle Submit Incident Incident Standard Details

Enterprise Apps PeopleSoft NA Request Standard Details

Enterprise Apps PeopleSoft Submit Incident Incident Standard Details

Enterprise Apps SAP NA Request Standard Details

Enterprise Apps SAP Submit Incident Incident Standard Details

IT Service Desk Report Outage or
Error NA Incident Standard Details

IT Service Desk Report Outage or
Error Submit Incident Incident Standard Details

IT Service Desk Request Help NA Request Standard Details

IT Service Desk Request Help Submit Service
Request Request Standard Details

Network Services Backup/Restore Request Full Restore
of backup Request Backup/Restore

Network Services Backup/Restore Request new backup
job Request Backup/Restore

Network Services Backup/Restore Request restore of
files Request Backup/restore

Network Services Fileserver Request File Share Request Request File Share

Network Services Fileserver Request increase in
disk quota Request Request Increase in

Disk Quota

Network Services Physical Wires Request new wiring Request Request New Wiring

Network Services Physical Wires Request relocation or
wiring Request Request Relocation

of Wiring

Network Services Physical Wires Submit Incident Incident Standard Details

Network Services Wireless Request Access Request Request Access

Network Services Wireless Submit Incident Incident Standard Details

Printing Desktop Request desktop
printer Request Printer Order Form

Printing Desktop Request toner/ink Request Toner Order Form

Printing Desktop Submit Incident Incident Print Incident

Printing Network Request access to
network printer Request Request Access to

Network Printer
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Service Category Subcategory Incident
Type Specific Form

Printing Network Request new network
printer Request Printer Order Form

Printing Network Request toner/ink Request Toner Order Form

Printing Network Submit Incident Incident Print Incident

Telephony/Fax Call Center
Telephony

Move/add/change
user or queue Request Standard Details

Telephony/Fax Call Center
Telephony

Request ACV/IVR
change Request Standard Details

Telephony/Fax Call Center
Telephony Submit Incident Incident Phone/Fax Incident

Telephony/Fax Desktop
Telephone Request telephone Request Standard Details

Telephony/Fax Desktop
Telephone Submit Incident Incident Phone/Fax Incident

Telephony/Fax Fax Request FAX
hardware Request Standard Details

Telephony/Fax Fax Request FAX software Request Standard Details

Telephony/Fax Fax Request FAX toner/ink Request Standard Details

Telephony/Fax Fax Submit Incident Incident Phone/Fax Incident

Telephony/Fax Mobile Telephone Request telephone Request Standard Details

Telephony/Fax Mobile Telephone Submit Incident Incident Phone/Fax Incident

Web Services Internet Request new page or
site Request

Request New Page
or Site Specifics
Screen

Web Services Internet Request update to
page or site Request

Request New Page
or Site Specifics
Screen

Web Services Internet Submit Incident Incident Standard Details
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Service Level Agreements (SLAs)
A Service Level Agreement (SLA) is an agreement between an entity (Customer, Service, or
Configuration Item) and a service provider that defines Response and Resolve target times for a Service.
SLAs can be a formal agreement between an organization and its customers, or a guide for technicians.

The SLA is the technician's guarantee to the customer saying, "I will respond to you within [a specified
period of time]," and "I will provide a solution for your issue within [a specified period of time]." SLA is one
of the most important metrics for ITSM, in addition to being one of the benchmarks for success.

In CSM, an SLA is a Major Business Object. The SLA form defines and manages the SLA.

Good to Know

• As configured OOTB, SLA selection is Time-Based. Tickets automatically select the shortest SLA•
time to apply.

• SLA uses technician working hours as its reference point, unless it is configured to use 24/7. At the•
time a customer submits a ticket, the SLA checks to see if technician working hours are currently
active. If they are not, the deadline calculation will not start until the technician working hours are in
effect again.

• Organizations that span many time zones, or where customer working hours differ significantly from•
technician working hours, should set SLAs in hours (example: 24 hours) rather than days (example:
1 day) to account for different day start and stop times.

• The Preview link under the Actions list on the SLA form allows you to propose hypothetical ticket•
situations to see what SLA deadlines look like with the current SLA is applied. Keep in mind that this
tool does not account for differences in working hours, so it reflects situations where the customer
and the technician share the same working hours.

Related concepts
How SLA Deadlines are Calculated
SLA Working Hours
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SLA Models
CSM provides two types of SLA models: Time-Based Model and Hierarchy-Based Model.

Note: Changing the SLA model only affects Incidents and Service Requests created after the
model is selected, so we recommend choosing a model during initial implementation.

Time-Based Model
In OOTB content, SLAs select based on the Time-Based Model, which takes the soonest deadline for any
SLAs associated to the ticket.

If you use the Time-Based model, CSM calculates, in real time, which SLA results in the earliest
resolution deadline and uses that in the event there are multiple SLAs present. The shortest SLA is then
applied to the resolution and response deadlines.

Hierarchy-Based Model
In the event of multiple SLAs, CSM chooses the SLA type that is highest in the following hierarchy
(provided the necessary overrides are in place):

• Config Item: SLAs for Configuration Items (CIs), typically based on criticality (example: Primary
Server). A Config Item SLA overrides every other SLA.

• Service: SLAs for a Service, typically based on criticality (example: Email service is really
important). A Service SLA overrides a Customer and Corporate SLA. Not many Services require a
special SLA. In the OOTB system, only Desktop Management and E-mail Calendaring have their
own SLAs.

• Customer: SLAs for customer levels, typically based on employee status (Platinum, Gold, Silver,
Bronze). A Customer SLA overrides a Corporate SLA.

• Corporate (default): Default SLA. Many organizations use only this SLA type.

See SLA and Priority for Response/Resolve Target Times by Work Hours and Priority.
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SLA Target Times
SLA Target Times calculate the duration of time in which a technician must resolve or respond to a ticket.

SLA Target Times can be set in days, hours, or minutes. They can either allow or not allow Stop the
Clock. Target Times can also be tied to a Working Hours calendar. They define the behavior of an SLA
and are based on:

• Priority: A P1 should have faster target times than a P5.

• Record Type: A disruption (Incident) should have faster target times than a Request.

• SLA Type: SLAs can be bound to a customer, a service, and a CI. A critical CI (server) should have
faster target times than a non-critical system.

Use this comprehensive processing to ensure that Incidents and Requests involving customers, services,
and CIs are appropriately serviced according to the needs of your organization.

For example, set a Resolve Target Time of 90 hours for a P3 Corporate Request, such as a software
upgrade. Consider a faster resolve time (example: Eight hours) for executives. Reserve your most
aggressive Respond target times (example: Five minutes) for a critical P1 Config Item Incident, such as
the primary server going down.

Note: See SLA and Priority for Response/Resolve Target Times by Work Hours and Priority.

Related concepts
Stop the Clock
SLA Working Hours

CSM 10.5.0 ITSM Practices 53

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=sla-priority_spreadsheet
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fsla_stop_the_clock_stc.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fsla_working_hours.html


Stop the Clock
Stop the Clock (STC) is a feature in OOTB SLA calculations that allows the technician to pause the SLA
clock while the ticket is in Pending status.

Use the STC status when the technician is waiting on information from the customer, the customer is
unavailable, the ticket requires completion of a Change Request, or other reasons. It may be appropriate
to allow this time to delay the SLA deadline, depending on the urgency of the SLA. Manage whether an
SLA uses STC by selecting the Allow "Stop the Clock" check box under Advanced Options in the SLA
form.
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SLA Working Hours
Working Hours define the calendar by which the SLA deadlines are calculated.

Use Working Hours to determine when time counts towards the SLA deadline and when it does not.
Manage these in the Business Hours Manager (in the CSM Administrator Managers menu).

Customer and Technician Working Hours
By default, the OOTB SLA configuration uses either a 24/7 calendar or the working hours of the
technician (8-5 calendar on the same time as the CSM server). When the ticket is created, the customer's
working hours are considered; however, they are not the frame of reference for the OOTB SLA deadlines.
Consideration of the customer's working hours is limited to a match/no match determination, which helps
CSM decide whether to start the clock (if the customer's hours match the technician's) or wait until the
technician's working hours (if they do not match the customer's).

If you prefer, you can add the customer's working hours calendar and configure the SLAs to adhere to
those instead.
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SLA and Priority
The SLA and Priority data describes the OOTB Hierarchy-Based Model SLAs. SLAs are listed
hierarchically by SLA type, and show Response/Resolve Target Times by Work Hours and Priority.

Note: For 24/7 support, resolution Target Times can be expressed in days, hours, or minutes.

Table 1. Config Item SLA for Primary Server

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For the server
that runs many
of the mission-
critical
applications

Standard

Incidents: 24 x 7

1 5 mins 1 hr

2 5 mins 2 hrs

3 10 mins 3 hrs

4 15 mins 4 hrs

Service Requests:
8-5 Monday-
Friday

1 10 mins 2 hrs

2 15 mins 3 hrs

3 20 mins 4 hrs

Table 2. Service SLA for Email Service

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For Email
Service provided
for the entire
organization

Email/
Calendaring

Incidents: 24 x 7

1 15 mins 2 hrs

2 15 mins 4 hrs

3 30 mins 6 hrs

4 30 mins 8 hrs

Service Requests:
8-5 Monday-
Friday

1 1 hr 6 hrs

2 2 hrs 1 day

3 4 hrs 3 days
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Table 3. Customer SLA for Platinum Level

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For VIP
customers (must
be director or
above)

Standard

Incidents: 24 x 7

1 15 mins 2 hrs

2 15 mins 4 hrs

3 30 mins 6 hrs

4 30 mins 8 hrs

Service Requests:
8-5 Monday-
Friday

1 1 hr 2 hrs

2 2 hrs 3 hrs

3 4 hrs 4 hrs

Table 4. Customer SLA for Gold Level

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For IP
customers
(example: Sales
and IT
department)

Standard

Incidents: 24 x 7

1 30 mins 3 hrs

2 30 mins 8 hrs

3 1 hr 12 hrs

4 3 hrs 16 hrs

Service Requests:
8-5 Monday-
Friday

1 1 hr 4 hrs

2 2 hrs 12 hrs

3 4 hrs 16 hrs

Table 5. Customer SLA for Silver Level

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For managers
and supervisors. Standard

Incidents: 24 x 7

1 1 hr 5 hrs

2 1 hr 1 day

3 2 hrs 2 days

4 2 hrs 3 days

Service Requests:
8-5 Monday-
Friday

1 2 hrs 2 days

2 2 hrs 5 days

3 1 day 10 days
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Table 6. Customer SLA for Bronze Level

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

For the
accounting
department

Standard

Incidents: 24 x 7

1 45 mins 5 hrs

2 45 mins 1 day

3 2 hrs 2 days

4 5 hrs 3 days

Service Requests:
8-5 Monday-
Friday

1 75 mins 4 hrs

2 2 hrs 2 days

3 3 hrs 5 days

Table 7. Corporate SLA for Corporate

Description Type Target Time:
Work Hours

Target Time:
Priority

Target Time:
Response

Target Time:
Resolve

Default for all
customers who
are not entitled
to a Customer
Service Level

Standard

Incidents: 24 x 7

1 1 hr 5 hrs

2 1 hr 2 days

3 2 hrs 3 days

4 2 hrs 5 days

5 2 hrs 9 days

Service Requests:
8-5 Monday-
Friday

1 2 hrs 2 days

2 2 hrs 5 days

3 1 day 10 days
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How SLA Deadlines are Calculated
The two processes to calculate SLA deadlines are Resolve By Without STC and Resolve By With STC.

Note: Respond By and Resolve By deadlines are calculated using different expressions that work
essentially that same way on different objects (the name and relevant deadline are different). This
topic provides calculations for Resolve By deadlines as an example.

The Resolve By Without STC flowchart shows the process for how timelines are calculated for SLAs that
do not allow Stop the Clock.

The Resolve By With STC flowchart describes the process for how timelines are calculated for SLAs that
allow Stop the Clock. It is based on the result of the Resolve By Without STC expression shown above.
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Each of the SLA deadline calculations consider Working Hours as specified in the SLA itself. See SLA
Working Hours.
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How SLAs are Selected
SLAs are selected based on the time, type, and number of SLAs.

The SLA Selection flowchart describes the process for how CSM determines the Incident SLA.

Note: In OOTB content, the stored variable Use time-based SLA mode is set to True so OOTB
SLAs select based on the shortest amount of time for any associated SLAs.

The Service is Shortest SLA flowchart describes the decision-making process to determine that Service is
the shortest SLA. Other SLA types use a similar workflow.
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• In the Time-Based Model, this is one sample expression that returns true if service is the shortest
SLA. Every SLA type has a similar expression.

• When a ticket is created, CSM uses a selection model to ensure the shortest SLA applies. You can
also set the system to use the Hierarchy-Based Model, where specific SLA types win out.
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OOTB SLAs
The SLA Model and the SLA/Priority Spreadsheet define OOTB SLAs.

OOTB SLAs are configured as an example SLA setup. They use a Time-Based SLA model and contain
many different SLA types (CI, Customer, Service, and Corporate). If you use the OOTB SLAs, the
following apply:

• Incident and Service Requests use the Priority Matrix as configured OOTB.•

• Stop the Clock (STC) is allowed for some less critical SLAs, as indicated.•

• The Automation Process server is set up and emails are customized (used in Warning and Breach•
notifications).

• The customer's working hours match the technician's, or if they do not match, the technician's hours•
take priority.

Related concepts
Stop the Clock
SLA Working Hours
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SLA Forms
Manage SLA forms in CSM Administrator through the SLA Business Object. The SLA form displays when
you create a new (or modify an existing) SLA in the CSM Desktop Client or CSM Browser Client.

These SLA forms are available OOTB:

• Edit

• Preview

• SLA

• SLA Overview

• SLA Summary

To manage SLA forms:

1. In CSM Administrator, select Create a New Blueprint.
2. Select the SLA Business Object, and then select Edit Form.
3. Under SLA forms, select the form you wish to manage.
4. Make any necessary changes.
5. Save the form and publish the Blueprint.

Related concepts
Manage SLA Forms
Related tasks
Create SLAs
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SLA Lifecycle
The OOTB system SLA lifecycle consists of phases from New through Retired. SLA forms and One-
Step™ Actions enhance the workflow.

1 A One-Step Action changes the status to Planning.

2 A One-Step Action changes the status to Active.

3

When periodically assessing, the owner can revise, deactivate, or retire the SLA.

• Revise: a One-Step Action changes the status back to Planning.

• Deactivate: a One-Step Action changes the status to Inactive.

• Retire: a One-Step Action changes the status to Retired.

4

When deactivated, the owner can revise, reactivate, or retire the SLA.

• Revise: a One-Step Action changes the status back to Planning.

• Reactivate: a One-Step Action changes the status back to Active.

• Retire: a One-Step Action changes the status to Retired.

5

When retired, the owner can revise or reactivate the SLA.

• Revise: a One-Step Action changes the status back to Planning.

• Reactivate: a One-Step Action changes the status back to Active.
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Note: CSM uses several features to enhance the SLA workflow (example: The SLA form helps
create and manage SLAs and One-Step Actions help move the SLA through its workflow).

Contributors
The SLA typically involves the following contributors. Depending on the workflow and the size of your
company, the creator and owner might be the same person.

• Creator: User that creates the SLA. This is typically a member of the Services team.

• Owner: User that manages the SLA. This is typically a member of the Services team.

• Consumer: Person that uses the SLA. This is typically a customer or user (technician) logging a
record.

Phases
The SLA workflow is broken down into the following phases:

1. New: Creator creates a new SLA and assigns ownership. Then, the owner defines the initial details
and submits the SLA for planning/development.

2. Planning (Development): Owner develops the SLA, including Target Times and Priority Matrix
Elements. When ready, the owner activates the SLA.

3. Active: SLA is operational in a live environment. Owner periodically assesses the SLA (SLA can be
sent back for review/rework or retired, if necessary).

4. Inactive: SLA is temporarily out of use. Owner periodically assesses the SLA (SLA can be sent
back for review/rework or retired, if necessary).

5. Retired: Expired/out-of-date SLA is retired. Owner can send the SLA back for review/rework, if
necessary.
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Create SLAs
Create an SLA to define times for a Service and use as a metric and benchmark.

Use the following guidelines to help you create an SLA:

• SLA Lifeclycle

• Define SLA Target Times

• Check for Errors

To create a new SLA:

1. In the CSM Desktop Client or CSM Browser Client, select New > New SLA.
2. Add a title and select a subscription level (optional).
3. Select an SLA type and add a description (optional).
4. (Optional) Add a scope and select a priority group
5. (Optional) Select start and end dates, and then select a review date.
6. (Optional) Select any preferred options under the Advanced Options section (example: Select the

Allow "Stop The Clock" check box).
7. (Optional) Select any links under the Actions list (example: Activate This SLA).
8. Use the SLA Target Times tab to define SLA target times.
9. Use the Priority Matrix Elements tab to define the Priority Matrix Elements.

10. (Optional) Select the Preview link under the Actions list to propose hypothetical ticket situations to
see what SLA deadlines would look like with the current SLA applied. Keep in mind that this tool
does not account for differences in working hours, and so it best reflects situations where the
customer and the technician share the same working hours.

11. Select Save.

Related concepts
SLA Lifecycle
Check for Errors
Priority Matrix Element Form
Related tasks
Define SLA Target Times

CSM 10.5.0 ITSM Practices 67

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Fshared%2Fsla_workflow.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fsla_check_for_errors.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fpriority_matrix_element_form.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fdefine_sla_target_times_for_an_existing_sla.html


Define SLA Target Times
Define SLA Target Times based on priority level and record type.

To define SLA target times:

1. Create a new SLA or use the Search Manager to open an existing one.
2. If needed, edit any SLA fields.
3. Select the SLA Target Time tab.
4. Select New SLA Target Time or select an existing SLA Target Time (example: Priority 1 Incident).

The SLA Target Time form opens to the right of the grid.
5. Select Step 1: Priority, and then choose the priority level and record type (example P1, Incident).
6. (Optional) Select Step 2: Hours, and then select the business hours to use.

a. (Optional) Select the Yes, use as default check box to use as the default target time.
7. (Optional) Select Step 3: Response, and then provide the target number of days, hours, or minutes

to respond to the Incident/Service Request.
The response time must be shorter than the maximum time limits of the Operational Level
Agreements (OLAs) and Underpinning Contracts (UCs) linked to the SLA. If the response time is too
short, a warning icon appears.

a. Select the option to set response deadline to be constrained to specific business hours.
If you selected Yes, select the business hours to use.

b. Provide the number of days, hours, or minutes for the warning before the response deadline.
The warning time must be shorter than the response time. If it is not, a warning icon appears.

8. Select Step 4: Resolution, and then provide the target number of days, hours, or minutes to
resolve the Incident/Service Request.
The resolution time must be shorter than the maximum time limits of the Operational Level
Agreements (OLAs) and Underpinning Contracts (UCs) linked to the SLA. If the resolution time is
too short, a warning icon appears.

a. Select the option to set response deadline to be constrained to specific business hours.
If you selected Yes, select the business hours to use.

b. Provide the number of days, hours, or minutes for the warning before the response deadline.
The warning time must be shorter than the response time. If it is not, a warning icon appears.

9. Select Review to review the target time fields.
10. Select Save.

The new target time appears in the SLA Target Times Tab.

Related concepts
Run a Saved Search
Target Times Form
Related tasks
Create SLAs
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Check for Errors
Use the Check for Errors One-Step™ Action to test SLAs in CSM.

Due to the complex, data-driven nature of SLAs, CSM incorporates a One-Step Action to help mitigate
errors that you may encounter when you create or configure an SLA.

Note: The error-checking mechanism may not catch every error. It should not be used as a
guarantee but rather as a supplement to thorough SLA design and implementation.

Use one of the following ways to initiate error checking:

• On the SLA form, select the Check for Errors link in the Actions list.

• On the SLA form, select the Check For Errors On Save check box under Advanced Options, and
then save the record.

Check for Errors One-Step Action:

1. Setup Error Testing: The first step of the One-Step Action clears out the temporary fields that are
used during the rest of the process.

2. Check Incident Target Times: Next, the One-Step Action verifies that for every SLA target time for
Incident there is exactly one default. If no defaults are present, the system does not know how to
handle exceptional cases in which an Incident is created outside of the business hours that the SLA
target times are set up for. Additionally, more than one default would be ambiguous leading to
unpredictable results.

3. Check Service Request Target Times: The same checks that are performed against the Incident
SLA target times are performed against the Service Request SLA target times.

4. Incident Matrix Matching: This step verifies that for each Incident priority available via the priority
matrix, there is a corresponding SLA target time to handle that given priority. If any discrepancies
are found, they are added to the list of errors to be displayed at the end of the error checking.

5. Service Request Matrix Matching: This step tests for consistency between the Priority Matrix
Elements (PMEs) and SLA target times for Service Requests.

6. Check Response vs. Resolution: This step makes a quick pass through all SLA target times and
compares the response and resolution times. If the response time is greater than the resolution
time, an error is displayed.

7. Display Results: Finally, a popup is displayed showing any errors found or a confirmation that no
errors were found.
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Apply SLAs
To apply an SLA, create an Incident with a default SLA. CSM uses this process to initially set the timelines
for the SLA and then determines whether or not the default SLA should update as more information is
added to the ticket.

How SLAs are applied

• Incidents are created with a default SLA (OOTB = Corporate).

• Application is based on the SLA that wins the selection process.

• If an element is added to the ticket that has a SLA tied to it, CSM checks to see whether the default
SLA should update, and change if needed (SLA Selection).

The SLA Timelines Created flowchart shows how timelines are initially set for SLA.

The SLA Selection flowchart shows how CSM determines the Incident SLA after the Incident has been
created as more information is added to the ticket (example: when a customer is added).
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The SLA Timelines/Stats Changed flowchart shows how SLA timelines are changed during the lifecycle of
the ticket, and the associated APs that are triggered.
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SLA is affected if a ticket goes to any of these statuses:

• In Progress: Marks the response-by date and time.

• Pending: Calculates total amount of time (in minutes) in this status. If Stop The Clock (STC) is
allowed, this time will be added to extend the deadline to prevent the SLA from breaching.

• Closed: Marks the resolution date and time.

• Reopened: Begins monitoring for SLA breach again based on the ticket SLA deadline. Time spent
in Closed status does not stop the clock.

SLA Breach

• A warning is initiated (if configured), the ticket is marked as warned, and emails are sent (if
configured).

CSM 10.5.0 ITSM Practices 72

CSM 10.5.0 ITSM Practices



• One-Step™ Action runs (OOTB: marks the ticket as having breached, emails the technician/
manager). Breached incidents display in applicable dashboards/metrics.
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Priority
The priority is used to establish timescales and effort to respond to and resolve an issue (Incident or
Request). Priority is derived from an impact and urgency Priority Matrix.

• Impact: Measures the effect of an Incident/Request (ex: Number of Customers affected/influenced
by the Incident).

• Urgency: Measures how long it will be until the Incident has a significant impact on the business (ex:
If the e-mail server goes down, all Customers are immediately affected).

CSM uses Priority Matrixes to automatically calculate priority and to provide a visual perspective of how
priorities align. Because Incidents and Requests typically require different priorities, each uses its own
Matrix. Priority Matrixes are organized by Priority Groups so that they can be applied to Services. Default
Priority Groups include:

• Standard: Standard Priority Matrixes for Incident and Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the E-mail/Calendaring Service. Priority Groups
and Priority Matrixes are configurable, so any Service/entity can have its own Priority Group/Matrix.

A Priority Matrix Element Form defines each priority that populates your Priority Matrix. This form is a
child form, and is linked to and available from its parent SLA Form (Priority Matrix Elements tab in the
SLA Form Arrangement).

Note: For more information about the Priority Matrix Element Form, refer to the Priority Matrix
Element Form documentation.

CSM 10.5.0 ITSM Practices 74

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=priority_matrix_element_form
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=priority_matrix_element_form


OOTB Priority Matrixes
OOTB Priority Groups include:

• Standard: Standard Priority Matrixes for Incident and Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the E-mail/Calendaring Service. Priority Groups
and Priority Matrixes are customizable, so any Service/entity can have its own Priority Group/Matrix.

Standard Incident Priority Matrix

Standard Incident Priority Matrix
Impact

Company Department Individual

Urgency

 

High 1 2 3

Medium 2 3 4

Low 3 4 5

Standard Request Priority Matrix

Standard Request Priority Matrix
Impact

Must Have Should Have Whenever Possible

Urgency
Expedite 1 2 3

Standard 2 3 3

E-mail/Calendaring Incident Priority Matrix

E-mail/Calendaring Incident Priority Matrix
Impact

Company Department Team Individual

Urgency
Critical 1 1 2 2

Normal 3 3 4 4

E-mail/Calendaring Request Priority Matrix

E-mail/Calendaring Request Priority Matrix
Impact

Critical Routine

Urgency
Expedite 1 2

Standard 2 3
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Service Workflow
Diagram describes the high-level Service workflow in the OOTB system.

1 A One-Step™ Action changes the status to Approval.

2

The Approver can approve or reject a Service.

• Approve: a One-Step Action changes the status to Development.

• Reject: a One-Step Action changes the status back to Planning.

3 A One-Step Action changes the status to Active. The Service is now available to users and
customers.

4

When periodically assessing, the Owner can revise or retire a Service.

• Revise: a One-Step Action changes the status back to Planning.

• Retire: a One-Step Action changes the status to Retired.

5 When retired, the Owner can reactive a Service. A One-Step Action changes the status back to
Active.

Note:

• CSM uses several features to enhance the Service workflow (example: The Service Form
helps create and manage Services, One-Step Actions help move a Service through its
workflow, etc.).
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• Service phases align with Service statuses, but this is not the case in every process
(example: Incident phases are different than Incident statuses).

Contributors
A Service typically involves the following contributors. Depending on your workflow and the size of your
company, many of these contributors might be combined into one person (example: Creator and Owner
might be the same person).

• Creator: User who creates the Service. This is typically a member of the Services Team.

• Owner: User who manages the Service. This is typically a member of the Services Team.

• Approver: User who ensures that the Service is ready to be released and made operational in a live
environment. This is typically the Service/IT Manager.

• Consumer: Person who uses the Service. This is typically a customer or user logging a record.

Phases
The Service workflow is broken down into the following phases:

1. Planning: Creator creates a new Service. Ownership is assigned. Then, the owner designs the
Service and submits it to an Approver for approval to develop.

2. Approval: Approver approves the Service for development. The Approver can also reject the
Service and send it back for rework.

3. Development: Owner defines categories and subcategories for the Service. When ready, the
Owner releases/activates the Service.

4. Active: Service is operational in a live environment. The Service is periodically assessed by the
Owner. The Service can be sent back for review/rework or be retired if necessary.

5. Retired: Expired/out-of-date Service is retired. The Service can be reactivated, if necessary.
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Create a Service/SLA/Priority Structure
To create a Service, SLA, Priority structure:

1. Design a three-tier Categorization for each Service.

2. See SLA and Priority.

3. Create one or more SLAs:

Tip: CSM provides a default SLA, named Corporate. Consider using this SLA for all Incidents/
Requests. If needed, change the Target Times to meet your needs.

a. Create a new SLA by clicking File>New>New SLA from the CSM Desktop Client menu bar or
by clicking New>New SLA on the CSM Desktop Client toolbar.

A new SLA Record is created with a Status of New.

b. Complete the SLA fields. The Title and SLA Type are required to save the record.

c. Plan your SLA:
i. In the Status alert bar, click Set to Planning.

The SLA status changes to Planning.

d. Define your SLA Target Times:
i. Click the SLA Target Times tab (Form Arrangement area).

ii. Click New SLA Target Time.

The New SLA Target Times form opens.

Note: For detailed field information, refer to the Target Times Form documentation.

Notes: By default, the Target Times form uses a wizard interface that provides helpful
information for creating Target Times. To bypass the Target Times wizard and complete
the information using one form, select the Disable Target Time Wizard radio button
under Advanced Options in the Main Pane.

iii. Select/define your Priority and parent type.

iv. Click the Next button  and define your Work Hours.

v. Click the Next button  and define your Response Time.

vi. Click the Next button  and define your Resolution Time.

e. Add values to your Priority Matrix:
i. Click the Priority Matrix Element tab (Form Arrangement area).

ii. Click New Priority Matrix Element.

The Priority Matrix Element form opens.
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iii. Define the priorities.

Note: For detailed field information, refer to Priority Matrix Element form.

4. Activate your SLA:
a. In the Status alert bar, click Active.

5. Create one or more Services:
a. Create a new Service by clicking File>New>New Service from the CSM Desktop Client menu

bar or by clicking New>New Service on the CSM Desktop Client toolbar.

A new Service Record is created with a Status of Planning.

b. Define the Service fields.

Note: For detailed field information, refer to the Service Form documentation.

c. Define the Service Categories:
i. Click the Categories tab (Service Form Arrangements area).

ii. Click New Category.

The Category form opens.

iii. Complete the fields.

Note: For detailed information, refer to the Service Form documentation.

d. Define the Service Subcategories:
i. Click the Subcategories tab (Arrangements area).

ii. Click New Subcategory.

The Subcategory form opens.

iii. Define the fields.

Note: For more information, refer to the Service Form documentation.

6. Activate your Service:
a. In the Status alert bar, click Set as Active.

7. After the SLA is activated, you have the following options:
a. If you discover that work needs to be done on the SLA, click the Deactivate this SLA link to

temporarily disable it (Status changes to Inactive). The SLA can be reactivated by clicking the
Set to Planning link in the Status alert bar.

b. If the SLA is no longer applicable, click Retire this SLA (Status changes to Retired). The SLA
can be reactivated by clicking the Set to Planning link in the Status alert bar.
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Service Design Ideas
CSM provides an OOTB Service workflow with all the items you need to successfully manage Services.
You can use this workflow, or tailor it to meet the needs of your organization.

Design ideas include:

• Fields: Change which fields are required and when, which fields support Rich Text, etc.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the Desktop Client, Browser Client, and CSM Portal. View Counter functionality is configured in
CSM Administrator.

• Statuses: Change Service statuses and/or the One-Step Actions that are initiated when a Service
enters each status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate your workflow.

• Email: Change the templates that are used to create the emails sent by One-Step Actions or
Automation Processes (example: "Notify Owned By via Email" One-Step Action). The email
templates are defined as part of the One-Step Action. Or, disable/change when and to whom
notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that monitor Incidents
(example: Monitors for record inactivity, sends automatic notification emails, etc.).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down fields.

• Relationships: Consider creating a relationship to show an association between Service and
Customer - Internal so you can view all Services used by a particular customer and all customers
associated with a particular Service.

Note: Detailed step-by-step instructions for the above is beyond the scope of this content.
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Service/Service Catalog Features
CSM provides the following tools to help manage Services.
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Service Form
Use the Service Form to define and manage your Services.

The Service Form is made up of four main areas:

1. Default Form: Displays Service name, status, and Created By information.

2. Form Arrangement: Dynamically displays linked records (Child Records) that are in a relationship
with the parent Service record.

3. Form Area: Displays the form fields for the tab selected in the Form Arrangement. The Overview
form contains the most important information related to the Service.

4. Actions List: Dynamically displays a list of actions that are available for the current Service.
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Good to know:

• Search for one or more Services that meet a specific criteria by running a Quick Search or Saved
Search.

• Create a new Service by selecting New > New Service on the CSM Desktop Client toolbar or File >
New > New Service from the CSM Desktop Client menu bar.

• The Service categorization has a three-tiered organization (Service, category, and subcategory) that
determines the type of support required (Incident or Request), which Specifics Form to display to
capture the appropriate details, and which Priority Matrix to use.

• CSM provides multiple OOTB Services for use throughout CSM. Use these Services as-is or create
your own using the Service Form.

• CSM provides several OOTB categories and subcategories to use as part of the Service
categorization. Use these categories and subcategories as-is, edit them, or create your own using
their respective forms in the Arrangement area of the Service Form.

• CSM implements several OOTB Actions/One-Step™ Action to make Service management more
efficient. For more information about Actions and One-Step Actions, refer to the Actions/One-Step
Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (example:
Major).

• The Status (in the Default Form) indicates the current phase of the Service as it moves through its
workflow.

• The Form Area displays the main form fields.

• Fields:
◦ Some validated fields can recognize what you are typing and will suggest a value for you

(example: Type "P" into the field; CSM will suggest the first item it finds that starts with the
letter P). Use the Down Arrow button to scroll through other possible values.

◦ Press F3 to open a Selector window, where you can select a legal value or create a new
value.

◦ Press Tab to move to the "next" field on the form.

• Saving:

◦ Date, time, and user name information is recorded the first time the form is saved, and each◦
time the form is modified.

The following table describes the fields on the form.
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Field Description Comments

Default Form

Important at-a-glance information, such as
record type, Status bar (current and next
Status), Review Date, Service Type, and
record ownership.

Status

Current Status of the Service as it moves
through the Service workflow. Statuses
include:

• Planning: Service is being created and
designed.

• Approval: Requirements are being
finalized and authorized. Requirements
are communicated, budgets and
resources are allocated.

• Development: Service is being
developed (refined and tested).

• Active: Service is operational in a live
environment.

• Retired: Service is retired from use.

Next: Status

Select the links to move the Service through
the Service workflow. Actions include:

• Submit for Approval: Changes the
Service Status to Approval.

• Begin Development: Changes the
Service Status to Development.

• Reject: Changes the Service Status
back to Approval.

• Set as Active: Changes the Service
Status to Active.

• Retire: Changes the Service Status to
Retired.

• Submit for Review: Changes the
Service Status back to Approval.

One-Step Actions (Alt 1 Step from
Relationship, Alt 2 Step from
Relationship, or Next Step from
Relationship): Conditionally
changes the record Status to next
logical Status (defined by the
Status values in Table
Management).

Form Area

<Service Name>
Name that uniquely identifies the Service. Be
succinct because the Service Catalog
displays this name.

Service Manager Service/Record owner. Person responsible
for owning the Service.
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Field Description Comments

Specifics Name Specifics Form is associated with the
Service.

Description Description of the Service.

Services Included List of mini services included in the Service.

Service SLA

Service SLA bound to this Service, if
applicable.

Note: Not many Services require a
special SLA. In the OOTB system,
only Desktop Management and E-
mail Calendaring have their own
SLAs.

Review Date

Scheduled review MM/DD/YYYY for the
selected Service. Select the Calendar
button  to launch a Calendar where you
can schedule a date.

Used to allow the Service to be
periodically reviewed to ensure that
it is correct/updated.

Service Type

Type of Service:

• Technical

• Business

Service Classification

Service Classification:

• Core IT

• On Demand

• Subscription

Importance

Service Importance:

• Mission-Critical

• Support

• Optional

Visible in Customer Portal If selected, this Service is part of Service
Catalog available in the Customer Portal.

Optional Services List of optional mini services included in the
Service.
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Field Description Comments

Services Excluded List of mini services not included in the
Service.

SLAs Entitled to this Service

Lists the SLAs that can access the Service in
the Portal (Corporate means every Customer
can access the Service in the Service
Catalog; Platinum, Gold, Silver, and Bronze
limit the Service by Customer status/level).
SLAs must be separated by a comma.

Image

Image that represent the Service in the UI.
Select the Set Image button to open the
Image Manager, where you can select or
import an image.

Business Alignment Business reasoning/alignment supporting
this Service.

Maintenance Calendar Defined Business Hours for the Service, as
defined in the Business Hours Manager.  

Default OLA Team Default OLA team responsible for the
operational components of the Service.  

Business Owner CSM User who is responsible for being the
business stakeholder.  

Outsourced To Vendor to whom the Service is outsourced, if
any.  

Cost Cost per hour associated with the Service.  

Form Arrangement Dynamically displays child records that are in
a relationship with the Service.  

Linked Services Displays related Services that have a
dependency on this Service.  

Categories Displays the defined Service Categories that
categorize your Service.

For more information, see Service
Categorization.

Subcategories Displays the defined Service Categories that
categorize your Service.

Incidents Displays Incidents that are logged to report a
disruption in this Service.

For more information, see About
Incidents and Requests.

Problems Displays Problems that involve this Service.  

Change Requests Displays Change Requests that involve this
Service.  

Configuration items Displays CIs that are related to/support this
Service.  

Service Schedules Displays Service Schedules that affect this
Service (example: Down for maintenance).  
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Field Description Comments

SLAs Displays SLAs that are bound to this Service. For more information, see Service
Level Agreements (SLAs).

Note: For more information about the Service One-Step Actions, see Service One-Step Actions.

Related concepts
About Quick Search
About Saved Searches
Specifics Forms
OOTB Service Categories and Subcategories
Service Categorization
Service Workflow

CSM 10.5.0 ITSM Practices 88

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2Fshared%2Fservice_level_agreements_-slas-.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2Fshared%2Fservice_level_agreements_-slas-.html
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_quick_search
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_search_groups
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fspecifics_forms__02.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Footb_service_categories_and_subcategories.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fservice_categorization.html
https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Fshared%2Fservice_workflow.html


Target Times Form
Use the Target Times form to define and manage your SLA Target Times. The Target Time form is a child
form, and is linked to and available from its parent SLA form (SLA Target Times tab in the SLA form
arrangement).

The Target Times form has a wizard interface, which allows you to easily move through the process of
creating Target Times. However, you also have the option to disable the wizard and simply use the
Review page (which includes identical information) to create the Target Times.

The following image shows the Review page:

The following table describes the fields on the form.

Field Description Comments

Priority Priority name/value.  

Parent Type Record type, either Incident or Request. Determined by your toggle choice (SLA
form).

Work Hours Business Hours when the SLA should be
used.  

Use as
Default

The SLA is used as the default if the
working hours cannot be determined or
there is not a defined Target Time for the
time period that an Incident or Service
Request is created.

 

Response
Time

Target number of days, hours, or minutes
to respond to the Incident (example: 1
hour).

 

Resolution
Time

Target number of days, hours, or minutes
to resolve the Incident (example: 4 hours).  
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Field Description Comments

Work Hours
(Response
Time)

Specifies the defined Business Hours that
constrain the Target Time. If blank, it is
assumed that it is a 24 hour clock.

Select the Business Hours Manager

button  to launch the Business Hours
Manager to select existing Business
Hours or create new ones. Also select the
time zone for the Business Hours based
on time zones or the time zone of the
Cherwell Application Server.

When you create new Business Hours,
you must update the Created During What
Business Hours expression to reflect the
new hours.

CSM uses this expression to set the
Created During field on the Incident
Business Object, and then uses the
Created During field in the following
relationships:

• Incident Links CI Target Time

• Incident Links Customer Target Time

• Incident Links Service Target Time

The field determines whether or not to use
the Work Hours calendar in the SLA Target
Time or to use the configured Response
and Resolution calendars.

If Business Hours overlap, move the
preferred hours above the other hours in
the list.

Work Hours
(Resolution
Time)

Response
Warning Time

Number of days, hours, or minutes before
a response breach to initiate a warning.
Used to alert you to an impending breach.

 

Resolution
Warning Time

Number of days, hours, or minutes before
a resolution breach to initiate a warning.
Used to alert you to an impending breach.

 

Related concepts
Create a Service/SLA/Priority Structure
Define General Behaviors for Fields
Define Link Properties for a Relationship
Create Business Hours
Related tasks
Define a Case Expression
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Priority Matrix Element Form
Use the Priority Matrix Element form to define and manage the values that go in your Priority Matrix. The
Priority Matrix Element form is a Child form, and is linked to and available from its Parent SLA form
(Priority Matrix Elements tab in the SLA form's Arrangement area). See OOTB Priority Matrixes for
additional information.

The following table describes the fields on the form.

Field Description Comments

Priority Group

Specifies which Priority Group (Priority Matrix) the value is
in:

• Standard: Standard Priority Matrixes for Incident and
Request.

• E-mail/Calendaring: Priority Matrixes dedicated to the
E-mail/Calendaring Service.

• Custom.

 

Incident/Service
Request

Specifies whether the value is in the Incident or Request
Priority Matrix.  

Urgency Specifies which Priority Matrix row the Priority is in. The value is put into
the row and column
that intersect.Impact Specifies in which Priority Matrix column the Priority is in.

Priority Specifies the value of the priority.  

Matrix Order
Specifies the vertical and horizontal sort order for the grid
(low to high). We recommend that you build left to right,
then down.

 

Description Description of the priority.  
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Service One-Step Actions
CSM provides the following OOTB Service One-Step Actions.

One-Step Action Description/Actions Association Executed
From

Next Step from
Relationship

Conditionally changes the record status to next
logical status (defined by the status values in
Table Management).

Service
Service Form:
Status: <Next
Status>

Status Info Displays a description of the Service. Service  

Update Service
Status Prompts you to manually select any status. Service

Service Form:
Status:
<Current
Status>

Form Actions    

Ownership Assign ownership.   

Assign to ANY
Individual

Prompts the User to assign the record to any
CSM User (not limited by Team). Uses Owned
By ID and Owned By Team fields.

Service

Assign to Individual

Launches the Choose Team window, where a
user can choose an Owned By Team for the
record; then, launches the Choose User window,
where a user can choose a Primary User from
the already-selected Team.

Service

Assign to Team
Launches the Choose Team window, where a
user can choose an Owned By Team for the
record.

Service

Take Ownership Makes the Current User the Primary User of the
record. Service

Service Form:
Assign to Me
under Actions

Other    

Date/Time
Information

Displays details for all the date/timestamps to
give a historical view. Service

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.
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Service Saved Searches
CSM provides the following OOTB Service Saved Searches.

Saved Search Returns Association Executed From

Active Services Services in the Active Phase. Service Search Manager, Reports

All Services All Services, regardless of status. Service Search Manager
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Problem Management
Problem management is the process that ensures that the root cause of multiple Incidents is resolved as
quickly as possible.
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About Problems
A Problem is the cause of one or more related Incidents. Problems involve a more complicated issue than
Incidents, and require a deeper investigative process so that the Incidents do not reoccur. A Known Error
is the root cause of a Problem and has a workaround to keep employees operating while the Problem is
being resolved.

For example, technicians at a company log five separate Incidents related to e-mail issues. A technician
notices this trend and logs a Problem that links all of the Incidents together as one record. The Problem is
investigated and the Known Error (the root cause of a Problem) is determined to be a failed e-mail server
connection.
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Problem Good to Know
• Search for one or more Problems that meet a specific criteria by running a Quick Search or Saved

Search.

• Create a new Problem by clicking New > New Problem on the CSM Desktop Client toolbar, by
clicking File > New > New Problem from the CSM Desktop Client menu bar, or by pressing
CTRL+SHIFT+P.

• You can create a Problem from multiple Incidents, then attach additional Incidents when
appropriate.

• By default, Problem uses the Corporate Priority Matrix.

• The OOTB system implements several Actions/One-Step Actions to make logging Problems more
efficient. For more information about Actions and One-Step Actions, refer to the Actions/One-Step
Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (example:
Major).

• CSM provides several OOTB Automation Processes to automate Problem Management. For more
information, refer to the Automation Process documentation.

• If enabled (via Automation Process), e-mail notifications are:
◦ Automatically created and sent to User owners to notify them of ownership.

◦ Automatically created and sent to Team owners to notify them of ownership.

• When on a record, you can send an e-mail directly to the current Customer (Requestor) by clicking
FIle > E-mail Current Customer, or by clicking the Notify Impacted Customers of Update link in
the Actions section. If sent using the File menu, the e-mail is blank. If sent using the Notify Impacted
Customers of Update link, an e-mail template is used to auto-populate the e-mail with information
from the current Incident (example: Change ID, Customer's name, logging date/time details, etc.).

• Journals track what occurs during the record's lifecycle (example: Notes to track progress or
comments, and History to track important field changes, e-mail correspondence, etc.). View or add
Journals by clicking the Journal tab in the record's Arrangement.

• Attachments supplement records by providing additional details in the form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Default Form at the top of the Problem form shows important at-a-glance information:
◦ Problem number and priority, along with the priority. Red indicates a priority 1, orange

indicates a priority 2, and green indicates a priority 3-5.

◦ The current status of the Problem as it moves through its workflow. The next status is
displayed as a link directly beneath the current status. Click the status link to move the
Problem to the next status.
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Note: Typically, workflow statuses should be enforced; however, some records do
allow Users (with security rights) to bypass statuses (example: Problems can be
manually closed without being formally resolved, if needed). To bypass a status, click
Select Other Status in the Actions section.

◦ Resolve Within

◦ Solution Type

◦ Assigned To

• Press TAB to move to the next field on the form.

• Fields:
◦ The Description field is a Rich Text field. To format the text or embed an image, click the Zoom

button .

◦ Submit a Workaround to your Knowledge Base or submit a Known Error to the Portal using
their respective buttons in the Workaround and Known Error phase.

Note: A full list of Fields is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view
a full list of fields associated with a particular type of Business Object (example:
Major).

• Saving:

◦ Date, time, and user name information is recorded the first time the form is saved, and each◦
time the form is modified.

◦ Clicking Save  triggers an audit of certain Problem information, such as Status, Priority,
Owned By, Diagnosis, and Workaround. If a change is detected in one of those Fields, a
Journal-History record is created to track the change. View the changes in the Problem
Journals tab (Arrangement section).
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Problem Workflow
The following figure shows the high-level Problem process workflow in the OOTB system.

1

Creator enters a Title, Detailed Description, Categorization, and Priority.

When saved, the Problem is displayed on the Problem Management Dashboard to notify the
Problem Management team of its existence.

2
Owner uses the Publish Known Error to Customer Portal Action.

A One-Step Action posts the Diagnosis Field contents in the Known Errors section of the Portal.

3

Owner provides details of the Diagnosis and Workaround by submitting a Knowledge Article (KA),
publishing in Portal, and/or emailing Customers.

A One-Step Action creates a new KA using text from multiple Problem Fields. Text from the
Workaround field is posted in the Top Issues section of the Portal. A One-Step Action sends a
notification email to the Customers of linked Incidents.

4 A One-Step Action changes the status to Pending Change and creates a new Change Request
record.
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5 A One-Step Action makes the current User the owner, changes the Problem status to Resolved, and
notifies Customers of linked Incidents.

6 A One-Step Action changes the Problem status to Resolved and sends an email to Incident owners
(linked to the Problem) to notify them of the solution.

Note: CSM uses several features to manage the Problem workflow (example: the Problem Form
helps create and manage Problems, One-Step Actions help move the Problem through its
workflow, Automation Processes notify stakeholders via emails, a Problem Dashboard notifies
stakeholders and tracks metrics, etc.).

Contributors
A Problem typically involves the following contributors:

• Creator: User who first logs the Problem. This is typically a member of the Problem Management
Team.

• Owner: User who manages the Problem. This is typically an IT manager who is a member of the
Problem Management Team.

Phases:
The Problem workflow is divided into the following phases:

1. Classify: Creator logs a new Problem. Then, the creator identifies and classifies the Problem
(Description, Service, Category, and Priority). The creator updates Customers via Twitter and links
related Incidents to the record.

2. Investigate: Ownership is assigned. The owner begins work, investigates and analyzes the
Problem, and then records a diagnosis. The owner updates Customers by publishing the Problem to
the Portal, and then links Configuration Items (CIs).

3. Known Error: Owner develops and records the workaround. Then, the owner can update Users (by
submitting a Knowledge Article to Knowledge Base) and Customers (by publishing a known error to
Customer Portal, post to Twitter, or send email).

4. Resolve: Owner records resolution details and cause code. Then, the owner can escalate the
Problem and/or log a Change Request required to solve the Problem (if necessary). The owner then
resolves attached Incidents before resolving the Problem.

5. Closed: Owner closes the Problem.

Statuses
A Problem progressing through the workflow encounters the following statuses:

1. New: Problem is being logged, identified, and classified.

2. Assigned: Problem has been assigned to an owner.

3. Work in Progress: Problem is being diagnosed, investigated, and analyzed.
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4. Pending Change: Problem process is on hold until a Change Request is implemented.

5. Resolved: Problem is resolved.

6. Closed: Problem is closed.

Note: Problem statuses do not align with Problem phases.

Related concepts
Problem Form
Log a Problem - Detailed
Problem One-Step Actions
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Logging Problems
The following instructions are available to walk you through the steps to log a new Problem using our
OOTB workflow:

• Log a Problem: Typical step-by-step instructions for logging a Problem.

• Log a Problem - Detailed: Detailed step-by-step instructions for logging a Problem, including tips,
optional steps, and behind-the-scenes information.

Note: CSM provides an OOTB Problem workflow with all the features you need to
successfully manage Problems. You can use this workflow as-is, or tailor it to meet the
needs of your organization.
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Log a Problem
The following procedure walks you through the typical steps to log a Problem.

To log a Problem:

1. On the CSM Desktop Client toolbar, click New>New Problem.

A new Problem Record is created with a unique Problem ID (example: 10230) and a status of New.

2. Identify and classify the Problem:
a. Provide a Title for the Problem (example: Email is not sending).

b. Enter a Description (example: Email in the Marketing department is not sending).

c. Enter a Service Classification. Use the Selector button to find a Service Classification.

The Service and Category appear below the Service Classification field.

d. Select an affected CI, if any. Click the CI Selector button  to launch the CMDB window,
where you can select a CI. You can locate CIs by filtering (by Config Type, All Customers, a
specific Customer) or by searching. You can also create a new CI on the fly.

e. Select an Assigned Team, an Assigned To team member, or both.

f. Click the Priority selector button to reveal the Priority Matrix and then select an impact and
urgency to generate a priority number.

g. (Optional) Set a Resolve By date.

h. Select the Incidents tab to link Incidents to the Problem.

i. Click Begin Work in the header. The Problem now has a status of In Progress.

3. Analyze the Problem:
a. Enter Symptoms and Probable Causes.

b. Enter a Root Cause.

c. Select a Cause Category from the drop-down.c.

4. Resolve the Problem:

Determine if the resolution is a Workaround, Permanent Fix, or Known Error.

a. If it is a Workaround, write a detailed procedure so that Users and Customers understand
exactly what they are supposed to do.

Notes: The Workaround field is required to create a Knowledge Article. The new Knowledge
Article pulls information from the following fields: Short Description, Detailed Description,
Service Classification, Workaround, Diagnosis, and resolution.

b. If it is a Permanent Fix, enter details.

c. If it is a Known Error, enter details.
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d. Select Actions as applicable:
◦ Notify Impacted Customers of Update: Send an email message to reporters of linked

Incidents.

◦ Resolve Linked Incidents: Mark linked Incidents as Resolved.

◦ Publish Workaround to Customer Portal.

◦ Create Knowledge Article.

e. If you find that the Problem was not resolved, you can reopen the record by clicking the Select
Other Status link in the Actions section and selecting the status (example: Work in Progress)
you want in the drop-down.

Related concepts
About Problems
Problem Workflow
Problem Features
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Log a Problem - Detailed
The following procedure walks you through detailed step-by-step instructions for logging a Problem,
including tips and behind-the-scenes information. The different contributors are noted in the procedure.

To log a Problem:

1. On the CSM Desktop Client toolbar, click New>New Problem.

Tip: You can also click File>New>New Problem from the CSM Desktop Client menu bar, or press
CTRL+SHIFT+P.

Note: A Problem can be logged from an Incident (Task Pane>Incident Actions>Create
Problem link). When submitted from an Incident, the Priority, Short Description, Detailed
Description, and Service categorization are auto-populated and the Incident is linked to the
Problem in the Arrangement area. A Problem can also be logged from anywhere in the
system (Task Pane>Common Tasks>Create Problem), though fields do not auto-populate
and a record is not automatically linked using this option.

A new Problem Record is created with a unique Problem ID (example: 10230) and a status of New.

2. Identify and classify the Problem:
a. Provide a Title for the Problem (example: E-mail is not sending).

b. Enter a Description (example: E-mail in the Marketing department is not sending).

c. Enter a Service Classification. Use the Selector button to find a Service Classification.

The Service and Category appear below the Service Classification field.

d. Select an affected CI, if any. Click the CI Selector button  to launch the CMDB window,
where you can select a CI. You can locate CIs by filtering (by Config Type, All Customers, a
specific Customer) or by searching. You can also create a new CI on the fly.

e. Select an Assigned Team, an Assigned To team member, or both.

f. Click the Priority selector button to reveal the Priority Matrix and then select an impact and
urgency to generate a priority number.

g. (Optional) Set a Resolve By date.

h. Select the Incidents tab to link Incidents to the Problem.

i. Click Begin Work in the header. The Problem now has a status of In Progress.

3. Analyze the Problem:
a. Enter Symptoms and Probable Causes.

b. Enter a Root Cause.

c. Select Assigned Team to do a Root Cause Analysis if applicable.

d. Select a Cause Category from the drop-down. Options include:d.
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◦ Hardware Failure

◦ Human Failure

◦ Procedure Failure

◦ Software Failure

◦ Update Failure

4. Resolve the Problem:

Determine if the resolution is a Workaround, Permanent Fix, or Known Error.

a. If it is a Workaround:
i. In the Workaround field, write a detailed procedure so that Users and Customers

understand exactly what they are supposed to do.

Note: The Workaround field is required to create a Knowledge Article. The new
Knowledge Article pulls information from the following fields: Short Description, Detailed
Description, Service Classification, Workaround, Diagnosis, and Resolution.

ii. Select or add a Change Request.

iii. Set a Review by date.

iv. Select Resolve and Close linked incidents.

v. Select Notify Impacted Customers of Update.

vi. Select Create Knowledge Article.

vii. Select Publish Workaround to Customer Portal.
viii. Close the Problem.

b. If it is a Permanent Fix:
i. Select the Permanent Fix radio button.

ii. Enter Permanent Fix details.

iii. Select or add a Change Request.

iv. Select Resolve and Close linked Incidents.
v. Select Notify Impacted Customers of Update.

vi. Select Create Knowledge Article.

vii. Select Publish Fix to Customer Portal.
viii. Close the Problem.

c. If it is a Known Error:
i. Select the Known Error radio button.

ii. Enter Known Error details.

iii. Set a Review by date.

iv. Select Notify Impacted Customers of Update.

v. Select Create Knowledge Article.
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vi. Select Publish to Known Errors on Customer Portal.
vii. Close the Problem.

d. Select Actions as applicable:
◦ Notify Impacted Customers of Update: Send an e-mail message to reporters of linked

Incidents.

◦ Resolve Linked Incidents: Mark linked Incidents as Resolved.

◦ Publish Workaround to Customer Portal): Uses the Make Visible in Portal One-Step
Action to display the workaround.

◦ Create Knowledge Article: Creates a Knowledge Article in a new window, attaches the
Problem, and autofills the Knowledge Article Title, Solution or Workaround, Service,
Category, Article Type.

e. If you find that the Problem was not resolved, you can reopen the record by clicking the Select
Other Status link in the Actions section and selecting the status (example: Work in Progress)
you want in the drop-down.

Related concepts
Problem Workflow
Problem Form
Problem One-Step Actions
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Problem Design Ideas
CSM provides an OOTB Problem workflow with all the items you need to successfully log and resolve
Problems. You can use this workflow, or tailor it to meet the needs of your organization. Design ideas
include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the Desktop Client, Browser Client, and CSM Portal. View Counter functionality is configured in
CSM Administrator.

• Statuses: Change Problem statuses and/or the One-Step Actions that are initiated when a Problem
enters each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate your workflow
(example: Tweet the Resolution description when a Problem is closed).

• E-mail: Change the templates that are used to create the e-mails sent by One-Step Actions or
Automation Processes (example: "Notify Owned By via E-mail" One-Step Action). The e-mail
templates are defined as part of the One-Step Action. Or, disable/change when and to whom
notifications are sent.

• Automation Processes: Enable/disable the Automation Processes that monitor Incidents
(example: Monitors for record inactivity, sends automatic notification e-mails, etc.).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down Fields (example: Cause Codes).

• Additional Process Options: Consider enhancing your process by creating a Major Problem
workflow using new fields, One-Step Actions, and Automation Processes. The workflow might
include a Major Problem Review where the Problem Reviewer provides information related to what
went well, what did not go well, mitigation ideas, and lessons learned.

Note: Detailed step-by-step instructions for the above is beyond the scope of this content.
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Problem Features
CSM provides the following tools to help manage Problems:
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Problem Form
Use the Problem Form to log, edit, and track Problems. The form is made up of four main areas:

1. Default Form: Displays Problem number, status, and Created By information.

2. Form Arrangement: Dynamically displays linked records (Child Records) that are in a relationship
with the parent Problem Record.

3. Form Area: Displays the form fields for the tab selected in the Form Arrangement. The Overview
form contains the most of the information needed to perform the Problem workflow.

4. Actions List: Dynamically displays a list of actions that are available for the current Incident.
◦ Assign to Me: Make yourself (Current User) the User owner for the Problem.

◦ Select Other Status: Choose a different status from a dialog box.

◦ Notify Impacted Customers of Update: Send an e-mail message to the Customers associated
with Incidents linked to the Problem.

◦ View Impacted Configuration Items: Opens a window with a visualization of the affected
Configuration Item(s).

◦ Generate Root Cause Analysis Tasks: Tasks associated with root cause analysis appear in the
Tasks tab in the Form Arrangement.

◦ Resolve Linked Incidents: Change the status of linked Incidents to Resolved.

◦ Create Knowledge Article: Create a Knowledge Article using the text from the Workaround
field.

◦ Publish to Top Issues in Customer Portal: Publish the text from the Diagnosis and Workaround
fields to the Portal. Customers can access the update by clicking the Top Issues link in the
Portal.

◦ Publish Workaround to Customer Portal: Adds the Problem and workaround to the Active
Problems section in the Portal.

◦ Publish Known Error to Customer Portal: Adds the Known Error to the Portal.
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The following table describes the fields on the form.

Field Description Comments

Form Area -
Overview   

Step 1: Identify and
Classify Record the basic details.  

*Title A concise description of the Problem. *Required.

*Description A detailed description of the Problem. *Required. Full-Text field
(searchable).

Service Classification Service, category, and subcategory affected by
the Problem.

For more information, see
Service Categorization.

Primary Configuration
Item Main CI involved in the Problem.

Assigned Team/
Assigned To

Select a User owner for the Problem. The Team
owner is populated by the selected User owner's
default Team.

*Priority
Indicates the established timescales and effort to
resolve a Problem. Priority is derived from an
impact and urgency Priority Matrix.

*Required. For more
information, see Priority.

Resolve By Assign a required resolution date.

Step 2: Analyze the
Problem

Symptoms Problem symptoms.

Probable Causes Possible causes for the Problem.

Root Cause Enter a Root Cause, if known.

Cause Category

• Hardware Failure

• Human Failure

• Procedure Failure

• Software Failure

• Update Failure

Step 3: Resolve the
Problem Record the workaround and update Customers.  
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Field Description Comments

Workaround Provide an explanation of a workaround for the
Problem.

The Workaround field is
required to create a
Knowledge Article. The
new Knowledge Article
pulls information from the
following fields: Short
Description, Detailed
Description, Service
Classification,
Workaround, Diagnosis,
and Resolution.

Solution Determine if the solution is No Solution, Known
Error, or Permanent Fix.

Form Arrangement   

Overview Overview of the current problem.

Journals

Displays related Journal records that are created
to track User notes/comments, Customer
requests/comments, field and status changes,
Queue history, and e-mail correspondence.

 

Tasks Displays related Tasks.  

Configuration Items Displays CIs that are related to/support this
Problem (example: Primary CI).

For more information, refer
to About CMDB.

Incidents Displays related Incidents that linked to/affected
by the Problem.  

Change Request Displays Change Requests that involve this
Problem.

For more information, refer
to About Change
Requests.

Related concepts
Problem Workflow
Log a Problem - Detailed
Problem One-Step Actions
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Problem Journals
CSM provides the following OOTB Problem Journal types:

• Journal - Note: Tracks User notes/comments. For example, a User might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt,
follow-up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

Note: History Journals are automatically created by CSM. Notes are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Problem Dashboard
CSM provides an OOTB Problem Dashboard that intuitively organizes your critical Problem metrics into a
single control panel. The Dashboard displays the number of open Problems, number of open Top Issues
(in the Portal), number of linked Incidents, number of Problems with and without workarounds, number of
open known errors, number of Problems owned by Teams, percentage of Problems in each phase (New,
Investigate, etc.), percentage of Problems in each category (based on Service), list of all Top Issues, and
a list of all Problems.

Note: Problem metrics are also available on other Dashboards, including Executive, Global IT,
and Change.

OOTB Problem Dashboard Widgets

Item Description Widget
Type Widget Name Widget Uses:

Open
Problems

Number of open Problems
(Status does NOT = Resolved or
Closed).

Text
Gauge

Total Open
Problems

Open Problems
Saved Search

Open Top
Issues

Number of open Problems
(Status does NOT = Resolved or
Closed) Top Issues in Portal =
True.

Text
Gauge

Top Issues
Count

Problems Set as
Top Issues Saved
Search
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Item Description Widget
Type Widget Name Widget Uses:

Total Linked
Incidents

Number of open Incidents
(Status does NOT = Resolved or
Closed) linked to the Problem.

Text
Gauge

Incidents
Affected
Counter

Incidents Linked to
Problem Saved
Search

No Work
Around

Number of open Problems
(Status does NOT = Resolved or
Closed) with a cleared
Workaround Exists check box.

Text
Gauge

Problems with
No Work
Around

No Workaround
Saved Search

With a Work
Around

Number of open Problems
(Status does NOT = Resolved or
Closed) with a marked
Workaround Exists check box.

Text
Gauge

Problems with a
Workaround

Workaround Exists
Saved Search

Known Errors

Number of open Problems
(Status does NOT = Resolved or
Closed) with completed
Workaround and Resolution
fields.

Text
Gauge Known Error Open: Known Error

Saved Search

My Team's
Problems

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on Team
ownership.

Bar Chart Problems by
Teams

Open Problems
Saved Search with
values based on
Owned By Team
field.

Problem
Lifecycle

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on the Status
field.

Pipeline
Chart

Problem
Lifecycle

Pipeline slices
represent Problem
statuses.

Open Problem
Categories

Percentage of open Problems
(Status does NOT = Resolved or
Closed) based on the Category
field.

Pie Chart Open Problems
Chart slices
represent Problem
categories.

Top Issues
List of Problems that have been
identified as "Top Issues in
Portal".

Search
Results
List

Global Issues All Top Issues
Saved Search.

All Problems
List of all open Problems (Status
does NOT = Resolved or
Closed).

Search
Results
List

All Problems Open Problems
Saved Search.
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Problem One-Step Actions
CSM provides numerous OOTB Problem One-Step Actions. Notable Problem One-Step Actions include:

One-Step
Action Description/Actions Associations Executed From

Status    

Next Step from
Relationship

Conditionally change the Problem status to
next logical status (defined by the Problem
status values in Table Management) and/or
initiate the next appropriate One-Step Action:

• Begin Work: Start Work in Progress One-
Step Action.

• Set as Resolved: Set as Resolved One-
Step Action.

• Pending Change: Set to Pending Change
One-Step Action.

• Close: Set as Closed One-Step Action.

Problem Problem Form,
Next: <Status>

View More
Status Options Allows the User to set any status. Problem Problem Form,

Next: <Status>

Conditional
Status    

Start Work in
Progress

Changes the Problem status to Work in
Progress. If an owner is not assigned, assigns
the Problem to the current User and the Team
the User belongs to.

Problem
Problem Form,
Status: Begin
Work link

Set as Resolved Changes the Problem status to Resolved. Problem
Problem Form,
Status: Set as
Resolved link

Set to Pending
Change

Changes the Problem status to Pending
Change. Problem

Problem Form,
Actions: Set as
Pending Change
link

Set as Closed Changes the Problem status to Closed. Problem Problem Form,
Status: Close link

Assign to Team

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record.

Changes Problem status from New to
Assigned.

Problem
Problem Form,
Owned By: Select
Team link
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Assign to
Individual

Launches the Choose Team window, where a
User can choose an Owned By Team for the
record; then, launches the Choose User
window, where a User can choose a Primary
User from the already-selected Team.

Changes Problem status from New to
Assigned.

Problem
Problem Form,
Owned By: Select
Owner link

Form    

Take Ownership

Makes the Current User the Primary User of
the record.

Changes status from New to Assigned.

Problem
Problem Form,
Actions: Assign to
Me link

Publish/Remove
Known Error to/
from Portal

If the known error is not yet visible in the Top
Issues section of the Portal, uses the Publish
Known Error in Portal One-Step Action Action
to display the known error. If the known error is
visible in the Top Issues section of the Portal,
uses the Remove Known Error from Portal
One-Step Action Action to remove the known
error.

Problem

Problem Form,
Actions: Publish
Known Error to
Customer Portal
link

Resolve
Incidents

Makes the current User the owner, and then
changes the Problem status to Resolved.
When the status changes to Resolved, e-mails
Customers of attached Incidents to notify them
of the resolution.

Problem

Problem Form,
Actions: Resolve
Linked Incidents
link

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.

Related concepts
Problem Workflow
Problem Form
Log a Problem - Detailed
Action Block Email Templates
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Problem Saved Searches
CSM provides numerous OOTB Problem Saved Searches. Notable Problem Saved Searches include:

Saved Search Returns Association Executed From

All Problems All Problems, regardless of status. Problem
Search Manager,
Metrics, Reports,
Widgets

All Top Issues All Problems that are visible in the
Portal. Problem Search Manager,

Widgets

Known Error
Problems that are known errors
(completed Diagnosis and Workaround
fields).

Problem Search Manager,
Metrics

My Open Problems Open Problems that are owned by me
(Current User). Problem Search Manager,

Metrics, Widgets

My Team Open
Problems

Open Problems that are owned by a
Team to which I (Current User) belong. Problem Metrics, Widgets

Open Problems Open Problems. Problem Search Manager,
Metrics, Widgets

Open: Known Error
Open Problems that are known errors
(completed Diagnosis and Workaround
fields).

Problem Search Manager,
Metrics, Widgets

Open: Known Error in
Portal

Open Problems that are known errors
visible in the Portal. Problem Search Manager,

Metrics, Widgets

Problems Set as
Global Issues

Open Problems that are Global Issues
(completed Diagnosis and Workaround
fields).

Problem Search Manager,
Metrics

Workaround Exists Problems that have a defined
workaround. Problem Search Manager
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Problem Automation Processes
CSM provides the following OOTB Problem Automation Processes:

Name Description

Notify Problem
Owner of
Assignment

When the Owned By Field of a Problem changes, the process initiates the Notify
Owned By via E-mail One-Step Action, which sends a notification e-mail to the
new owner.

Notify Problem
Team of
Assignment

When the Owned By Team Field of a Problem changes, the process initiates the
Notify Owned By Team via E-mail One-Step Action, which sends a notification e-
mail to members of the Team that owns the changed Problem.

Inactivity Escalation
Waits two days after the Last Modified Date Time Field changes, then initiates the
Escalate if Inactive One-Step Action, which sends a notification e-mail to the
manager of the Problem owner.

Problem - Resolve
Incident

Waits for the status of a Problem to be set to Closed, then initiates the Resolve
Incidents One-Step Action, which sets the status of the Incidents to Resolved and
sends a notification e-mail to the Incident Customer(s).
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Problem Reports
CSM provides numerous OOTB Problem Reports. Notable Problem Reports include:

Report Description Association Saved Search

Problem Impact
Metrics

Lists all Problems (including details) and highlights
the number of Incidents linked to each Problem. Problem All Problems

Problem Metrics Bar charts show the number of Problems (including
details) by status, Service, impact, and category. Problem All Problems

Problem
Summary

Bar chart shows the number of open and resolved
Problems logged each quarter. Problem All Problems

Problem Trends Line charts show the number of Problems each
month by Service and impact. Problem All Problems

Problems by
Category

Bar chart shows the number of Problems by
category. Below the chart is a list of Problem details. Problem All Problems

Problems by
Impact

Bar chart shows the number of Problems by impact.
Below the chart is a list of Problem details. Problem All Problems.

Problems by
Service

Bar chart shows the number of Problems by
Service. Below the chart is a list of Problem details. Problem All Problems

Problems Linked
with Incidents

Lists Problems (including details) that have linked
Incidents. Problem All Problems

Top 10 Problems
Bar chart displays the top ten Problems based on
how many Incidents are associated with each
Problem ID.

Problem All Problems

Top 10 Problems
by Category

Bar charts display the top ten Problems (by
category) based on how many Incidents are
associated with each Problem ID.

Problem All Problems
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Service Asset and Configuration Management
(CMDB)

CSM provides a Configuration Management Database (CMDB) process to ensure that all Configuration
Items are effectively managed and stored in the Configuration Management Database (CMDB).

See Configuration Items.
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About the Configuration Management Database
(CMDB)

The Configuration Management Database (CMDB) is a repository of Configuration Items (CIs). The
CMDB is an interface that assists with the management of Configuration Item (CI) Records. Use the
CMDB to view, create, edit, and delete CI records. CI Records are stored alphabetically, and can be
viewed in a Grid View or Record View. A Configuration Item is a Group Object comprised of different CI
types. Use the CMDB to:

• Create CIs

• View CI details

• Edit CIs

For more information, refer to CMDB Features and Capabilities in the online help.
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About Configuration Items
Configuration Items (CIs) are assets that make up the Configuration Management Database (CMDB). CIs
must be managed to avoid disruptions to Services. Use CI forms to track and monitor the following items:

• New items

• Current items

• Retired items

There are several OOTB CI categories:

• Computer: Individual laptops, individual workstations, etc.

• Mobile Device: Company cell phones, tablets, etc.

• Network Device: Access points, firewalls, routers, switches, etc.

• Printer: Local printers, network printers.

• Server: Application server, file server, mail server, etc.

• Software License: Open source, proprietary, shareware, etc.

• System: Database system, network system (example: A CI System for the email system would
have a relationship with each of the mail servers).

• Telephony Equipment: Phone, ACD, etc.

• Other: CIs that do not correspond with other CI categories.

The OOTB CI Forms (example: Computer) help to create, manage, and track CIs:
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1. Default Form: Displays information based on the type of CI.

2. Form Arrangement: Dynamically displays linked child records based on the type of CI, such as
Journals, Incidents, and Problems.

3. Form Area: Displays detailed CI information based on the type of CI, such as location and network
information.

4. Actions List: Dynamically displays a list of actions that are available for the current record.
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CMDB Features and Capabilities
CSM CMDB has several features and capabilities:

• Searching: Quickly locate all CIs by running a Quick Search, or search for a particular CI or set of
CIs by refining the search criteria to a word/phrase, timeframe, Customer, etc. Use Saved Search to
save/run commonly-run Searches.

• Saved Searches: Use CI Saved Searches to quickly locate/filter CIs, or to automate searching in
Reports or on Dashboards.

• Security: Secure CIs by controlling who can view, create, edit, and delete records.

• Business Object: Use the dedicated Configuration Item Business Object to track CIs, and then
configure the Business Object to capture/track only what you want.

• Forms: Use the powerful Configuration Item Forms to create, edit, and track CIs. The form provides
a Default Form area to display important information (CI type, current status, next status, Primary
User, asset owner, common operations, and a Form Arrangement area to dynamically display linked
records (child records) that are in a relationship with the CI (parent record).

• Workflow: Use the streamlined CMDB workflow to move CIs from an initial status to a final status.

• Creation Flexibility: Create CIs manually or through an automated process.

• Ownership: Assign each CI to a Primary User to ensure accountability and track assets. The
Primary User is also thought of as an external Customer, technician, or internal User of an asset. In
CMDB, the Customer is referred to as the Primary User.

• Linked Records: Link child records to a parent CI Record to ensure data relationships. Linked child
records are visible in the CI Arrangement. For example, you might associate a CI with CI Events,
Installed Software, Installed Services, or Drives.

• History and Revision tracking: Use linked Journals to track important status and field changes.

• E-mail correspondence tracking: Use linked Journals to track email correspondence.

• Rich Text: Use Rich Text to complement your Descriptions by adding formatting and images/
screenshots.

• Actions/One-Step Actions: Use powerful Actions and One-Step Actions to move CIs through their
workflow, initiate common operations (ex: Assign ownership), email asset owners, etc. Actions/One-
Step Actions are available on the CI Form (ex: CSM Desktop Client Task Pane).

• CMDB Dashboard: Use the CMDB Dashboard to view your critical CI metrics in a single, real-time,
at-a-glance control panel. The Dashboard displays the number of CIs being repaired, the number of
CIs that are down, the number of new CIs, total CMDB assets based on type, the number of CI
events based on type, and the number of CIs based on vendor.

• Reports: Run Reports to show up-to-date statistics on the number of assets based on type (ex:
Hardware, Software, etc.).

• Automation Processes: Use Automation Processes to automatically send notification emails and
run tiered alerts.

• Status: Use to retire and move a CI out of an active CMDB by changing the status to inactive,
retired, or disposed.  Status allows the system administrator to view the lifecycle of a CI and
maintain a logical history of incidents, revisions, and upgrades. The system administrator can
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update the status of a CI from active to inactive and apply a no orphan to particular associated
records while removing the CI from the current selection processes..
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Enable or Disable the CMDB for CSM Client Users
Disable the CMDB in CSM if you are not using it.

To make the CMDB unavailable for CSM Client users, switch off one or both of these security rights:

Configuration Management Database security right:

1. Open CSM Administrator.
2. Select the Security category, and then select the Edit Security Groups task.
3. In the Group drop-down list, select Admin.
4. Select the Rights tab.
5. In the Category drop-down list, select Configuration Management.
6. Select the right for Configuration Management Database and clear the Allow check box.

This disables access to the CMDB database for the Admin group.
7. Select Save.

View Business Object security right:

8. Open CSM Administrator.
9. Select the Security category, and then select the Edit Security Groups task.

10. Select the Business Objects tab.
11. In the Business Objects drop-down list, select Configuration Item.
12. Clear the View check box in the General section.

This removes the user's ability to view the Business Object record.
13. Select Save.

To check your changes:

14. Log in to a CSM Client as a user with administrator rights.
15. Select Tools from the menu bar.

The CMDB option is still visible but unavailable.
16. Create a new Incident record in the Desktop Client.

17. For the Primary CI field, select the Find Related item button  on the Related Item Picker.
You see an error message stating You are not authorized to view the CMDB.

Note: These steps also prevent users from executing One-Step™ Actions that allow access to the
CMDB.

Related concepts
Managing Security Groups
Define Business Object Rights (Access to Data)
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Configuration Item Workflow
Configuration Item (CI) assets use two distinct workflows based on their classification of either hardware
or software.

The following figure shows the high-level Hardware CI (Computers, Mobile Devices, Printers, Network
Devices, Servers, Systems, Telephony Equipment, and Other CIs) process workflow in the OOTB system.

Note: Access additional statuses (Stolen/MIA, In Repair, In Testing, etc.) at any time with the View
More Status options link in the Actions list .

A CI progressing through the Hardware CI workflow encounters the following main statuses:

1. New: CI is being logged, and the initial details are being recorded.

2. Ordered: CI is being ordered.

3. In Stock: CI has been received.

4. Planned: CI use and location are being determined.

5. In Testing: CI is being tested.

6. Active: CI is operational.

7. In Repair: CI is being repaired.

8. Down: CI is being taken out of service temporarily.

9. Stolen/MIA: CI has been stolen or lost.

10. Retired: CI is being taken out of service.

The following figure shows the high-level Software CI (Software License) process workflow in the OOTB
system.
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A CI progressing through the Software CI workflow encounters the following main statuses:

1. Requested: Software License has been requested.

2. Planned: Software License use and location are being determined.

3. Ordered: Software License is being ordered.

4. Active: Software License is operational.

5. Expire: Software License is expired.
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CMDB Interface
The Configuration Management Database (CMDB) interface is a tool that allows you to quickly manage
Configuration Item (CI) records. Use the CMDB interface to take the following actions:

• View CI records: View a Grid list of CI records or a specific record in detail.

• Find a specific CI record using filtering and searching options.

• Create, edit, or delete a CI record.

The CMDB interface can be opened several ways from the CSM Desktop Client or Browser Client.

To open the CMDB interface:

• From the CSM Desktop Client menu bar or CSM Browser Client menu bar, click Tools>CMDB.

• From the Common Tasks section of the CSM Desktop Client Task Pane, click CMDB.

The following image shows the CMDB interface.

The

1. Filters: View all CI records, or filter by CI Type (example: Computer, Printer, and so on.), Customer
(example: All or named Customer), and/or timeframe (example: Anytime, Today, Previous Month,
and so on).
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2. Search: Search for a specific CI record (example: Search any searchable field, such as Asset Tag,
Host name, and so on).

3. Record View: Displays Grid list of CI records or a specific CI record.

Good to know:

• From the Grid, you can print, export, run an Action, sort, filter, group, size, move/reorder, and add/
remove columns. Double-click a record to display it.

• See CMDB Interface Behaviors for tips on working with CI records in the CMDB interface.
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Open the CMDB Interface
1. Open the CSM Desktop Client or CSM Browser Client.
2. Select Tools > CMDB, or use one of the following options:

◦ From the Common Tasks section of the CSM Desktop Client Task Pane, click CMDB.

◦ From a Business Object record, click the CI Selector button .

◦ From the Configuration Items tab in a Form Arrangement, click the Link button .
The CMDB interface opens.
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CMDB Interface Behaviors
Menu Bars and Toolbars

Use the CSM Desktop Client menu bar/toolbar and Browser Client menu bar/toolbar to access table
management operations, such as:

• Navigating records.

• Switching between grid view and current record view.

• Adding, editing, and deleting CI records.

Context Menu (Desktop Client only)

Use the CMDB interface context (right-click) menu to quickly access common CMDB operations.

Menu Item Description

Go to record Displays the selected CI record. This option isn't available if you select multiple
records.

Go to record in new
window

Displays the selected CI record in a new window. This option isn't available if
you select multiple records.

New Creates a new CI record.

Actions If Context Menu Actions are defined, an Actions menu item is also displayed to
run Actions.

Delete Deletes the selected CI record.

Print grid Prints the active grid.

Export grid Exports the active grid to a file.

Record Views

There are two views available for the CMDB interface:

• Grid list: Select Show Results   on the toolbar to display a grid list of CI records.

• Current record: Select Show Current Record   on the toolbar to display the selected CI
record.

Grid Capabilities

When CI records are displayed in grid view, use the CSM grid capabilities (example: Print, export, run an
Action, sort, filter, group, size, move/reorder, and add/remove columns) to display only the data you want
and in a way that is meaningful to you.

Find Records
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Use the filter and search options to find CI records. Display all CI records, or filter by CI Type (example:
Computer, printer), customer (example: All or named customer), and/or time frame (example: Anytime,
today, previous month).

To search, type a value to search in the Search box (example: Asset tab, host name), and then select Go.
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Creating Configuration Item (CI) Records
The following instructions walk through the steps to create a Printer CI Record using our OOTB workflow:

• Create a Configuration Item (CI) Record: Typical step-by-step instructions for creating a Printer CI
Record.

Note: CSM provides OOTB CMDB workflows with all the features needed to successfully
manage CIs. Use these workflows as-is, or tailor them to meet organizational needs.
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Create a Configuration Item (Printer)
Hardware forms and Software forms vary based on the specific Configuration Item (CI). The following
image shows a Printer Configuration Item form.

To create a CI:

1. On the CSM Desktop Client toolbar, click New > New Configuration Item, and then select a CI (ex:
New Config - Printer).
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Tip: Another way to create a CI is to click File > New > New Configuration Item > New
Config - Printer from the CSM Desktop Client menu bar.

A CI Record is created with a unique Asset Tag ID (ex: 4476) and a status of New.

Note: An Asset Tag can be auto-generated or provided by an administrator to customize it
for business needs.

2. Enter a name for the CI in the Friendly Name field.

3. Select a Primary User:
a. Primary User: Provide the name (ex: Gina) of the person who initiated the Change (not the

creator of the record), and then press Enter or Tab to search for the Customer Record.

If an exact match is found, the Primary User Fields are auto-populated with the Customer’s
name and e-mail. If multiple matches are found (ex: Multiple Customers named Gina), the
Contact Manager opens to select the appropriate Customer.

Note: The Primary User is also thought of as a Customer, technician, or internal User
of an asset. In CMDB, the Customer is referred to as the Primary User.

4. Select an Assigned Team and Assigned Owner for the CI from the drop-down menus.

Note: Select Assign to Me in the Actions List to make yourself the CI owner.

5. The CI owner records the initial CI details.

Tip: Fields with drop-down arrows are populated based on Lookup Table values in Table
Management. Add, edit, or delete Field values by selecting the Field, and then pressing F3.

6. The asset owner orders the CI:
a. In the Default Form beneath Status, click Next: Order.

The CI status changes to Ordered.

7. When the CI is received, the asset owner identifies the CI as in stock:
a. In the Default Form beneath Status, click Next: Mark as In Stock.

The CI status changes to In Stock.

Note: If the CI needs to be tested before becoming operational, click View More
Status Options in the Actions List. The CI Status Selector opens. Click In Testing,
and then click OK. The status changes to In Testing.
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Note: If the CI is stolen or lost, click the View More Status Options link in the Actions
List to access the CI Status Selector, and then select the Stolen/MIA status.

8. Owner plans the use and location of the CI:
a. In the Default Form beneath Status, click Planned.

The CI status changes to Planned.

Note: If the CI needs to be tested before becoming operational, click View more
status options in the Actions List. The CI Status Selector opens. Click In Testing, and
then click OK. The status changes to In Testing.

9. When ready, owner activates the CI:
a. In the Default Form beneath Status, click Next: Activate.

The CI status changes to Active.

Note: If the CI needs to be repaired while active, click the Mark as "In Repair" link in
the Actions list. The status changes to In Repair.

10. (Optional) Owner deactivates the CI:

Note: A CI is typically deactivated when it must be taken out of service temporarily (ex:
Primary User leaves the organization).

a. In the Default Form beneath Status, click Bring Down.

The status changes to Down.

Tip: CSM provides multiple OOTB Automation Processes that use Tiered Alerts to help
manage CIs when they are out of service (status is Down). Use these Automation Processes,
edit them, or create them to fit the organizational needs.

11. (Optional) Asset Owner retires the CI:

Note: A CI is typically retired when it must be taken out of service permanently (ex: Printer is
replaced).

a. In the Actions List, click the View More Status Options link.

The CI Status Selector opens.

b. Click the Retired status.

c. Select OK.c.
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The CI status changes to Retired.
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CMDB Design Ideas
CSM provides OOTB CI workflows with all the items you need to successfully create CIs. Use these
workflows, or tailor them to meet organizational needs. Design ideas include:

• Fields: Change which fields are required and when, which fields support Rich Text, and more.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the Desktop Client, Browser Client, and CSM Portal. View counter functionality is configured in CSM
Administrator.

• Statuses: Change CI statuses and/or the One-Step Actions that are initiated when a CI enters each
status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
threshold and/or colors for Open Incidents logged against a CI.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate the workflow.

• Email: Change the email templates that are used to create the emails sent by One-Step Actions or
Automation Processes. Or, disable/change when and to whom notifications are sent (example: Send
a notification to computer owners when their CI Record changes).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
downs (example: Computer Manufacturer).

• Visualizations: Add, remove, or edit Upstream or Downstream Relationship options.

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
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CMDB Features
CSM provides the following tools to help manage the CMDB:
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CMDB Forms
Use the Configuration Item Forms (example: Computer) to create, edit, and track Configuration Items
(CIs). The forms are made up of four main areas:

1. Default Form: Displays information based on the type of CI.

2. Form Arrangement: Dynamically displays linked child records based on the type of CI, such as
Journals, Incidents, and Problems.

3. Form Area: Displays detailed CI information based on the type of CI, such as location and network
information.

4. Actions List: Dynamically displays a list of actions that are available for the current record.
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The following table describes common fields on the CI Form:

Field Description Comments

Default Form Displays information about the item based on
status and ownership.  

Primary User User assigned to the CI.

The asset is owned by a group or
manager within an organization
(ex. IT). The Owned By Team
assigns the asset to a Primary
User to use. The Primary User
does not own the asset.

Primary User
Name

Name of the Primary User who uses the CI. The
User assigned the asset by the organizational
owner (see Owned by).

Provide a name in the Primary User field (ex:
Gina), and then press Enter or Tab to locate the
Customer Record.

Note: Wildcards like % or * can be used with
partial information. If an exact match is found,
the information autopopulates the Requestor,
Phone, and E-mail fields. If multiple matches
are found (ex: Multiple Customers named Gina),
the Contact Manager opens so that the
technician can select the appropriate one.

Form Area Displays detailed CI information.

Fields in this area vary based on
the type of CI. These fields are
completely customizable and
configurable.

Details General CI details. Complete the necessary
information. Only Friendly Name is required.

For example, the Computer CI
uses Asset Tag, Manufacturer,
Serial Number, Operating System
information, etc.

Friendly Name Name for the CI.
This name is displayed in the
Default Form with the Asset Tag
and the Record Type.

Asset Tag Identification number for the CI.

Properties/
Network

Component details specific to the CI type.
Complete the necessary information. No fields
are required.

For example, the Computer CI
uses CPU information, Memory,
Vendor, Barcode, etc.

Financial Purchase details. Complete the necessary
information. No fields are required.

For example, the Computer CI
uses Vendor, Invoice ID, Purchase
Date, Purchase Type, and
Purchase Price.
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Field Description Comments

Actions List Common operations (initiate Actions/One-Step
Actions).  

Assign to me Click the link to make yourself (Current User)
the Owned By User of the asset.

One-Step Action (Take
Ownership):

Makes the Current User the
Primary User of the record.

Create a new Opens a prompt dialog box to log a Change
Request, Incident, or Problem.

View the CI/
Network Map

Opens the Configuration Item dialog box that
includes a visualization of the CIs.

Activate Sets the CI as active.
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CMDB Tiered Alerts
Tiered Alerts are tools used to manage CI behaviors when a defined event occurs (example: When a CI
status changes to Down, an alert might send a notification e-mail to the Record Owner). Alerts are tiered
because they can be configured to initiate a sequential set of Commands/Actions/One-Step Actions at
timed intervals. The alerts continue to increment (based on defined intervals) until the defined event is no
longer valid.

Good to know:

• Tiered Alerts are available for the following CI Records: Network Device, Printer, System, Telephony
Equipment, and Other CIs.

• Tiered Alerts require an Automations Process to define the event (example: CI status changes to
Down) that initiates the alert. CSM provides multiple OOTB Automation Processes that use Tiered
Alerts. For more information, see CMDB Automation Processes.

• Add up to 99 Tiered Alerts.

• View defined Tiered Alerts in Grid form by clicking View>Grid View in the Tiered Alerts tab of the
Arrangement.

To define Tiered Alerts:

1. Open a CI record (New>New Configuration Item>New Config - [CI type]).

2. Click the Tiered Alert tab in the Arrangement.

3. Click the New Tiered Alert button.

The Tiered Alert form opens.

4. Define the first tier:
a. Alert Order: Click the Up arrow to select the tier level (example: 1).
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b. Alert Action: Select a Command, Action, or One-Step Action to take place when the Tiered
Alert is initiated (example: Send E-Mail):

i. Click the Action Selector button to access the Action Manager.

The Action Manager Opens.

ii. Click the Command, Action, or One-Step Action to execute (example: Send E-Mail
Command).

iii. Select OK.iii.
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The Command, Action, or One-Step Action opens in the Alert Action field.

Note: The Wait time from previous alert field is disabled since this is the first
defined alert.

5. Define the second tier:
a. Alert Order: Click the Up arrow to select the tier level (example: 2).

b. Alert Action: Select a Command, Action, or One-Step Action to take place when the Tiered
Alert is initiated.

i. Click the Action Selector button to access the Action Manager.

The Action Manager Opens.

ii. Click the Command, Action, or One-Step Action to execute (example: New Incident
One-Step Action).

iii. Select OK.iii.

The Command, Action, or One-Step Action opens in the Alert Action field.
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c. Define the Wait Time from Previous Alert:
i. In the first field, provide a number to indicate the number of minutes, hours, or days that

CSM should wait (after the first Tiered Alert) before initiating the second alert (example:
2).

ii. In the second field, click the drop-down menu to reveal timeframe options, and then
select a timeframe (Minutes, Hours, Days).

The Tiered Alert record is automatically saved.
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CMDB Dashboard
CSM provides a OOTB CMDB Dashboard that intuitively organizes your critical CI metrics into a single,
real-time, at-a-glance CMDB control panel.

Note: CMDB metrics are also found on other OOTB Dashboards (ex: Global IT).

The following table describes the items on the Dashboard:

Item Description Widget
Type Widget Name Widget Uses:

CIs In
Repair

Displays the number
of CIs with an Asset
Status of In Repair.

Text
Gauge CI in Repair Custom Saved Search

CIs
Down

Displays the number
of CIs with an Asset
Status of Down.

Text
Gauge Current Down CIs CIs Currently Down

Saved Search

New CIs
Displays the number
of CIs with an Asset
Status of New.

Text
Gauge New CIs Custom Saved Search

Events
by CI

Displays the number
of CI Events by week
(bars within the chart)
and New CIs (line
within the chart).

Bar with
Line
Chart

CI Events vs. New CIs All Events Saved Search,
All Assets Saved Search

CSM 10.5.0 ITSM Practices 151

CSM 10.5.0 ITSM Practices



Item Description Widget
Type Widget Name Widget Uses:

CI by
Vendor

Displays the
percentage of CIs
based on Vendor.

Pie Chart CI by Vendor
Hardware with
Manufacture Saved
Search

Total
CMDB
Assets

Displays the number
of assets based on
type.

Text
Gauge

Uses the following Widgets:

• CMDB Computers in
last 30 days

• CMDB Network
Devices in last 30
days

• CMDB Printers in last
30 days

• CMDB Telephony in
last 30 days

• Copy of Mobile in
CMDB

• Copy of Servers in
CMDB

• Other CIs in CMDB

• Software in CMDB

• System in CMDB

Uses the following Saved
Searches:

• All Computers

• All Network Devices

• All Printers

• All Telephony
Equipment

• All Mobile
Equipment

• All Server
Equipment

• All Other CIs

• All Software

• All System CIs

View
Filters Dashboard
metrics by a defined
date range.

Filter CD - Date Filter - 30 Day
Default  
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CMDB One-Step Actions
CSM provides multiple One-Step Actions associated with CIs, including:

One-Step Action Description/Actions Associations Executed From

Status    

Alt Step from
Relationship

Conditionally change the CI status to next
logical status (defined by the CI Status values
in Table Management) and/or initiate the next
appropriate One-Step Action.

[CI] CI Form: Next:
[Status]

Alt 2 Step from
Relationship

Next Step from
Relationship

Form    

Ownership    

Assign to ANY
Individual

Prompts the User to assign the record to any
CSM User (not limited by Team). Uses Owned
By ID and Owned By Team fields.

[CI] CI Form: Assign To
link

Assign to
Individual

Launches the Choose Team window, where a
user can choose an Owned By Team for the
record; then, launches the Choose User
window, where a user can choose a Primary
User from the already-selected Team.

[CI] CI Form: Select
Owner link

Assign to Team
Launches the Choose Team window, where a
user can choose an Owned By Team for the
record.

[CI] CI Form: Select
Team link

Take Ownership Makes the Current User the Primary User of
the record. [CI] CI Form: Take

Ownership link

Other    

DateTime Info
Popup

Displays details for all the date/timestamps to
give a historical view. [CI]

CI Form: View
Detailed Date/Time
Information link

Create a new...

Prompts the User to create a new Incident,
Problem, or Change.

Note: This One-Step Action is only applicable
for hardware CIs.

[CI] CI Form: Create a
new... link
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A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.

CSM 10.5.0 ITSM Practices 154

CSM 10.5.0 ITSM Practices



CMDB Saved Searches
CSM provides the following OOTB CI Saved Searches:

Saved Search Returns Association Executed From

All Assets All CIs, regardless of type. Configuration Item Search Manager,
Reports, Widgets

Assets with Linked
Incidents

CIs with at least one related
Incident. Configuration Item Search Manager,

Reports

CIs Currently Down CIs with an Asset Status of Down. Configuration Item Search Manager,
Widgets

Computers and
Systems Computer and System CIs. Configuration Item Search Manager,

Reports

Critical CIs CIs marked as Critical. Configuration Item Search Manager

Hardware Hardware CIs. Configuration Item Search Manager,
Reports

Items with BIOS CIs that have a BIOS Version
number. Configuration Item Search Manager,

Reports

Software Software License CIs. Configuration Item Search Manager,
Reports

Software Compliance
CIs where the number of Users is
less than the number of Software
Licenses in use .

Configuration Item Search Manager
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CMDB Automation Processes
CSM provides the following OOTB CMDB Automation Processes:

Name Description

Notify Owner of
Computer Change

When any Field of a Config - Computer Record changes, the process initiates
the Send Computer Change Notification E-mail One-Step Action, which sends a
notification e-mail to the owner of the Config - Computer Record.

Tiered Alert -
Computer Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Computer Business Object).

Notify Owner of
Network Device
Change

When any Field of a Config - Network Device Record changes, the process
initiates the Send Device Change E-mail One-Step Action, which sends a
notification e-mail to the owner of the Config - Network Device Record.

Tiered Alert -
Network Device
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Computer Business Object).

Tiered Alert - Printer
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Printer Business Object).

Tiered Alert - Server
Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Server Business Object).

Tiered Alert -
System Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - System Business Object).

Tiered Alert -
Telephony
Equipment Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Telephony Equipment Business Object).

Tiered Alert - Other
CI Down

Waits for the CI status to change to Down, and then increments the Alert Level
(or aborts the process) based on the configuration in CSM (Arrangement section
of the Config - Other CI Business Object).
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CMDB Reports
CSM provides the following OOTB CMDB Reports:

Report Description Association Saved Search

OS Report Lists Hardware assets and details. Configuration Item Hardware

BIOSVersions Lists CIs that have a BIOS Version
number. Configuration Item Items with BIOS

Computer Memory
Audit

Lists Physical Memory and Virtual
Memory of Computer and System
assets.

Configuration Item Computers and
Systems

CI Change Request
Metrics

Bar Chart of Top 5 CIs with large
numbers of associated Change
Requests.

Configuration Item All Assets

CI Summary Report Lists all Hardware CIs by Vendor. Configuration Item Hardware

CPU Speed Report Lists CPU Speed and number of CPUs
of Computer and System assets. Configuration Item Computers and

Systems

Software Summary

Lists software summary information,
including Asset Tag, Version, Number
Assigned to Users, and Number of
Licenses.

Configuration Item Software

Incidents by
Configuration Item

Lists CIs with linked Incidents and
includes information such as Asset Tag,
Manufacturer, and Model.

Configuration Item Assets with
Linked Incidents

Related tasks
Report on Groups with Relationships with Themselves
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CMDB Installed Software
Use CMDB Installed Software to view Installed Software on the selected Computer or Server.

To locate CMDB Installed Software:

1. In CSM Desktop Client or CSM Browser Client, select Tools > CMDB.

2. In the Configuration Items to show drop-down list, select Config-Computer or Config-Server.
3. Double-click any Computer or Server in the list.

4. Select the Installed Software page.

5. To view the Installed Software form:
◦ Double-click the Installed Software in the grid.

OR

◦ Select the Installed Software in the grid and select View > Form View.

Installed Software Grid
Use the CMDB Installed Software grid to view Installed Software on the selected Computer or Server.

The following table describes the columns in the grid.

Column Description Comments

Product The software product name as defined on the Installed Software
Form.

For more
information, see
About CMDB.

Vendor The Vendor for the software product as defined on the Installed
Software Form.

Version The Version of the software product as defined on the Installed
Software Form.

Install Date The Install Date of the software product as defined on the Installed
Software Form.
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Installed Software Form
Use the CMDB Installed Software form to view or modify the Installed Software on the selected Computer
or Server.

The following table describes the fields on the form.

Field Description Comments

Default Form Lists the Product, Vendor, Version, and Install Date of the installed
software.

For more
information, see
About CMDB.

Product Type the Product Name for the installed software.

Present Select this box if the installed software is present.

Vendor Type the name of the Vendor for the installed software.

Version Type the Version of the installed software.

Install Date Select the Date the software was installed.
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CMDB Installed Services
Use CMDB Installed Services to view Installed Services on the selected Server.

To locate CMDB Installed Services:

1. In CSM Desktop Client or CSM Browser Client, select Tools > CMDB.

2. In the Configuration Items to show drop-down list, select Config-Server.
3. Double-click any Server in the list.

4. Select the Installed Services page.

5. To view the Installed Service form:
◦ Double-click an Installed Service in the grid.

OR

◦ Select an Installed Service in the grid and select View > Form View.

Installed Services Grid
Use the CMDB Installed Services grid to view Installed Services on the selected Server.

The following table describes the columns in the grid.

Column Description Comments

Display Name The Display Name as defined on the Installed Service
Form.

For more information, see
About CMDB.

Service Status The Service Status as defined on the Installed Service
Form.
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Installed Service Form
Use the CMDB Installed Service form to view or modify an Installed Service for the selected Server.

The following table describes the fields on the form.

Field Description Comments

Default Form Define the Display Name and Service Status for the installed
service.

For more
information, see
About CMDB.

Display Name Type the Display Name for the installed service.

Present Select this box if the installed service is present.

Name Type the Name for the installed service.

Service Status Type the Service Status for the installed service.
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Agreement Management
Agreement management is the process that allows users to mange individual Operational Level
Agreements (OLAs) and Underpinning Contracts (UCs).
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About Agreements
An Agreement is a record that defines the terms of service between the service desk and a Supplier. An
Operational Level Agreement (OLA) is a service agreement between the service desk and another entity
(ex: Team, department, etc.) within the same organization. An Underpinning Contract (UC) is a service
agreement between an organization and a third-party service provider. Agreements are directly related to
Suppliers and include Terms, including rules for changes to the Agreement, rules for termination of the
Agreement, and service availability.

In CSM, Agreement is a Group Object that includes two Major Objects: OLA and Underpinning Contract.
The OLA form and Underpinning Contract form share fields and functionality and are used to view and
manage each type of Agreement separately:

Note: Agreement can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Agreements Good to Know
Good to know:

• Search for one or more Agreements that meet a specific criteria by running a Quick Search or•
Saved Search.

• Create a new Operational Level Agreement by clicking New>New Agreement>New OLA on the
CSM Desktop Client toolbar, or by clicking File>New>New Agreement>New OLA from the CSM
Desktop Client or Browser Client menu bar.

• Create a new Underpinning Contract by clicking New>New Agreement>New Underpinning
Contract on the CSM Desktop Client toolbar, or by clicking File>New>New Agreement>New
Underpinning Contract from the CSM Desktop Client or Browser Client menu bar.

Note: Operational Level Agreements are Agreements with an internal Supplier. Underpinning
Contracts are Agreements with an external Supplier. The steps in this document can be used to
create either an OLA or a UC.

• When on a record, you can send an e-mail directly to the current Supplier by clicking the Supplier's•
e-mail address in the Default Form.

• The Supplier tab contains the Supplier's full record as it is seen in the Supplier Selector.•

• Journals track what occurs during the record's lifecycle (example: Notes to track progress or•
comments). View or add Journals by clicking the Journals tab in the record's Arrangement. The
Journals associated with Agreements track Owner notes/comments.

• Attachments supplement records by providing additional details in the form of linked/imported files•
(.pdf, .doc, etc.), images, web pages, and Document Repositories. View and manage Attachments

using the Attachment button  and Attachments bar.

• The Status in the Default Form indicates the current phase of the Agreement as it moves through its•
workflow.

• Press TAB to move to the next field on the form.•

• Fields:•

◦ The Description field is a Rich Text field. To format the text or embed an image, click the Zoom◦
button .

• The OOTB system implements several Actions/One-Step™ Actions to make creating Operational
Level Agreements and Underpinning Contracts more efficient. For more information about Actions
and One-Step™ Actions, refer to the Actions/One-Step™ Actions documentation.

Note: A full list of One-Step™ Actions and Fields is beyond the scope of this document.
Export a schema document from CSM Administrator (Create a Blueprint>Tools>Export
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Schema) to view a full list of One-Step Actions or Fields associated with a particular type of
Business Object (example: Major).
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Create an Agreement
The following procedure provides steps for creating an Agreement.

To create a new OLA or Underpinning Contract:

1. On the CSM Desktop Client toolbar, click New>New Agreement>New OLA (or Underpinning
Contract).

A new Agreement is created with a status of New.

2. You can take ownership of the Agreement by clicking the Assign to Me link under Actions

3. Provide details about the Agreement:
a. Name: Provide a name for the Agreement.

b. Supplier: Provide the name (example: Hardware Support) of the Team that will be responsible
for fulfilling the Agreement.

Note: To browse for a Supplier or add a new Supplier Record, click the Related Item

Picker button . The Supplier tab in the Form Arrangement contains an overview of
the Supplier record. To view the selected Supplier's detailed Supplier Record, click the

Quick View button . Detailed Supplier information is populated in the Supplier tab
in the Form Arrangement.

c. Supplier Catalog Item Type: Select a Supplier Catalog Item Type from the drop-down
(example: Product or Service).

d. Supplier Catalog Item: Select the Supplier Catalog Item from the Selector tool (example:
Laptop, SQL Server).

Note: New Supplier Catalog Items can be created from the Supplier Catalog Item
Selector or by using the Supplier Catalog Item Form (Supplier Catalog Items are
limited by the Supplier Catalog Type). For more information about Supplier Catalog
Item, refer to About Supplier Catalog Items documentation.

e. Description: Provide a description of the Agreement.

f. Start Date: Click the Calendar Date Selector button  to select a start date for the
Agreement.

g. End Date: Click the Calendar Date Selector button  to select an end date for the
Agreement.

h. Review Date: Click the Calendar Date Selector button  to select a review date for the
Agreement.

i. Scope: Provide the scope of the Agreement.

j. Assigned Team: Select a team.
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k. Assigned To: Select a member of the Assigned Team.

4. Provide terms for changing or terminating the Agreement:
a. Rules for Changes: Provide the negotiated and agreed upon rules for changing the

Agreement.

b. Rules for Termination: Provide the negotiated and agreed upon rules for terminating the
Agreement.

5. Provide Availability details:
a. Service Availability: Provide the time(s) that the service is to be available.

b. Service Uptime: Provide the uptime for the service.

c. Service Availability Exception(s): Provide the exception(s) for when the service will not be
available.

6. Provide Cost and Performance information:
a. Resolution Time: Provide the resolution time.

b. Resolution Units: Provide the units to be applied to the resolution time (example: Minutes,
hours, days, or weeks).

c. Resolution Business Hours: Click the Business Hours Manager button  to select the
business hours that will count against the resolution.

d. Associated Cost: Provide the cost of the product or service.

e. SKU Number: Provide the Stock Keeping Unit number of the Supplier Catalog Item.

7. When ready, the Owner begins planning the Agreement:
a. In the Default Form, click Begin Planning.

The Agreement status changes to Planning.

8. When the available information has been entered, the Owner activates the Agreement:
a. In the Default Form, click Activate to activate the Agreement.

The Agreement status changes to Active.

Note: The Owner can keep track of progress, troubleshooting, or other notes using the
Journals tab. The Journal tracks Owner notes/comments, as well as activity and
changes made to the Agreement.

9. When the Agreement has been fulfilled, the Owner can Retire the Agreement:
a. In the Default Form, click Retire to retire the Agreement.

The Agreement status changes to Retired.

10. The Agreement can be reverted to Active status or reverted to Inactive status after being retired.

a. Revert to Active: Click the link to revert the Agreement to Active.a.

b. Revert to Inactive: Click the link to revert the Agreement to Inactive.b.
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Agreement Features
CSM provides the following tools to help manage Agreements:
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Agreement Forms
Use the Agreement Forms to create, edit, and track Agreements. The forms are made up of four main
areas:

1. Default Form: Displays the name of the Agreement, Agreement type (OLA or Underpinning
Contract), and other important information.

2. Form Arrangement: Dynamically displays linked records (Child Records) that are in a relationship
with the parent Agreement.

3. Form Area: Displays the form fields for the tab selected in the Form Arrangement. The Overview
form contains most of the Agreement information.

4. Actions List:
◦ Assign to Me

◦ Deactivate
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The following table describes common fields on the Agreement Form:

Field Description Comments

Default Form
Displays the name of the Agreement, Agreement
type (OLA or Underpinning Contract), status, review
date, and Supplier and assignment information.

 

Overview

Contains information about the Agreement, such as
the Supplier Catalog Item Type, the Supplier Catalog
Item, a description of the Agreement, and the Scope
of the Agreement.

Fields in the Main pane
are the same, regardless
of the type of Agreement.
These fields are
completely customizable
and configurable.

*Name Name of the Agreement. *Required

*Supplier Supplier assigned to the Agreement.

*Required

A Supplier is a person or
group (internal or
external) that is
responsible for providing a
product or service to an
organization based on an
Operational Level
Agreement (OLA) or
Underpinning Contract
(UC).

*Supplier Catalog
Item Type

Designates if the Supplier is providing a product or a
service. *Required

*Supplier Catalog
Item

Designates what kind of product or service the
Supplier is providing.

*Required

Supplier Catalog Items
are limited by the Supplier
Catalog Type.

Description Description of the Agreement.

Scope A summary of the steps involved in completing the
Agreement.

Rules for Changes Provide the negotiated and agreed upon rules for
changing the Agreement.

Rules for
Termination

Provide the negotiated and agreed upon rules for
terminating the Agreement.

Resolution Time The negotiated and agreed upon resolution time.

Resolution Units The units to be applied to the resolution time.
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Field Description Comments

Resolution Business
Hours

The business hours that will count against the
resolution time.

Associated Cost The negotiated and agreed upon cost of the product
or service.

Form Arrangement Dynamically displays child records that are in a
relationship with the Agreement.

Terms Displays rules for changing or terminating the
Agreement.

Supplier Displays detailed information about the Supplier.

Journals
Displays related Journal records that are created to
track User notes/comments, field changes, and e-
mail correspondence.
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Agreement Journals
CSM provides the following OOTB Agreement Journal types:

• Journal - Note: Tracks User notes/comments.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt,
follow-up, resolution, and questions.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Remote Support History: Tracks chat/remote support sessions.

Note: History Journals are automatically created by CSM. Notes are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).
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Agreement One-Step Actions
CSMprovides the following Agreement One-Step Actions:

One-Step Actions Description/Actions Associations Executed From

Status

Alt 1 Step from
Relationship

Conditionally change the
Agreement Status to next
logical Status (defined by
the Agreement Status
values in Table
Management) and/or initiate
the next appropriate One-
Step.

Agreement Agreement Form: Next:
<Status>

Alt 2 Step from
Relationship

Next Step from
Relationship

Ownership

Take Ownership Makes the Current User the
Primary User of the record. OLA or UC Agreement Form: Assign

to Me Action

Supplier

E-Mail Supplier E-Mails Supplier associated
with the Agreement. OLA or UC Agreement Form: Supplier

e-mail address

Dial Supplier Phone Calls Supplier associated
with the Agreement. OLA or UC Not included on OOTB

Agreement Form

Other

Update Costs when OLA
Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

OLA
Agreement Form: One-Step
Action runs automatically
when OLA is saved.

Update Costs when UC
Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

UC
Agreement Form: One-Step
Action runs automatically
when UC is saved.

Update Costs when
Agreement Costs Change

Updates record to reflect
changes made to the
Associated Cost field.

Updates costs on associated
Work Units and Service
Catalog Templates.

Agreement
Agreement Form: One-Step
Action runs automatically
when Agreement is saved.

CSM 10.5.0 ITSM Practices 174

CSM 10.5.0 ITSM Practices



A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.
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Agreement Saved Searches
CSM provides the following OOTB Agreement Saved Searches:

Operational Level Agreements

Saved Search Returns Association Executed From

Active OLAs All active OLAs. OLA Search Manager, Widgets

All OLAs All OLAs, regardless of status. OLA Search Manager

OLA Costs Active OLAs with associated
costs. OLA Search Manager

Underpinning Contracts

Saved Search Returns Association Executed From

Active Status All active Underpinning Contracts. Underpinning Contract Search Manager, Widgets

This Week Underpinning Contracts with a
review date this week. Underpinning Contract Search Manager

Agreement

Saved Search Returns Association Executed From

Resolution Times Agreements containing a
Resolution Time. Agreements Search Manager

Supplier Agreements Agreements with a Supplier. Agreements Search Manager
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Change Management
Change management ensures that Changes are recorded, classified, scheduled, implemented, and
reviewed to minimize service disruption to the company.

Note: This feature is also available as a mApp Solution.
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About Change Requests
A Change Request is a record that tracks the addition, removal, or modification of anything that could
affect IT Services. These can include changes to architectures, processes, tools, metrics, documentation,
and other Configuration Items.

CSM manages three types of Changes:

• A Standard Change is documented, low-risk, low-cost, occurs frequently, and is thoroughly
understood by the Change Advisory Board (CAB). The change only needs to be approved by the
CAB once before it is added to a list of Standard Changes. After that, Standard Changes do not
need to go through the approval process.

• A Normal Change is undocumented and it is unknown how the Change might affect the system.
Though the CAB must approve the Change before implementation, it is not considered a high
priority, and can be addressed during the regular CAB meeting time.

• An Emergency Change is a break in the system and must be addressed immediately so that the
system can resume operation. Since the change is critical, it requires immediate attention from
either the CAB or Emergency Change Advisory Board (ECAB).

For example:

• A new employee requires a software installation (Normal Change). If this becomes a common
scenario, a Change Request can be submitted to make it a pre-authorized Change (Standard
Change).

• A technician reboots the email server because several employees are unable to access email
(Emergency Change).

Related concepts
Create a Change Request
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Change Good to Know
CSM uses several features to manage the Change workflow. The Change Form helps create, manage,
and track Changes; One-Step™ Actions help move the Change through its workflow; Automation
Processes notify stakeholders via email; an Approval process enforces Approvals; and a Change
Dashboard notifies stakeholders and tracks metrics.

• Search for one or more Changes that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Change by selecting New > New Change Request.
• If enabled (via an Automation Process), email notifications are automatically created and sent to

stakeholders. For example, send emails to:
◦ A customer to notify them of a status change.

◦ Team owners to notify them of ownership.

◦ The user owner to notify them of the ownership.

◦ Approvers when a Change requires approval.

• When on a record, you can send an email directly to the current customer (requester) by selecting
File > E-mail Current Customer in the CSM Desktop Client or by selecting E-mail > E-mail
Current Customer in the CSM Browser Client. You can also select the customer's email address in
the Change Form.

• Journals track what occurs during the record's lifecycle (example: Notes to track progress or
comments, and History to track important field changes, email correspondence). View or add
Journals by selecting the Journal tab in the record's Form Arrangement.

• Fields:
◦ Many fields with drop-down lists are driven by a Lookup Table and can be edited in the CSM

Desktop Client using Table Management. To see what table is providing the data, select inside
the field, and then press F3.

◦ Required fields are often conditional, meaning some are required to save a record, some are
required to change the status of a record, and some are required to close the record. Required
fields are marked with an asterisk by the field label.

◦ The Description field is a Rich Text field, so formatting and images/screenshots can be used to
complement the text. To format the text or embed an image, select the Zoom button.

◦ Some validated fields can recognize what you are typing and will suggest a value (example: If
you type "P" into the field, CSM will suggest the first item it finds that starts with the letter P).
Use the down arrow button to scroll through other possible values.

◦ Press TAB to move to the next field on the form.

Note: A full list of fields is beyond the scope of this document. Export a schema
document from CSM Administrator ( Create a Blueprint > Tools > Export Schema) to
view a full list of fields associated with a particular type of Business Object (example:
Major).

• Saving:
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◦ Date, time, and user name information is recorded the first time the form is saved, and each◦
time the form is modified.

◦ Selecting Save triggers an audit of fields that are being tracked for modification (example:
Status). If a modification is detected in a tracked field, a Journal-History record is created to
track the modification. View the modifications in the Journals tab (Form Arrangement).

Related concepts
Change Journals
Lookup Business Objects
About Table Management
About Rich Text
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Change Advisory Boards (CABs)
Normal and Emergency Change Requests require at least one approval by a Change Advisory Board.

Change Management uses two boards:

• Change Advisory Board: The Change Advisory Board (CAB) is a group of people that support the
assessment, prioritization, authorization and scheduling of Changes.

• Emergency Change Advisory Board: The Emergency Change Advisory Board (ECAB) is a subgroup
of the Change Advisory Board that makes decisions about Emergency Changes.

By default, Standard Changes do not require the approval of the CAB, but you can define an Approval
Process in CSM Administrator (Create a Blueprint > [Business Object] > Edit Approvals), if necessary.

Tip: Use the Change Advisory Board Worksheet to organize information relating to CAB and
ECAB members. You will need this information when defining the approval boards.
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Create a Change Advisory Board
Procedures are configured in the CSM Desktop Client and in CSM Administrator.

To configure the CAB:

1. Complete the Change Advisory Board worksheet: Organize information relating to CAB members.

2. Define Change Advisory Board Members: Select CAB members and assign basic Approval rights.

Note: CSM provides three Approvals for Change, including Emergency Change
Implementation Requests, Normal Change Assessment Approval, and Normal Change
Implementation Approval. Add, edit, or delete Approvals for Change in CSM Administrator.

Related concepts
Change Management mApp Solution Change Advisory Board Worksheet
About Approvals
Define Change Advisory Board Members
Security Features Security Rights
Create a Change Request
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Change Management mApp Solution Change
Advisory Board Worksheet

Use the Change Advisory Board worksheet to organize information relating to CAB members.

A subset of the CAB are members of the Emergency Change Advisory Board (ECAB), who approve
Emergency Change Requests.

Table 1. Change Advisory Board

Table Selections Comments

CAB Member
Name:  Member names come from a UserInfo table that is set

up when identifying CSM users.

Change Type

• Emergency

• Normal

• Standard

Defined using the Change Type Lookup Table in
Table Management.

Role

• Business Analyst

• Change Manager

• Developer

• End-User

• Financial Analyst

• Project Manager

• Project Team Member

• Sponsor

• Stakeholder

• Technical Analyst

• Tester

Defined using the CAB Role Lookup Table in Table
Management.

Approval Phase
• Assessment Phase

• Implementation Phase
By default, Standard Changes do not require an
Approval.

Related concepts
Create a Change Advisory Board
Table Management
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Change Management Workflows
CSM offers three workflows based on Change types.

Change Types

• Standard - Does not require review.

• Normal - Requires review but is not urgent.

• Emergency - Requires review and is urgent.

Contributors
A Change typically has several contributors. Depending on your workflow and the size of your company,
many of these contributors may have any of the following combined roles:

• Creator: User who first logs the Change. This is typically a technician.

• Requestor: User who requests the Change. This is typically an IT manager.

• Owner: User who manages the Change. This is typically a change manager.

• Approver: User who ensures that the Change should be implemented. This is typically one or more
members of the CAB Team.

Which Workflow Should I Use?
Use the following flowchart to determine which type of Change workflow to follow.

Standard Change Workflow
This is a high-level workflow for Standard Changes.
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Normal Change Workflow
This is a high-level workflow for Normal Changes.

Emergency Change Workflow
This is a high-level workflow for Emergency Changes.

Related tasks
Create a Standard Change Request
Create a Normal Change Request
Create an Emergency Change Request
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Create a Change Request
Normal Changes and Emergency Changes require steps to create a plan and gain approval from a
Change Advisory Board (CAB). Standard Changes consist of pre-approved procedures and Tasks.

Normal, Emergency, and Standard Change Requests each have slightly different forms, but share many
fields. This topic provides an overview of the Change Request Form. Refer to Create a Standard Change
Request, Create a Normal Change Request, and Create an Emergency Change Request for details on
the workflow for each Change Type.

The diagrams below show high-level workflows for each Change Type.

High-Level Standard Change Workflow

High-Level Normal Change Workflow

High-Level Emergency Change Workflow
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Create and Classify the Change
On the CSM toolbar, select New > New Change Request.
A new Change record is created with a unique Change ID.

Field Description

Requester

In the Requester Field, specify the name of the person who initiated the Change, and
then press Enter or Tab to search for the Customer Record.
If an exact match is found, the Requested By Fields in the Default Form are auto-
populated with the customer’s name and email. If multiple matches are found, the
Contact Manager opens so you can select the appropriate customer. To browse
customers, select the Related Item Picker.

Title Specify a title for the Change.

Description Specify a description of the Change.

Change Type Select Normal, Standard, or Emergency. The fields that are show on the rest of the
form depend on this selection.

Change Model
Select the Related Item Picker to choose a Change Model (required for Standard
Changes, optional for Normal and Emergency Changes). The Change Model will pre-
populate several fields, depending upon how the Change Model was set up.

Emergency Subtype Select a subtype (Service Restoration or Outage Avoidance) from the drop-down list
(Emergency Change only).

Primary Configuration
Item

Select the Related Item Picker to launch the CMDB window, and then select a CI. This
shows CIs for any customer or for a selected customer.

Assigned Team Specify the Team Owner of the Change.

Reason Use the drop-down list to select a reason for the Change.

Change Already
Implemented?

Indicates whether the Emergency Change has already been implemented (Emergency
Change - Service Restoration only).
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Field Description

Assigned To
Specify the member of the Team who will be the User Owner of the change.
The Creator can take ownership of the Change by selecting Assign to Me in the
Actions list.

Proposed Start Date Select the Calendar Date Selector to select a start date for the Change (Standard and
Normal Change only).

Proposed End Date

Select the Calendar Date Selector to select an end date for the Change (Standard and
Normal Change only).

Note: If a Stop icon appears next to the Proposed Start and/or Proposed End
Date, you are outside of the maintenance window, and you must select an
acceptable date. Hover over the icon for a detailed error message.

Impact Select the scope of the Change from the drop-down list.

Urgency Select the service level from the drop-down list.

Priority The Impact and Urgency scores are used to calculate the Priority.

Service Affected Select the Related Item Picker to select the affected Service.

View Change Calendar Select the View Change Calendar link to open the Change Calendar.

View Collision Detection Select the View Collision Detection link to open a Configuration Map of the Primary CI.

Review Date Select the Calendar Date Selector to select a review date the Change (Normal Change
only).

Risk and Planning
The procedures in this section are for Normal Changes and Emergency Changes but do not apply to
Standard Changes. These types of Changes require approval from a Change Advisory Board (CAB).

Field Description

Implementation Plan Specify the process required to implement the Change.

Justification Enter a justification for the Change Request.

Acceptance Criteria Specify the functionality and quality requirements.

Validation Plan Provide a validation plan (Normal Change only).

Back Out Plan Specify a plan to back the Change out if implementation fails.

Outage Required Select this check box if the CI will experience an outage while the Change is
implemented (Normal Change only).

Impact Assessment Provide an impact assessment.

Outage Start Date Select the Calendar Date Selector to select a start date for the outage (Normal
Change only).
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Field Description

Outage End Date

Select the Calendar Date Selector to select a start date for the outage (Normal
Change only).

Note: If a Stop icon appears next to the Outage Start and/or Outage End
Date, you are outside of the maintenance window, and you must select an
acceptable date. Hover over the icon for a detailed error message.

Complete Risk
Assessment In the Actions list, select this link to open the Risk Assessment questionnaire.

Validation and Review
Emergency Changes are time sensitive and do not require all of the review procedures listed in this
section. Steps that are used only for Normal Changes are marked (Normal Change only).

1. Owner assesses the Change:

Field Description

Impact Assessment Specify the impact assessment (consequences of the Change).

Back Out Plan Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

2. A peer review task must be assigned and completed.

3. (Normal Change only) Owner submits the Change for authorization:
a. Under Status, select the Next: Submit for Approval link.

b. If a peer review task is incomplete, the Change cannot be submitted for approval.

4. (Normal Change only) Approver approves the Change:
a. In the Approval grid, double-click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval process rules.

b. (Optional) Provide comments.

c. Select Approve.
The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

The Change status changes to Pre-Implement and the Change enters the Implement phase.

5. (Normal Change only) If the Change is approved, it moves to the Scheduled status.
a. Under Status, select the Next: Scheduled link.

6. When you are ready to implement the Change, select the Next: Begin Work link.

7. After deployment of the Change, the owner completes the Validation and Review section.
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Field Description

Actual Start Date

Select the Calendar Date Selector to select the date that the
Change actually started. When a Change Request moves to
the In Progress status, this field is auto-populated with the
current date/time.

Actual End Date

Select the Calendar Date Selector to select the date that the
Change actually ended.

Note: If a Stop icon appears next to the Actual Start
and/or Actual End Date, you are outside of the
maintenance window, and you must select an
acceptable date. Hover over the icon for a detailed
error message.

Close Code Select a close code from the drop-down list.

Close Notes Specify additional information related to implementation of the
Change.

PIR Select the Post Implementation Review status.

CMDB Update Complete Select this check box when the CMDB update is finished.

Email Change Review Select this link to email the user assigned to this Change.

Complete the Change
Close the change.

Note: All fields in this section must be filled out before you can move a Change Request to Closed
status. There is an exception if the Close Code is Cancelled, Declined by CAB, or Withdrawn.

Related concepts
About Change Requests
Change Workflow
Change Features
Create a Change Advisory Board
Change Models
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Create a Standard Change Request
Standard Change Requests do not require approval.

Standard Changes have four stages: Classify, Implementation, Review, and Closed.

To create a Standard Change:

1. Create a Change Request and select Standard from the Change Type drop-down list.
2. All fields in the Classification section are required fields (with the exception of Primary

Configuration Item).
When you enter the Change Model; the Title, Description, Service Affected, and Service Importance
fields automatically populate.

3. Add any Tasks associated with the Change Request.
4. Under Status, select the Scheduled link.
5. When you are ready to begin implementation tasks, select the Next: Begin Work link (under

Status).
The Stage moves to In Progress. You can also place the Change Request on hold by selecting the
On Hold link under Actions.

6. Under the Validation and Review section, all fields are required. Complete all associated Tasks.
All fields in this section must be filled out before you can move a Change Request to Closed status.
The exception is if the Close Code is Cancelled, Declined by CAB, or Withdrawn.

7. After the Change is deployed, select the Next: Validation link (under Status).
8. All implementation tasks must be closed before advancing to the next status.
9. Under Status, select the Next: CMDB Update link.

After the Change Owner updates the CMDB, select the CMDB Update Complete check box.
10. Under Status, select the Next: Mark as Complete link.

The status changes to Closed.

Related concepts
Change Management Workflows
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Create a Normal Change Request
Normal Change Requests require approval.

Normal Changes have six stages: Classify, Assessment, Authorization, Implementation, Review, and
Closed.

To create a Normal Change Request:

1. Create a Change Request and select Normal from the Change Type drop-down list.
2. All fields in the Classification section are required fields.
3. Under Status, select the Next: Risk Analysis link.
4. Select the Risk Assessment link to fill out the Risk Assessment survey (required).

You cannot edit a Risk Assessment after you submit it.
5. Under Status, select the Next: Planning link.

A prompt appears notifying you that a Peer Review work item has been created and needs to be
assigned. Select Close to close the window.

6. Select the Tasks tab to complete the Peer Review.
7. During the Planning stage, complete the implementation plan, provide evidence of testing, add tasks

if necessary, and prepare the Change Request for approval. Under the Risk and Planning section,
all fields are required before you can submit for approval.

8. Create any Tasks necessary for the Change Request.
9. Under Status, select the Next: Approval link to submit the Change Request for authorization. CSM

calculates lead times and an approval deadline. If the proposed start date does not meet the lead
time requirement, you will have to either reschedule the change or submit it as an exception.
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If the CAB approves the Change Request, the status moves to Scheduled. If it is denied, the status
moves to Rejected.

Note: After submitting for approval, all fields in the Classification and Risk and Planning
sections are disabled and read-only, with the exception of the Assigned Team/Assigned To
and Proposed Start and End Dates. After approval, the Proposed Start and End Dates are
disabled and read-only.

10. When you are ready to begin implementation tasks, select the Next: Begin Work link (under
Status).
The Stage moves to In Progress. You can also place the Change Request on hold by selecting the
On Hold link under Actions.

11. Under the Validation and Review section, all fields are required. Complete all tasks.
All fields in this section must be filled out before you can move a Change Request to Closed status.
The exception is if the Close Code is Cancelled, Declined by CAB, or Withdrawn.

12. After the Change is deployed, select the Select Next: Validate Change link (under Status).
13. All implementation tasks must be closed before advancing to the next status.
14. Under Status, select the Next: CMDB Update link.

After the Change Owner updates the CMDB, select the CMDB Update Complete check box.
15. Under Status, select the Next: Mark as Complete link.

The status changes to Closed.

Related concepts
Change Management Workflows
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Create an Emergency Change Request
Emergency Change Requests are urgent requests that require approval.

Emergency Changes can be classified into subtypes to identify emergency change drivers and adjust
business rules for submission.

• Service Restoration: A Change necessary to resolve a service outage or a severe degradation of
service delivery. Approval of actions to restore service is managed by the team working the incident;
approvals are not executed in CSM.

• Outage Avoidance: The Change must be executed outside the normal Change process to prevent a
service interruption. Approvals must be completed prior to implementation.

Emergency Changes have five Stages: Classify, Authorization, Implementation, Review, and Closed.

To create an Emergency Change Request:

1. Create a Change Request and select Emergency from the Change Type drop-down list.
2. All fields in the Classification section are required fields (with the exception of Change Model and

Primary Configuration Item).
When you enter the Change Model; the Title, Description, Assigned Team, and Service Affected
fields automatically populate.

3. Add any Tasks associated with the Change Request.
4. Under the Risk and Planning section, all fields are required.
5. For Emergency Subtype, select Outage Avoidance or Service Restoration.
6. If you choose Outage Avoidance:
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a. When an Outage Avoidance is submitted for ECAB approval, formal review and authorization
occurs. Approval Task(s) must be approved. If the Outage Avoidance is rejected, the Change
Request is closed.
If it is approved, the Change Request moves to Scheduled status.

b. Select the Next: ECAB Approval link (under Status).
7. If you choose Service Restoration, all fields in the Classification and Risk and Planning sections

are required prior to moving to the next status because ECAB approval is bypassed.
8. Select the Next: Scheduled link (under Status).
9. When you are ready to begin implementation tasks, select the Next: Begin Work link (under

Status).
The Stage moves to In Progress.

10. After the Change is deployed, perform validation testing. Under the Validation and Review section,
all fields are required.
All fields in this section must be filled out before you can move a Change Request to Closed status.
The exception is if the Close Code is Cancelled, Declined by CAB, or Withdrawn.

11. Under Status, select the Next: CMDB Update link.
After the Change Owner updates the CMDB, select the CMDB Update Complete check box. If no
CMDB Update is required, you can move to the next step.

12. Under Status, select the Next: Mark as Complete link.
The status changes to Closed.

Related concepts
Change Management Workflows
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Change Features
CSM includes several tools to help manage Change.

Related concepts
Create a Change Request
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Change Management Risk Assessment
Use Risk Assessments to assess the risk of Normal and Emergency Change Requests.

Risk Assessments are mandatory for Normal Changes and optional for Emergency Changes. The Risk
Assessment includes ten standard questions, but you can edit them as needed.

• How many users will be impacted by this Change?

• Has this Change been implemented before?

• Is there an impact to revenue if the Change fails?

• How easy would it be to roll back this Change if it failed?

• If there is a failure with the Change, can services be restored within the proposed start and end
date?

• Is the Change fully documented?

• How many resources are required for this Change?

• Is the Change visible to external customers?

• Has the Change been tested?

• Could a business service disruption occur if the Change implementation does not go as planned?

A risk score of Low, Moderate, High, or Critical is calculated based on the answers.
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Change Management Change Form
Use the Change Form to create, edit, and track Changes.

The form has five areas:

1. Status Area: Displays information relevant to the Change Form, including Change ID, Change type
(Standard, Normal, or Emergency), Status, and Requester.

2. Pages: Displays linked records (child records) that are related to the Change (parent record), such
as Journals (to track notes and history), Problems, and Incidents.

3. Form Area: Displays the main form fields.

4. Stages: A list of the stages associated with the Change Request. Different Change Types have
different stages.

5. Actions List: Dynamically displays a list of actions that are available for the current Change.

The following image shows a Standard Change Form with the five sections identified.
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Change Journals
CSM provides several Change Journal types.

• Journal - Note: Tracks user notes/comments. For example, a user might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks customer requests/comments.

• Journal - History: Tracks important field changes. Tracked fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks email correspondence. For example, emails sent for receipt, follow-
up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

Note: History Journals are automatically created by CSM. Note and Customer Request
Journals are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by selecting the Journals tab in the parent record's Form
Arrangement).

Related concepts
Change Good to Know
About Queues
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Change Dashboard
CSM provides a Change Dashboard that intuitively organizes your critical metrics into a single, real-time,
at-a-glance Change control panel.

Note: Change metrics are also found on other Dashboards (example: Global IT).

The following table describes the items on the Dashboard.

Item Description Widget
Type Widget Name Widget Uses

Open Change
Requests All open Changes. Search

Results List
CDAll Open
Changes

All Open Changes
Saved Search

My Change
Reviews

Number of approved
Changes owned by the
current user.

Search
Results List

CDAll Approved
Changes

My Approved
Changes Saved
Search

Approved
Changes All approved Changes. Text Gauge

CDTotal
Approved
Changes

Approved Changes
Saved Search

Linked
Incidents or
Problems

Open Changes that have
either at least one linked
Incident or one linked
Problem.

Text Gauge
Changes with
Linked Incidents
or Problems

Active Changes with
Linked Incidents and
Problems Saved
Search
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Item Description Widget
Type Widget Name Widget Uses

Open Past
Scheduled
Close Date

Open Changes (Status does
not = Closed) that are open
past the time they are
scheduled to be closed
(Created Date Time is
greater than Scheduled End
Date).

Text Gauge
CDOpen
Changes Past
Request Date

All Open Past
Scheduled Close
Date Saved Search

Changes
Outside
Window

Open Changes (Status does
not = Closed) that occur
outside of the maintenance
window (Not During
Maintenance Window =
True).

Text Gauge

CDOpen Change
Outside of
Maintenance
Window

Open Changes Not
During Maintenance
Window Saved
Search

High Risk
Changes

Incomplete Changes (Status
does not = Complete) with a
risk value that is greater
than/equal to 3.

Text Gauge CDHigh Risk
Changes

High Risk Changes
Saved Search

Change
Request Life
Cycle

Number of open Changes
based on status.

Pipeline
Chart

CDChange
Request Lifecycle

All Open Changes
Saved Search

Open Change
Requests by
Type

Percentage of open
Changes based on type.

Doughnut
Chart

CDChanges by
Type

Change Requests
Saved Search
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Change One-Step Actions
CSM provides multiple One-Step Actions associated with Change Requests.

One-Step™
Actions Description/Actions Executed From

Status   

Alt Step from
Relationship

Conditionally changes the Change status to next logical
status (defined by the Change status values in Table
Management) and/or initiate the next appropriate One-
Step Action.

Change Form:
<Status> link

Alt 2 Step from
Relationship

Next Step from
Relationship

Button Next Step
Conditionally changes the embedded form to the next
logical form (based on Embedded Form) and/or initiates
the next appropriate One-Step Action.

Change Form: Form
buttons

Form   

Ownership   

Assign to Anyone
Prompts the user to assign the record to any CSM user
(not limited by Team). Uses Owned By ID and Owned
By Team fields.

Change Form: Assign
To link

Assign Change to
Owner

Launches the Choose Team window, where a user can
choose an Owned By Team for the record; then,
launches the Choose User window, where a user can
choose a Primary User from the already-selected Team.

Change Form: Select
Owner link

Assign Change to
Team

Launches the Choose Team window, where a user can
choose an Owned By Team for the record.

Change Form: Select
Team link

Take Ownership of
Change Makes the Current User the Primary User of the record. Change Form: Take

Ownership link

Other   

Create Change
Review

Creates a new Review Questionnaire (Supporting
Object) and creates an email containing a link to the
review and record details (Description, Scheduled End
Date, Actual End Date).

Change Form: E-Mail
Change Review link

Change Request
Actions toolbar item;
Create Change
Review option
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One-Step™
Actions Description/Actions Executed From

Create New Task Creates a new Task in the Change's Form
Arrangement.

Change Form: Create
New Task link

Nominate for
Standard Change Creates a new Normal Change Record.

Change Form:
Nominate for Standard
Change link

Rework Change
Request

Changes the Change status to New so users can edit
fields and then resubmit the Change for CAB Approval.

Change Form: Rework
Change link

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.

Related concepts
Change Workflow
Change Form
Action Block Email Templates
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Change Saved Searches
CSM provides numerous Change Saved Searches associated with Change Requests.

Notable Change Saved Searches include:

Saved Search Returns Executed From

Active Changes with
Linked Incidents or
Problems

Open Changes that have either at least one
linked Incident or one linked Problem.

Search Manager,
Widgets

All Changes Waiting
Approval

Changes that have a status of Waiting
Approval. Metrics

Change Requests All Change Requests, regardless of status. Search Manager,
Widgets

Emergency Change Changes that are defined as Emergency
Changes.

Search Manager,
Widgets, Change
Calendar

My Approved Changes Changes approved by me (current user). Search Manager,
Widgets

My Open Change
Requests Open Changes owned by me (current user). Search Manager,

Widgets

My Teams Open Change
Requests

Open Changes owned by one of my (current
user) Teams.

Search Manager,
Widgets

My Total Changes Changes owned by me (current user). Search Manager,
Widgets

Normal Change Changes that are defined as Normal Changes. Search Manager,
Change Calendar

Standard Change Changes that are defined as Standard
Changes.

Search Manager,
Change Calendar

Related concepts
About Saved Searches
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Change Automation Processes
CSM provides the following Change Automation Processes.

Name Description

Notify Requester of
Status Change

When the Status Field of a Change Request changes, the process initiates the
Send Status Change E-mail One-Step™ Action, which sends an email
notification of the status change to the requester of a Change Request.

Notify Change Team
of Assignment

When the Owned By Team Field of a Change Request changes, the process
initiates the Notify Owned By Team via E-mail One-Step Action, which sends a
notification email to members of the Team that owns the Change Request.

Notify Change Owner
of Assignment

When the Owned By Field of a Change Request is changed, the process
initiates the Notify Owned By via E-mail One-Step Action, which sends a
notification email to the new owner.

Change Approval
Notifications

When an Approval is added to a Change Request, the process initiates the
Send E-Mail One-Step Action, which sends a notification email to members of
the CAB.

Change - Escalate 4
Hours after End Date

Waits four hours after the Scheduled End Date. If the time limit passes, the
process initiates the Escalate Change 4 Hours After End Date One-Step
Action, which sends an email to the Change Request owner requesting that
they update the record.

Change - Notify
Problem Owner

Waits until a Change Request that is linked to a Problem is closed, then
initiates the Notify Problem Owner Change is Closed One-Step Action, which
sends a notification email to the Problem owner.

Related concepts
Automation Processes
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Change Reports
CSM provides several Change Reports associated with Change Requests.

Report Description Saved Search

Planned Changes Lists Normal and Standard Changes within a user-
specified date range. All Open Changes

Post Implementation
Review

Lists Changes and their associated Incidents and/or
Problems.

Changes with
Linked Incidents
and Problems

Change Trends Line chart shows the number of Changes by the
associated Service. Also lists Change details.

Changes with
Linked CIs

Past Year Change
Trends

Line chart shows the number of Changes within the past
year by the associated Service. Also lists Change
details.

Date Range for
Report

Change Breakdown
Line chart shows the number of Changes by the reason
for the Change (example: Incident Resolution) within a
user-specified date range. Also lists Change details.

Date Range for
Report

Past Year Change
Breakdown

Bar chart shows the number of Changes by the reason
for the Change (example: Incident Resolution) within a
user-specified date range. Also lists Change details.

Date Range for
Report

CI Change Request
Metrics

Bar chart shows the top five CIs based on the highest
number of associated Change Requests. Also lists
Change details.

Changes with
Linked CIs

Proactive Service -
Changes

Lists Changes based on Service Categorization within a
user-specified date range.

Date Range for
Report

Related concepts
About Reporting
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Change Models
Use Change Models to pre-populate certain fields in Change Request forms.

A Change Model is a pre-defined template you can apply to Change Requests. When you apply a
Change Model to a Change Request, the template information is entered into the Change Request, and
those fields are made read-only.

You can create and propose Change Models or retire them.

Note: When OOTB, you can only apply Change Models whose status is Active, and whose type
matches the Change Request type (Standard, Normal, or Emergency).

Related concepts
Create a Change Request
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Create a Change Model
Create a Change Model for the most common changes you encounter in your organization.

To create a Change Model:

1. Select New > New Change Model in the CSM Desktop Client or CSM Browser Client.
2. Provide a name for the Change Model.
3. From the Change Type drop-down list, select Standard, Normal, or Emergency.

Depending on the Change Type you choose, you can include the following fields:

Field Normal Emergency Standard

Owned By Team x x x

Change Title x x x

Justification x x

Description x x x

Service Affected x x x

Risk and Impact x x

Backout Plan x x

Implementation Plan x x x

4. The CAB members associated with the Change Model's Change Type are automatically added to
the Standing Cab Members tab in the form arrangement. Those members are also responsible for
moving the Change Model through to activation.
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Change Design Ideas
CSM provides a Change workflow with all the tools you need to successfully create and manage a
Change. You can use this workflow as-is or tailor it to meet the needs of your organization.

Design ideas include:

• Fields: Change which fields are required and when and which fields support Rich Text.

• View Counter: Incrementally track the number of times a record is viewed by a customer or user in
the CSM Desktop Client, CSM Browser Client, and CSM Portal. View Counter functionality is
configured in CSM Administrator.

• Statuses: Modify Change statuses and/or the One-Step™ Actions that are initiated when a Change
enters each status.

• Form: Change the form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate your workflow
(example: Add another Approval process), or implement any of the unused sample One-Step
Actions that are shipped with CSM (example: Create and send out a Change Review questionnaire).

• Email: Change the templates that are used to create the emails sent by Automation Processes, or
disable/change when and to whom notifications are sent (example: Notify Change owners by email
of any status updates).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down fields (example: CAB Members).

• Approvals: Modify the Approval process rules (example: The number or percentage of approvers
needed to approve a Change).

Related concepts
Rich Text
Counters
One-Step Actions
Approvals
Forms
Automation Processes

CSM 10.5.0 ITSM Practices 210

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=rich_text
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=counters
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=one-steps-actions
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=approvals
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=forms
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_automation_processes


Event Management
Event Management is a way to systematically observe services and service components, and record and
report selected changes of state identified as events.
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Security Events
Security Events are generated from multiple sources and can be created automatically and manually.

You can create Security Events from:

• All Configuration Items using the Events tab.

• Integration with a Security Information and Event Management (SIEM) and/or network monitoring
systems.

• The drop-down list in the main toolbar of the CSM Desktop Client and the CSM Browser Client.

Related tasks
Create a Network or Security Event
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Create a Network or Security Event
Create and manage Network or Security Events to determine if an action is required.

You can create an Incident, Service Request, or other record to help manage your Events. Close the
Event if no further action is needed.

Network and Security Events will generally be opened via automation but can also be opened manually.

To create a Network or Security Event:

1. From the toolbar in the CSM Desktop Client or the CSM Browser Client, select New > New Event >
New Event - Network or New Event - Security.

2. Provide a name and details.
3. Select an event type and service.

Both fields are optional for a Network Event. For a Security Event, the Event Type field is required
and the Service field is not available.

4. Select a priority and event severity.
5. Select a reported date time and who reported the Event.

The Reported Date Time field is autopopulated and is a required field. The Reported by field is
optional.

6. Select a source and provide an external source ID.
The Source field is required, but the External Source ID field is optional.

7. (Optional) Assign the Event to a team and individual.
You can also select the Assign to Me link in the Actions list.

8. Provide the response notes, cause code, and resolution details.

Note: The Response Notes and Resolution Details fields are optional, but the Cause
Code field is required before you can move the status to Resolved.

The Resolution Details field is audited and Journal entries track modifications made. View the
Journal - History entries in the Journals tab of the form arrangement.

9. (Optional) Initiate other Actions as appropriate using the links in the Actions list.
10. Select Save.
11. Work Items, Affected Users (Security), Network Events (Security), Similar Events, Security Events

(Network), Incidents, Change Requests, and Configuration Items (CIs) associated with the Event will
be listed in their respective tabs of the form arrangement. You can create new Work Items/Events
and Incidents/Change Requests and link affected users, Events, and CIs in each tab.

Related concepts
Security Events

CSM 10.5.0 ITSM Practices 213

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/bundle/csm_record_management_10_5_help_only/page/content%2Frecord_management%2F..%2F..%2Fcontent%2Frecord_management%2Fsecurity_events.html


Event Management Dashboard
The Event Management dashboard gives you at-a-glance information on Network and Security Events
and severity and status data.

Use the Event Management Dashboard to monitor and take action on any Network or Security Events
detected throughout your organization. Elevated Security and Priority Events are highlighted so you can
easily drill down into the details. The Events by Status funnel widget allows management to ensure
Events are reviewed and processed as soon as they are reported. Use the Unresolved Aging Events
widget to take action on any Event aging unnecessarily, potentially putting your customers at risk.
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Knowledge Management
Knowledge management is the process that ensures that all Knowledge in your CSM Knowledge Base is
efficiently gathered, approved, stored, and shared with users and customers.

In CSM, Knowledge is stored mainly in Knowledge Articles (KAs) but can come from other Knowledge
Sources as well, including Business Object records, attachments, and web sources (example: Google or
YouTube).

For more information, see:

• About Knowledge

• Knowledge Features and Capabilities

• Knowledge Article Good to Know

• About Knowledge Articles

CSM 10.5.0 ITSM Practices 215

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_knowledge
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=knowledge_article_features_and_capabilities
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=knowledge_article_good_to_know
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_knowledge_articles


Risk Management
Risk management is the process that allows organizations to minimize risks associated with Suppliers by
defining and tracking factors that could affect the delivery of a service.
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About Risk
A Risk Assessment is a questionnaire that is used to evaluate the risk level of a Supplier. Users evaluate
a Supplier using the Risk Questionnaire by answering questions related to Service Delivery risks and
Service Disruption risks. As the User progresses through the questionnaire, Risk Weight definitions
calculate the risk level, and then auto-populate Risk Chart using Low, Medium, High, and Extreme risk
levels.

In CSM, Risk Assessment is a Supporting Business Object. The Risk Assessment form allows Users to
view and manage Risk Assessments.

Note: Risk Weight is a Lookup Object that allows Users to define Risk Assessment properties
(including categories, subcategories, point allocation, etc.) using Table Management.

Note: Risk Assessment can be used to support Multi-Sourcing Service Integration (MSI) and
Service Integration and Management (SIAM). For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.
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Risk Good to Know
• A Risk Assessment is a questionnaire that is used to evaluate the risk level of a Supplier.

• Risk Weight is a Lookup Object that allows Users to define Risk Assessment properties (including
categories, subcategories, point allocation, etc.) using Table Management.

• Search for one or more Risk Assessments that meet a specific criteria by running a Quick Search or
Search Group.

• Create a new Risk Assessment by clicking Create a Risk Assessment in a Supplier form.

• The OOTB system implements several Actions/One-Step Actions to make creating Risk
Assessments more efficient. For more information about Actions and One-Step Actions, refer to the
Actions/One-Step Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Risk Assessment records by controlling who can view, create, and edit records.
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Scorecard Management
Scorecard management is the process that allows users to evaluate the performance of a supplier in real
time.
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About Scorecards
A Scorecard is a record that allows Users to view detailed Supplier performance data in real time. The
Scorecard displays data that is automatically calculated based on quality, delivery, responsiveness, and
complaints, and then presented as a letter grade in the Supplier form.

In CSM, Scorecard is a Supporting Object. The Scorecard form allows Users to view and manage
Scorecards.

Note: Scorecard Weight and Scorecard Curve are Lookup Objects that allow Users to define
Scorecard properties (categories, point allocation, grading system, etc.) using Table Management.

Note: Scorecard can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Scorecard Good to Know
• A Scorecard is a record that allows Users to view detailed Supplier performance data in real time.

• The Scorecard displays data that is automatically calculated based on quality, delivery,
responsiveness, and complaints, and then presented as a letter grade.

• Scorecard Weight and Scorecard Curve are Lookup Objects that allow Users to define Scorecard
properties (categories, point allocation, grading system, etc.) using Table Management.

• Search for one or more Scorecards that meet a specific criteria by running a Quick Search or
Search Group.

• Secure Scorecard records by controlling who can view records.

CSM 10.5.0 ITSM Practices 221

CSM 10.5.0 ITSM Practices

https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_quick_search
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_search_groups
https://help.cherwell.com/csh?product=version-csm-10.5.0&topicname=about_security_groups


Service Cart Management
Service Cart management is the process that gives customers more control over their Service Requests
and Service Orders.

Note: This feature is also available as a mergeable application (mApp Solution).
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About Service Carts
CSM provides a service cart as a Major Business Object for customers to use in the supplied IT Portal.

A service cart is an e-commerce tool that allows customers to add multiple Service Requests to a single
order, and then temporarily hold the items until they are ready to submit the full order. When the order is
submitted, each Service Request automatically creates associated Tasks based on related Service
Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and customers view and
track the Service Requests (and Service Request history) on the My Service Orders page of the
Customer Portal.

Note: Service Cart can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM).
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Service Cart Good to Know
• A Service Cart is an e-commerce tool that allows Customers to add multiple Service Requests to a

single order, and then temporarily hold the items until they are ready to submit the order. When the
order is submitted, each Service Request automatically creates associated Tasks based on related
Service Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and
Customers view and track the Service Requests (and Service Request history) on the My Service
Orders page of the Customer Portal.

• CSM Provides an OOTB Service Cart as a Major Business Object for Customers to use in the
OOTB IT Portal.

• Service Carts are automatically created when a Customer creates and saves a new Request in the
Portal. Once the Customer submits the items in the Service Cart, the Service Requests are created
in the CSM Desktop Client, and a Service Order is created that lists the details of the Customer's
Service Request(s).

• Incidents logged in the Portal do not go into a Service Cart or Service Order. Only Service Requests
are submitted via the Service Cart.

• CSM provides a read-only, editable OOTB Service Cart form available in CSM Administrator. The
Service Cart form is separate from the Service Request forms available in the CSM Desktop Client
and the Portal. For more information, refer to the Incident documentation.

• The OOTB CSM system implements several Actions and One-Step Actions to make working with
the Service Cart more efficient. For more information about Actions and One-Step Actions, refer to
the Actions/One-Step Actions documentation.

• CSM provides several OOTB Service Cart Saved Searches that make finding Service Requests,
creating Widgets, and running Reports easier and faster.

• The OOTB CSM system implements several Automation Processes to automate Service Cart
Management (ex: Sending Customers reminders about their abandoned Service Carts). For more
information, refer to the Automation Process documentation.
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Service Cart Workflow

Note: The Service Cart has its own workflow separate from the Incident/Service Request
workflow. For more information about the workflow, phases, and statuses of Incidents and Service
Requests, refer to the Incident documentation.

The following figure shows a high-level Service Cart process workflow in the OOTB CSM system.
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Note: CSM uses several features to manage the Service Cart workflow. The Service Request
forms in the Portal help create and manage items in the Service Cart. Automation Processes
notify Customers via e-mails about the status of their Service Orders. The Service Cart
Dashboards allow Customers to track their open and past Service Orders.

Contributors
A Service Cart typically involves the following contributors:

• Customer: The Portal Customer who logs Service Requests.

• Technician: The User who manages and completes the Service Requests.

Statuses
A Service Cart progressing through the workflow encounters the following statuses:

1. New: Customer has created and recorded the initial details of a Service Request(s) in the Portal.

2. Committed: Customer has submitted their Service Order in the Portal.

3. Pending: The Service Order is temporarily paused or on hold.

4. In Progress: A technician in the CSM Desktop Client is investigating/fulfilling the Service Order.

5. Complete: A technician has resolved and closed the Service Order.

6. Canceled: The Customer who created and recorded the initial details of the Service Order has
canceled the order in the Service Cart before submitting it.

7. Abandoned: The Customer who created and recorded the initial details of the Service Order has
abandoned their order in the Service Cart without canceling or submitting it.
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Using Service Carts
When working with Service Carts, Users can:
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Add Items to the Service Cart
Service Carts are automatically created when a Customer creates and saves a new Request in the Portal.
Once the Customer submits the items in the Service Cart, the Service Requests are created in the CSM
Desktop Client, and a Service Order is created that lists the details of the Customer's Service Request(s).

Note: Incidents logged in the Portal do not go into a Service Cart or Service Order.

To add an item to a Service Cart:

1. Log in to the Portal

2. Click the Service Catalog button on the menu bar.

The Service Catalog opens.

3. Select a Request (ex: Request New Computer).

The Request form opens.
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4. Complete the Request form.

5. Click the Add to Cart button.

The My Service Cart Dashboard opens.

To add more Requests to the Service Cart, click Continue Shopping to return to the Service
Catalog. Click Cancel Order to cancel the entire order (you are prompted to verify before your order
is canceled).

6. Submit the Service Cart by clicking the Submit Order button. The My Service Orders Dashboard
opens and shows the status of all current and past Service Orders. Customers can click on an item
in the Grid to open the Service Request.
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View Items in a Service Order
Once a Service Request has been submitted, Customers can view the status of their current Service
Orders and review past Service Orders using the My Service Orders Dashboard.

To view items in a Service Order:

1. Log in to the Portal

2. Click the Service Orders drop-down in the menu bar, and then select My Orders.

The My Service Orders Dashboard opens.

3. Select an item from the Grids to open the specific Service Request.
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Service Cart Features
CSM provides the following tools to help manage the Service Cart:

• Form

• Dashboards

• One-Step Actions

• Saved Searches

• Automation Processes
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Service Cart Form
CSM provides a read-only OOTB Service Cart form available in CSM Administrator. The Form is
comprised of two main areas:

1. Default Form: Displays important at-a-glance information (Service Order ID, Status bar, record
ownership, etc.).

2. Form Area: Displays the main Form details and Fields.

Note: The Service Cart form is separate from the Service Request forms available in the
CSM Desktop Client and the Portal. For more information, refer to the Incident
documentation.

Service Cart Form Fields

Field Description Comments

Default Form

Service
Order

Record type and unique record identifier
(ID).

CSM automatically assigns the ID when the
Service Cart is created.
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Field Description Comments

Status

Statuses include:

• New: Customer has created and
recorded the initial details of a
Service Request(s) in the Portal.

• Committed: Customer has
submitted their Service Order in the
Portal.

• Pending: The Service Order is
temporarily paused or on hold.

• In Progress: A technician in the
CSM Desktop Client is investigating/
fulfilling the Service Order.

• Complete: A technician has resolved
and closed the Service Order.

• Canceled: The Customer who
created and recorded the initial
details of the Service Order has
canceled the order in the Service
Cart before submitting it.

• Abandoned: The Customer who
created and recorded the initial
details of the Service Order has
abandoned their order in the Service
Cart without canceling or submitting
it.

 

Requester

Name, avatar, e-mail address, and phone
number associated with the requester (i.e.,
the Portal Customer who submitted the
Service Order).

 

Form Area - Details

Created On Date on which the Service Order was
created.

The date is generated using the
ServiceCart.CreatedDateTime Text
Expression.

Estimated
Cost Estimated Cost of the Service Order. The estimated cost is calculated using the

Estimated Total Cost Text Expression.

Items Total number of Service Requests in the
Service Order

The number of items is calculated using the
numeric Count Items Expression.

% Complete Percentage of the Service Order that is
currently complete.

The percentage is calculated using the
Percentage Complete Text Expression.

Items
Pending

Items in the Service Order with a status of
Pending.

The number of items with a Pending status
is calculated using a numerical Count Items
Pending Expression.
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Field Description Comments

In Progress Items in the Service Order with a status of
In Progress.

The number of items with an In Progress
status is calculated using a numerical
Count Items In Progress Expression.

Complete Items in the Service Order with a status of
The number of items with a Complete
status is calculated using a numerical
Count Items Complete Expression.

Canceled Items in the Service Order with a status of
The number of items with a Canceled
status is calculated using a numerical
Count Items Canceled Expression.
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Service Cart Dashboards
CSM provides the Service Cart and My Service Orders Dashboards for Customers to manage and view
their Service Orders in the OOTB IT Portal.

The My Service Cart Dashboard displays Service Orders that have been created but not yet submitted for
a technician to address in a Grid. Customers can cancel the order (by clicking the Cancel Order button) or
submit the order (by clicking the Submit Order button).

Once a Customer submits a Service Order, they can monitor the status of their Service Requests on the
My Service Orders Dashboard, as well as past Service Orders.
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Note: Service Request metrics are also available on other Dashboards, including Requests,
Global IT, and Executive.

My Service Cart Dashboard Widgets

Item Description Widget
Type Widget Name Widget Uses:

Services
Ordered

List of all Service Requests
saved but not yet submitted
in the Service Cart

Search
Results List

Service Cart
Item Grid

Custom Query:
Incident.Service Cart ID
equals Service Cart ID
Stored Value and
Incident.Withdraw is not
equal to True.

Continue
Shopping

Runs the Service Catalog
Action to return the User to
the Service Catalog.

Button
(Action)
Widget

Continue
Shopping Service Catalog Action

Cancel
Order

Runs the Cancel Service
Cart Order Action to cancel
the order.

Button
(Action)
Widget

Cancel
Service Cart
Order

Cancel Service Cart Order
Action

Submit
Order

Runs the Submit Service
Cart Order Action to submit
the order.

Button
(Action)
Widget

Submit
Service Cart
Order

Submit Service Cart Order
Action

My Service Orders Dashboard Widgets
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Item Description Widget
Type Widget Name Widget Uses:

Filter Filters data in the Search
Results Grid. Filter Service Order

Status
Filter by Lookup
Table

Services to be
Delivered

List of all Service Requests that
have been submitted and are
currently open.

Search
Results List

My Open
Service Orders

My Open Service
Order Items Saved
Search

My Order
History

List of all Service Requests that
have been submitted and
closed.

Search
Results List

My Service
Order History

My Closed Service
Order Items Saved
Search
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Service Cart One-Step Actions
CSM provides several OOTB Service Cart One-Step Actions, including:

One-Step
Action Description/Actions Associations Executed From

Blueprint

Create
Incidents

Create Incidents from Service Cart
Items.

Once a Customer submits the Service
Order, CSM creates Incidents/Service
Requests based on the information
provided in the Service Order, and
then runs the In Progress One-Step
Action to change the Service Cart
status to In Progress.

Service Cart
One-Step Action Manager,
Submit button on the Portal
My Service Cart Dashboard.

Go to Cart
From the Summary form, the One-
Step Action takes the Customer to the
Service Cart.

Service Cart
One-Step Action Manager,
submission of the Service
Order to the Service Cart

Set Estimated
Total Cost

Sets the Total Cost field in the Service
Cart based on the sum of all costs in
the Service Order.

Service Cart
One-Step Action Manager,
submission of the Service
Order to the Service Cart

Blueprint - Email Messages

E-mail
Reminder

Sends the Customer a reminder about
Service Carts that have not been
submitted or committed for a
technician (ex: The Cart has been
abandoned).

Service Cart

One-Step Action Manager,
when the Service Cart
exceeds the Service Cart
Expiration date (three days
after the Service Cart has
been created)

Order Canceled

Sends the Customer a notification that
the Service Order has been canceled
or the Service Cart has been
abandoned.

Service Cart
One-Step Action Manager,
when the Service Order has
been canceled.

Order
Confirmation

Sends the Customer a notification with
the Service Order details, including
Cart Item IDs, Total Cost, and Cart
Item Costs.

Service Cart
One-Step Action Manager,
when the Service Order has
been submitted.

Blueprint - Status Actions

Abandoned

Sets the status of the Service Cart to
Abandoned if the Cart remains in a
New status for more than twice the
number of days specified in the
Abandoned Cart Reminder Stored
Value.

Service Cart

One-Step Action Manager,
when the Service Cart
exceeds twice the number
of days specified in the
Abandoned Cart Reminder
Stored Value.
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Canceled
Sets the status of the Service Cart to
Canceled if all Service Cart Items are
canceled.

Service Cart
One-Step Action Manager,
when all items in a Service
Cart are canceled.

Complete
Sets the status of the Service Cart to
Complete when all items in the Service
Cart have been completed.

Service Cart
One-Step Action Manager,
when all items in a Service
Cart are complete.

In Progress

Sets the status of the Service Cart to
In Progress when the items in the Cart
have been submitted and Service
Requests have been created in CSM
for each Cart item.

Service Cart

One-Step Action Manager,
when all items in the Service
Cart have Service
Requests.

New
Sets the status of the Service Cart to
New when the Service Cart has been
created.

Service Cart
One-Step Action Manager,
when the Service Cart is
first created.

Submitted

Sets the status of the Service Cart to
Submitted when items in the Service
Cart have been submitted as a Service
Order

Service Cart

One-Step Action Manager,
when the items in the
Service Cart have been
submitted as a Service
Order.

Global

Send E-mail to
Customer

Sends an e-mail to the Customer who
submitted the Service Cart Order. Service Cart One-Step Action Manager

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.
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Service Cart Saved Searches
CSM provides several OOTB Service Cart Saved Searches, including:

Saved Search Returns Association Executed From

All Service Carts All Service Carts, regardless of status. Service Cart Search Manager,
Metrics, Widgets

Canceled or
Abandoned Service
Carts

Service Carts that have been canceled
or abandoned. Service Cart Search Manager,

Metrics, Widgets

Complete Cart Items Service Cart Items with a status of
Complete. Service Cart Search Manager,

Metrics, Widgets

Cost Service Cart items where the Total Cost
field contains a value. Service Cart Search Manager,

Metrics, Widgets

In Progress Cart
Items

Open Service Cart items with a status
of In Progress. Service Cart Search Manager,

Metrics, Widgets

New Cart Items Open Service Cart items with a status
of New. Service Cart Search Manager,

Metrics, Widgets

New Service Carts Open Service Cart Orders with a status
of New. Service Cart Search Manager,

Metrics, Widgets

New Service Items Open Service Cart Orders with a status
of New. Service Cart Search Manager,

Metrics, Widgets

Pending Cart Items Open Service Cart Orders with a status
of Pending. Service Cart Search Manager,

Metrics, Widgets

Submitted Cart Items Open Service Cart Orders with a status
of Submitted. Service Cart Search Manager,

Metrics, Widgets
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Service Cart Automation Processes
CSM provides the following OOTB Service Cart Automation Processes:

Name Description

Send Abandoned
Cart Reminder

When a Service Cart has been created and abandoned for three (3) days, the
process initiates the Email Reminder One-Step Action, which sends a notification
e-mail to the Service Cart creator about the Service Cart's status. The creator can
then continue with the Service Cart or abandon the order.

Send Order
Confirmation

When a Service Cart Order status is changed by a technician to Submitted, the
process initiates the Order Confirmation One-Step Action, which sends a
notification e-mail to the Customer with the order details.

Service Cart
Complete

When the items in a Service Cart are all set to Resolved status, the process
initiates a One-Step Action to set the Service Cart Order status to Complete and
send a notification e-mail to the Customer about the change.
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Service Catalog Template Management
Service Catalog Template management is the process that allows users to manage small amounts of
work, comprised of Work Units, using Service Catalog Templates (SCTs).

SCTs are available to customers from the Service Catalog in the CSM Portal.
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About Service Catalog Templates
A Service Catalog Template (SCT) automates many processes and allows repetitive steps to be reused
so you don't have to create new steps. A Work Unit (WU) is a small amount of work done by a single team
or individual. An SCT is a collection of work units that work together.

When you must perform a series of tasks to complete an Incident or Service Request, the steps may be
similar, but vary depending on the end goal. Use Service Catalog Templates instead of writing several
One-Step™ Actions to create the tasks. SCTs and Work Units can accomplish the work quickly and save
time.

For example, the following steps for receiving a new printer and receiving a new laptop are similar.

To receive a new printer:

1. Unbox and label.

2. Test the unit.

3. Place in storage for later use.

To receive a new laptop:

1. Unbox and label.

2. Test the unit.

3. Load default software package.

4. Place in storage for later use.

Each of the steps above can be considered a Work Unit, so you can organize the WUs with two Service
Catalog Templates: Receive New Printer and Receive New Laptop.

Receive New Printer

Work Units
Unbox and label
Test the unit
Place in storage for later use

Receive New Laptop

Work Units
Unbox and label
Test the unit
Load default software package
Place in storage for later use

For additional examples, see Service Catalog Template Examples.
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Good to Know

• Search for one or more Service Catalog Templates that meet a specific criteria by running a quick
search or search group.

• By default, SCT uses the Incident Service subcategory structure. Navigate to category options by
selecting Tools > Table Management > Type > Incident Category.

• CSM implements several Actions and One-Step Actions to make creating Service Catalog
Templates more efficient.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint > Tools > Export Schema) to view
a full list of One-Step Actions associated with a particular type of Business Object (example:
Major).

• Secure SCT records by controlling who can view, create, and edit records.

Service Catalog Templates can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). See The Relationship between CSM and Multi-Sourcing Service
Integration and Service Integration and Management.

Related tasks
Create a Service Catalog Template
Related information
About Quick Search
About Saved Searches
About One-Step Actions
About Security Groups
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Create a Service Catalog Template
CSM provides several default Service Catalog Templates (SCTs) or you can create your own to meet the
needs of your organization. The SCT form allows users to view, create, track, and manage SCTs.

The Incident categorization (and ability to complete the Task within the specified Service Level Agreement
[SLA]) determines which Service Catalog Templates are available. For example, if a technician has a
Service Request for a new employee, only SCTs appropriate for new employees are displayed.

You can also limit which Service Catalog Templates appear based on the anticipated SLA timeframes. If
an employee needs a new printer and there are two SCTs that apply, but one of them doesn't allow the
technician to meet the SLA in time, the only Service Catalog Template displayed is the one that meets the
criteria. In addition, if there is an SCT that can't be fulfilled in time, display that information to the
technician so they have the option to choose that Service Catalog Template anyway.

To create a Service Catalog Template:

1. On the CSM Desktop Client or the CSM Browser Client toolbar, select New > New Service Catalog
Template.
A new SCT record is created with a unique ID and a status of New.

2. Provide a title and portal title (example: New Employee Setup).
The portal title autopopulates based on the Title field. You can provide a different title for the Portal
(Service Catalog page), if necessary.

3. Provide a description and portal description (example: Create all necessary items for a new
employee setup). The portal description autopopulates based on the Description field. You can
provide a different description for the Portal (Service Catalog page), if necessary.
To format the text or embed an image, select the Zoom button .

4. Select a service classification that matches the service, category, and subcategory. This setting
determines when the Service Catalog Template can be run. The classification in the Incident must
match the SCT classification before you can activate the Service Catalog Template.
An abbreviated read-only Service form displays in the form arrangement.

5. (Optional) The critical path time units autopopulate based on attached SLAs, Work Units (WUs), and
dependencies. This is one way to organize the SCT.

Note: The critical path creates a cumulative process completion time based on all attached
SLAs, WUs, and dependencies. Service Catalog Templates can be linked to WUs and
Incidents from within the SCT form, a Work Unit form, or an Incident form.

6. (Optional) Select a category (example: HR Process) and choose a timeframe from the Business
Hours Manager (the business hours that apply to the process).
The category allows users to filter Service Catalog Templates for saved searches and reports.

7. In the Default form, select the Select Owner link to assign a business owner, and assign an IT
process owner (if different from the creator) by selecting one of the ownership links:

◦ Creator's name (example: Henri Bryce): Select this link to select a user owner.
◦ Creator's Team (example: 3rd Level Support): Select this link to first select a team owner, and

then select the owner.

After providing the details of the SCT, select the WUs that make up the Service Catalog Template.
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8. To add Work Units to the SCT, select the Add a Work Unit link.
The Work Unit Selector window opens displaying available WUs.

a. Select a Work Unit from the grid. Linked WUs appear in the Work Unit tab of the form
arrangement as they are added to the Service Catalog Template. To view the detailed Work
Unit form, select the Jump button  in the form arrangement toolbar. The WUs populate the
Work Unit Order tab where they are organized by the system.

Note: As Work Units are added, dependencies can also be added to dictate the order
in which the WUs are completed. Work Units with dependencies are easily viewed in
the Work Unit Order tab. For example, before the PC can get an Asset Tag, the laptop
must first be acquired.

b. (Optional) Manage WUs in the Work Unit Functions section by selecting any of the following
links. These won't appear in the SCT unless it has Work Units or dependencies linked to it.

◦ Visualize the Service Catalog Template: Displays a visual workflow diagram of the
Service Catalog Template. This link is only available after the SCT is activated.

◦ Add a Work Unit: Adds additional Work Units to the SCT.
◦ Delete a Work Unit: Removes an existing WU from the Service Catalog Template. This

does not delete the Work Unit from the system, only from the SCT.
◦ Reorder the Work Units: Changes the order of the WUs. This link is only available

when there are two or more Wrok Units.
◦ Update Completion Times: Automatically syncs supplier agreements with WUs and

updates the critical path time.
◦ Add a Dependency: Adds a dependency to a Work Unit; so when the SCT is run, one

Task will be dependent upon another Task. The WU that is depended upon must be
completed before the dependent Work Unit can be completed. This link is only available
when there are two or more WUs.

◦ Remove a Dependency: Removes a previously created dependency.
◦ Add a Note to Work Unit: Provides additional information related to the Work Unit.

When the WU becomes a Task, the defined note displays in the Description field on the
Task. This note appears only in the Service Catalog Template.

◦ Remove a Note from Work Unit Task: Remove an existing note from the Work Unit
Task.

9. Select the Next: Active link in the Default form to activate the SCT.
The status changes to Active and the Service Catalog Template is available to customers from the
Select Available SCT link in the Actions list. When an SCT is selected, a Service Request is
created and the associated WUs transform into Tasks, which are required to close the Service
Request.
An SCT can only activate once per Incident. When a Service Catalog Template is activated, it
creates Tasks based on the Work Units; one Task per WU. After the Tasks have been created, there
is no further connection between the SCT/Work Unit and the Incident.

To retire the Service Catalog Template, select the Next: Retired link in the Default form.
Related concepts
Service Catalog Template Examples
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Related tasks
Create a Work Unit
Related information
About Rich Text
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Service Catalog Template Examples
Common examples of Service Catalog Templates (SCTs) include acquire a generic laptop, acquire an
executive laptop, and new employee setup.

You can reuse repetitive steps as Work Units (Tasks) to automate many processes. Examples of a few of
those processes are listed below. These steps are general guidelines, so you can customize the steps to
meet your organizational needs.

Acquire Generic Laptop
To acquire a generic laptop:

1. Order laptop.

2. Receive laptop.

3. Unbox laptop and put on asset tag.

4. Load standard software.

5. Add laptop to current inventory.

Acquire Executive Laptop
To acquire an executive laptop:

1. Order laptop.

2. Receive laptop.

3. Unbox laptop and put on asset tag.

4. Load executive software.

5. Add laptop to current inventory.

New Employee Setup
To set up a new employee:

1. Acquire laptop.
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2. Unbox laptop and put on asset tag.

3. Prepare laptop.

4. Create AD account.

5. Provide email account.

6. Deliver equipment.

7. Set up desk.

Related tasks
Create a Service Catalog Template
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Site and Building Management
Site and Building management is the process that allows Site and Building Managers to effectively
monitor the relationship between one or more Sites and associated Buildings related to a customer,
Configuration Item (CI), or other applicable Business Objects.
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About Site and Building Records
Learn about how Site and Building records are used.

A Site is a physical location that can include one or more Building records, though a Site might exist
without associated Building records (example: Your USA Headquarters might only have one location).
Sites and Buildings can be associated with a Customer, Configuration Item (CI), or other applicable
Business Objects. Site and Building Managers monitor and update the location records and relationships,
as necessary.

Sites and Buildings are Major Business Objects. Their associated forms allow Users to view, create, track,
and manage location information.

CSM 10.5.0 ITSM Practices 253

CSM 10.5.0 ITSM Practices



Creating Site and Building Records
Access procedures for creating Site and Building records.
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Create a Site Record
Walk through the typical steps to create a Site record.

To create a Site record:

1. On the CSM Browser Client or CSM Desktop Client toolbar, click New>New Site.

A new Site record is created with a status of New.

2. Provide information about the Site in the Overview:
a. Site Name: Provide a name (example: USA Headquarters). This is a required field.

b. Address: Provide an address (example: 10125 Federal Drive).

c. Address 2: Provide additional address information (example: Suite 100).

d. Country: From the drop-down, select the country associated with the Site (example: United
States of America).

e. State/Province/Territory: From the drop-down, select the name of the state, province, or
territory associated with the Site (example: Colorado).

f. City: Provide the name of the city (example: Colorado Springs).

g. Postal Code: Provide the zip code (example: 80908).

h. Region Code: From the drop-down, select a region code (example: Western United States).

i. Notes: Provide other important information for the Site.

3. The Site record creator is automatically assigned as the Owner. Assign a different Site Manager or
Team in the Default Form by clicking the Site Manager or Team name links.

Note: You can also change the SIte Manager by selecting the Assign To... link under
Actions.

4. Activate the Site by clicking the Next: Active link in the Status bar.

The status changes to Active and the Site is available.

5. (Optional) Create Building records to associate with the Site:
a. Click the New Building button in the Form Arrangement.

b. Complete the Building form.

6. (Optional) To deactivate the Site, click the Next: Inactive link in the Status bar.

Note: The status of the Building records associated with the Site must be set to Inactive
before the Site can be deactivated.
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Create a Building Record
Walk through the typical steps to create a Building record.

To create a Building record:

1. On the CSM Browser Client or CSM Desktop Client toolbar, click New>New Building.

A new Building record is created with a status of New.

2. Provide information about the Building in the Overviewn:
a. Site: From the drop-down menu, select the site associated with the Building (example: USA

Headquarters).

b. Building Name: Provide a name for the Building. This is a required field.

c. Address: This field auto-populates using the address from the associated Site record. If
necessary, provide a different address.

d. Address 2: Provide additional address information for the Building.

e. Country: This field auto-populates using the country from the associated Site record. If
necessary, provide a different country.

f. State/Province/Territory: This field auto-populates using the state/province/territory from the
associated Site record. If necessary, provide a different state, province, or territory.

g. City: This field auto-populates using the city from the associated Site record. If necessary,
provide a different city.

h. Postal Code: This field auto-populates using the zip code from the associated Site record. If
necessary, provide a different zip code.

i. Region Code: This field auto-populates using the region code from the associated Site
record. If necessary, provide a different region code.

j. Full Address: Provide the full address for the Building.

k. Notes: Provide other important information for the Building.

3. Assign a Building Manager in the Default Form by clicking one of the ownership links:
◦ Select Owner: Click to first select a Team owner and then a User owner.

◦ Select Team: Click to select a Team owner.

Note: You can also take ownership of the Building by selecting the Assign to Me link.

4. Activate the Site by clicking the Next: Active link.

The status changes to Active and the Building record is available.

5. (Optional) To deactivate the Building, click the Next: Inactive link or click the Set Status to Inactive
link.

6. (Optional) To mark the Building as Vacant, click the Set Status to Vacant link.
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Supplier Catalog Item Management
Supplier Catalog Item management is the process that allows users to manage generic products or
services that are provided by an internal or external supplier.
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About Supplier Catalog Items
A Supplier Catalog Item is a generic product or Service that is provided by an internal or external Supplier
to an organization's Customers.

In CSM, Supplier Catalog Item is a Major Business Object. The Supplier Catalog Item form allows Users
to view, create, track, and manage Supplier Catalog Items.

Note: Supplier Catalog Item can be used to support Multi-Sourcing Service Integration (MSI) and
Service Integration and Management (SIAM). For more information, see The Relationship
between CSM and Multi-Sourcing Service Integration and Service Integration and Management.
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Supplier Catalog Item Good to Know
• A Supplier Catalog Item is a generic product or Service that is provided by an internal or external

Supplier to an organization's Customers.

• Search for one or more Supplier Catalog Items that meet a specific criteria by running a Quick
Search or Search Group.

• Create a new Supplier Catalog Item by clicking New>New Supplier Catalog Item on the CSM
Desktop Client toolbar or by clicking File>New>New Supplier Catalog Item from the CSM Desktop
Client menu bar.

• The OOTB system implements several Actions/One-Step Actions to make creating Supplier Catalog
Items more efficient. For more information about Actions and One-Step Actions, refer to the Actions/
One-Step Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Supplier Catalog Item records by controlling who can view, create, and edit records.
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Supplier Management
Supplier management is the process that allows users to onboard and offboard multiple suppliers (internal
and/or external) and manage their individual lifecycles, which includes defining information, creating
agreements, and assessing performance.
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About Suppliers
A supplier is a person or group (internal or external) that is responsible for providing a product or service
to an organization based on an Operational Level Agreement (OLA) or Underpinning Contract (UC).

Supplier is a Major Business Object. The Supplier form allows users to view, create, track, and manage
suppliers.

Note: Supplier can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Supplier Good to Know
• A Supplier is a person or group (internal or external) that is responsible for providing a product or

service to an organization based on an Operational Level Agreement (OLA) or Underpinning
Contract (UC).

• Search for one or more Suppliers that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Supplier by clicking New>New Supplier on the CSM Desktop Client toolbar or by
clicking File>New>New Supplier from the CSM Desktop Client menu bar.

• The OOTB system implements several Actions/One-Step Actions to make creating Suppliers more
efficient. For more information about Actions and One-Step Actions, refer to the Actions/One-Step
Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (ex: Major).

• Press TAB to move to the next field on the form.

• Secure Supplier records by controlling who can view, create, and edit records.
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Create a New Supplier
To create a new Supplier:

1. On the CSM Desktop Client or CSM Browser Client toolbar, click New > New Supplier. A new
Supplier Form displays.

The Supplier automatically enters the Evaluating phase of the workflow.

2. The Default Form will display the Supplier name, status, grade, risk level, and contact information
once you have entered it. Assign a Supplier Manager by selecting the -select owner- link. Click the
Assign to Me link in the Actions List to assign yourself as the owner of the Supplier record.

3. Record basic Supplier details, contact information, and add a company logo in the Overview tab in
the Form Arrangement.

4. Provide Supplier Management information to determine how often the Supplier's performance
should be reviewed and how often Risk Assessments should be conducted. The Supplier Category
should be populated from the drop-down menu to denote what type of contract the Supplier has with
the company. The Supplier Type can also be populated from the drop-down to denote if the Supplier
is an Internal Supplier or an External Supplier.

Note: The Supplier Category and Supplier Type drop-down menus can be configured based
on User need. To add or remove field options, click Tools > Table Management > Supplier
Category, or the desired menu name, and right-click a field to edit it. Click the New button in
the toolbar to add a new field option to the drop-down.

Note: The On Probation/Under Review checkbox is linked to an Automation Process; if the
field is selected, then the system automatically notifies the Supplier Manager via e-mail that
the Supplier needs to be reviewed.

5. The Form Arrangement contains tabs for quick reference of records related to the Supplier. There is5.
no requirement regarding which tabs need to be populated or completed in order for the Supplier to
move through the workflow.

◦ The Agreements tab displays existing contracts the company has with the Supplier and the
Work Units tab divides them into smaller units. The Tasks tab then shows what the Supplier
needs to perform or provide in order to fulfill the Agreements and Work Units.

◦ The Supplier Catalog Items tab displays the existing items the supplier is contracted for,
including type of item and how it is used within the company.

◦ Scorecard assessment dates and grades display in the Scorecard tab. The most recent grade
displays in the Default Form. For details on completing the Supplier Scorecard, see Step 6.

◦ Create a Supplier risk assessment by selecting the Create Risk Assessment link in the
Actions List. Once you complete a risk assessment, it will appear in a Supplier Risk
Assessment tab in the Form Arrangement. The date that the assessment was performed, the
Supplier's total score, their total risk level, and the Manager that performed the assessment
will display under this tab. For details on completing the Risk Assessment, see Step 7.
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◦ Service Impact Events include anything that may impact the Supplier's ability to provide their
specified service; these events can be manually inputted into the tab.

◦ Enter Service Complaints through the Service Complaints tab if necessary.

◦ The Configuration Items tab displays the Configuration Items that a Supplier's service
supports.

6. Create a Supplier Scorecard.

a. Click the Create Scorecard link in the Actions List.

Note: The Scorecard assesses the Supplier's reliability and whether or not there are
complaints within their control attached to their Form. Complaints associated with the
Supplier display in the Service Complaints tab of the Form Arrangement.

The Scorecard Form displays, showing how the Supplier has ranked in four categories, each with
the same subcategories.

A grade based on the Scorecard Form's calculations displays in the grade section of the Default
Form.

Note: The Supplier Scorecard uses an Automation Process that automatically sends an e-
mail to the Supplier Manager if the resultant grade is lower than the previously attained
grade. The Supplier Manager also receives an e-mail if the Supplier is given a failing grade
by the Scorecard.

7. Complete the Supplier Risk Assessment.

a. Select the Create Risk Assessment in the Actions List

The Risk Assessment Questionnaire determines the Supplier's risk based on Service Delivery Risks
and Service Disruption Risks. The Questionnaire should be filled out during the initial Evaluation
stage, and again based on the Risk Assessment Cycle that should have been determined in the
Supplier Management section of the main form.

Note: The Risk Assessment form is the OOTB configuration but can be modified by the User
to measure fields of their choice. The Questionnaire corresponds with the Risk subject. The
Questionnaire asks questions regarding the subject that is currently selected, but the
Questionnaire is the same for each subject. A Risk Mitigation Plan is required if the Risk is
Moderate and Possible, or higher. The plan should be typed into the available text box. All
Risk Assessments that are performed and the date of completion displays in the Risk
Assessment tab in the Arrangement Pane.

The Risk Assessment results display in the Supplier Risk Assessment tab of the Form Arrangement.
"Low" Risk are green, "Medium" are orange, and "High" are red.
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8. Once information has been completed by the Supplier Manager, the status of the Supplier can be
moved to the next stage in the workflow, from Evaluating to Onboarding.

• Onboarding occurs when the Supplier is filling out Agreements with the company and establishing a
service design.

• Once a Supplier has been approved and is acting as a service provider, the Supplier should be
moved to the Active phase of the workflow.

• Offboarding may occur as a result of poor performance and serves as the phase a Supplier will be in
if the company is currently attempting to sever ties. During this phase, a replacement Supplier
should be chosen.

• The Inactive phase occurs when a Supplier is no longer being used and has fulfilled all existing
Tasks or Agreements.

CSM 10.5.0 ITSM Practices 265

CSM 10.5.0 ITSM Practices



Work Item Task
Work Item is a Group Member of Task. Use the Work Item form to define and manage Tasks required to
resolve Incidents, Problems, or Changes.

Create a new Work Item, assign ownership, and create dependencies from the Task tab in the Form
Arrangement of these Business Objects.

Related concepts
Logging Incidents
Logging Problems
Change Workflow
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Using Work Item Actions
There are several Actions associated with the Work Item form to assist with managing Tasks and assist
with completion.

• Take Ownership: Select this link to assign the Task to yourself.

• View Detailed Date/Time Information: Select this link to view details such as the time and date
that the Work Item was created, when it was last edited, and parent record details.

• Add to My Outlook Calendar: Select this link to add the Task due date to your Outlook calendar.

• Add to a Downstream Task: Select this link to open a new Task form. Doing so adds an additional
dependancy to the parent record. The Downstream Task must be completed after the Work Item it
was created from.

• Link to an Upstream Task: Select this link to select an Upstream Task to link the Work Item to. The
Upstream Task must be completed prior to completing the current Work Item.

• Visualize Task Dependency Flow: Select this link to open a Visualization of all Tasks associated
with the parent record in the order that they must be completed.

• Decline this Task: Select this link to decline the task. The status automatically moves to Closed,
and the Close Code is automatically set to Declined.

• Reassign this Task: Select this link to reassign the task to another team or another user.
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Create a New Work Item
In the CSM Desktop Client, create a new Work Item, assign a user owner, and provide a title and
description for the Work Item.

To create a new Work Item:

1. From the CSM Desktop Client toolbar, select New > New Incident.

Note: Choose from the following Records: Incident, Problem, or Change.

2. Complete the Incident form.
3. Select New Work Item from the Task tab in the form arrangement.

A new Work Item form opens with a unique ID and status of New.
4. Assign a user owner.
5. Provide a Title for the Work Item.
6. Provide a Description of the Work Item task.
7. (Optional): Select the Task is for a future date/time checkbox to select a future date/time that the

Work Item must be complete on.
8. (Optional): Select the Track time spent checkbox to require the owner to log time spent resolving

the Work Item.
9. Click Save.

An email is automatically sent to the Work Item owner, notifying the user that a Work Item has been
assigned to them. Once the owner begins work on the Task, the status of the Work Item moves to
either Acknowledge or In Progress. The parent record cannot be closed until all associated Tasks
have been completed.
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Complete a Work Item
After finishing a Task, complete the steps to move the Work Item to Closed.

To complete a Work Item:

1. Select a code from the Close Code drop-down list (example: Completed).
2. Provide Completion Details.
3. Select Next: Close in the Default form to move the Work Item to Closed.
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Work Units
A Work Unit is a generic task that is required to fulfill a Service Request.

A Work Unit is a generic task that is required to fulfill a Service Request. Work Units are grouped together
in one or more Service Catalog Templates and then converted into individual Tasks when a customer
submits an order for a Service using the CSM Portal.

In CSM, Work Unit is a Major Business Object. The Work Unit form allows Users to view, create, track,
and manage Work Units.

Note: Work Unit can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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About Work Units
Work Units are grouped together in one or more Service Catalog Templates and then converted into
individual Tasks when a customer submits an order for a Service using the CSM Portal.

In CSM, Work Unit is a Major Business Object. The Work Unit form allows Users to view, create, track,
and manage Work Units.

Note: Work Unit can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM). For more information, see The Relationship between CSM
and Multi-Sourcing Service Integration and Service Integration and Management.
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Work Unit Good to Know
• A Work Unit is a generic task that is required to fulfill a Service Request. Work Units are grouped

together in one or more Service Catalog Templates and then converted into individual Tasks when a
Customer submits an order for a Service using the Customer Portal.

• Search for one or more Work Units that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Work Unit by clicking New>New Work Unit on the CSM Desktop Client toolbar or by
clicking File>New>New Work Unit from the CSM Desktop Client menu bar.

• The OOTB system implements several Actions/One-Step Actions to make creating Work Units more
efficient. For more information about Actions and One-Step Actions, refer to the Actions/One-Step
Actions documentation.

Note: A full list of One-Step Actions is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint>Tools>Export Schema) to view a full
list of One-Step Actions associated with a particular type of Business Object (ex: Major).

• Fields:
◦ Press TAB to move to the next field on the form.

◦ The Work Unit Description and Task Description (Displays on Task) fields are Rich Text fields.
To format the text or embed an image, click the Zoom button .

◦ The Name, Work Unit Description, and Task Description (Displays on Task) fields are required
to save the record.

• Secure Work Unit records by controlling who can view, create, and edit records.
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Creating Work Units
The following instructions are available to walk you through the steps to create a Work Unit using our
OOTB workflow:

• Create a Work Unit: Typical step-by-step instructions for creating a Work Unit.

Note: CSM provides an OOTB Work Unit workflow with all of the features you need to
successfully manage Work Units. You can use this workflow as-is, or tailor it to meet the
needs of your organization.
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Create a Work Unit
Create a Work Unit (WU) to use in a Service Request or Service Catalog Template (SCT).

To create a Work Unit:

1. On the CSM Desktop Client toolbar, select New > New Work Unit. See CSM Desktop Client
toolbar.
A new WU record is created with a unique ID and a status of New.

2. Complete the Basic Information section (the Name, Work Unit Description, and Task
Description fields are required):

a. Provide a name (example: Acquire a Laptop) and select a category (example: Order product).
The category provides a way to organize the Work Unit.

b. Provide a description for the Work Unit and for the Task (example: Order a generic laptop).
The Task description (displays on Task) autopopulates based on the Work Unit Description
field. Provide a different description for the Task, if necessary.

3. Select an team owner and user owner.

Note: When the WU transforms into a Task, the Work Unit owner becomes the Task owner.

4. (Optional) Complete the Catalog Information section if you are using a Supplier Catalog Item:
a. Select a Catalog Item (example: Generic Laptop). This field uses the Supplier Catalog Items

table.
After selecting the Catalog Item, the following fields autopopulate (if available): Item
Description, Max Time to Complete, Max Time Units, Estimated Cost, and Business
Hours. Item Description information (uses the Supplier Catalog Items table description)
displays as read-only text so you cannot manually edit this field. You can provide different
values for Max Time to Complete, Max Time Units, Estimated Cost, and Business Hours,
if necessary. The Supplier Catalog Item and Agreement records display as abbreviated read-
only forms in the form arrangement.

b. (Optional) From the Actions list you can:
◦ Change Supplier: Select the link to open the Agreement Selector, and select an alternate

Supplier.

The new Supplier information displays in the form area.

◦ Clear the Catalog Item: Select the link to remove the data in the Catalog Information section
and select a new Catalog Item under the Catalog Information section.

5. Select the Next: Set to Active link in the Default form to activate the WU.
The status changes to Active and the Work Unit is available to use for Service Catalog Templates.

To retire the WU, select the Next: Retire Work Unit link in the Default form.
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Work Unit Features
CSM provides the following tools to help manage Work Units:

• Form

• Saved Searches
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Work Unit Form
CSM provides a read-only OOTB Work Unit form available in the CSM Desktop Client. The Form is
comprised of three main areas:

1. Default Form: Displays important at-a-glance information, such as Work Unit ID, Status bar (current
and next Status), and to whom the Work Unit is assigned.

2. Form Arrangement: Dynamically displays a tabbed collection of child Forms and records that are in
a relationship with the Parent Work Unit form (example: Supplier Catalog Item, Agreement (OLA or
UC), and Service Catalog Templates). See Managing Form Arrangements for more information.

3. Form Area: Displays the main form fields. Specifics forms appear when relevant.

4. Actions List: Dynamically displays a list of actions that are available for the current Work Unit.
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Work Unit Saved Searches
CSM provides the following OOTB Work Unit Saved Searches:

Saved Search Returns Association Executed From

All Work Units All Work Units, regardless of status. Work Unit Search Manager, Widgets

New Work Units Work Units with a status of New. Work Unit Search Manager

Retired Work Units Work Units with a status of Retired. Work Unit Search Manager
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